ETC Supplement

Element v2.6.0 Supplement to Manual

Many functions and controls available on other Eos Family consoles were added to Element with version 2.6.
This supplement will discuss those new features. In addition to this supplement, several updated chapters from
the Element manual have been included.

Note: For additional features added to all of the Eos Family consoles in version 2.6, please see the
Eos Family v2.6 Supplement, which can be found starting on page 48 of this document.

The following is a list of those new features and where you can learn more about them.

% New Setup Options for Element on page 1

# Highlight and Lowlight on page 2

¥ Using {Make Manual} on page 3

7 Using {Make Null} on page 3

¥ Using {Query} on page 4

» Non-intensity Parameter Category Cue Timing on page 5
¥ Discrete Channel/Parameter Timing (page 1)

> Hang (page 1)

# [Update] (page 1)

¥ About Fan on page 23

»* About Presets on page 14

7 {ByType}, {Absolute}, and {Locked} on page 11 Palettes
¥ About Filters on page 31

% About Partitioned Control on page 28

# About Virtual Media Server on page 34

New Setup Options for Element
There are four new options for Element in Setup>Desk>Display.

DirSel.Dbl Clk

When enabled, double clicking a direct select button will act as [Recall From] [Record Target] to place the
entire contents of that preset, palette, or step-based effect on stage. The default for this setting is “Disabled”.

Display Fader Ribbon

When enabled, the fader ribbon will display. The fader ribbon shows the state of Element's faders. When dis-
abled, the fader ribbon will not display. {Display Fader Ribbon} is enabled by default.

inbib

Display Help Prompts

When enabled, Element displays help prompts above the command line. When disabled, the prompts will not
display. {Display Help Prompts} is enabled by default.
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Userid
This option is available in Setup>Desk>Display.

You can change the User ID for the console by selecting this button and entering a number from the keypad.
For more information on User ID, see Multiple Users on page 25 .

Update Mode
This option is available in Setup>Desk>Record Defaults.

This field allows you to select a default update mode. The defaultis “Make Absolute”. For more information,
see [Update] on page 7

{Home Preset}
This option is available in Setup>Show>Show Settings.

Allows you to specify a preset that will be used as the home level for all non-intensity parameters in the preset,
instead of the fixture library defaults. This preset will be applied for all “Go to Cue Out” and home commands.
Intensity values in the preset will be ignored. Channels not included in the assigned home preset will continue
to home to their library defaults.

Please see Storing and Using Presets on page 13 for more information.

Partitions

Pressing the {Partitions} button in Setup>Show opens the partition display in the CIA. This display shows any
recorded partitions, including the four pre-existing partitions. For more information, see the Using Partitions
chapter in this supplement.

Manual Control

Changes in this section impact the Basic Manual Control or the Advanced Manual Control chapter.

Highlight and Lowlight

Element can be placed in Highlight mode. Channels selected while in this mode will either go to a default set-
ting, or to a value provided by a highlight preset (established in Setup>Desk>Manual Control). Modifications
can then be made to those channels. Any changes will be maintained when the highlight mode is removed.

To place Element in highlight mode, press {Highlight} [Enter]. The command line will show that highlight is
currently in use.

If no highlight preset is established, or for channels that have no value stored in the highlight preset, the fol-
lowing values will be applied to channels as they are selected:

7 Intensity - full

»* Focus parameters - no change from present state

# Color parameters - home value

»» Shutter parameters - no change from present state

»* Image parameters - home value

» Form parameters - no change from present state
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For Example:
1. [Group] [1] {Highlight} [Enter] - places channels 1 through 5 in highlight.
2. [Next] - specifies channel 1.
** 1isinthe highlight value.
#» 2-5areinthe lowlight value.
# All other channels go to the defined rem dim level.
¢ J

You may assign both a highlight and a lowlight preset in setup. Any preset may be used. Channels/parameters
that are not included in the presets assigned to Highlight and Lowlight will continue to use their default high-
light values.

Ona command line with a channel selection, you can use [Shift] + {Highlight} to go into Highlight mode and
send the selected channels to the default Highlight setting. This command will self terminate the command
line.

If you just use {Highlight}, the command line will be cleared.

Using {Make Manual}

The {Make Manual} softkey can be used to convert cue or submaster data into manual values, allowing it to
be included in [Record], [Record Only], and [Update] operations.

»+ [5]{Make Manual} [Enter] - selects channel 5 and makes all of its current parameter settings manual
data.
*» [8] {Focus} {Make Manual} [Enter] - selects channel 5 and makes all of its focus data manual.

?» [9][Thru] [3] {Color} {Intensity} {Make Manual} [Enter] - selects channels 3-9 and makes their color
and intensity values manual.

Using {Make Null}

The {Make Null} softkey can be used to withhold parameter data from record or update actions in live, and
remove parameter data from record targets in blind. {Make Null} is applied using channel selection and can
impact entire channels, individual parameters, or parameter categories.

Make Null In Live

When you apply a {Make Null} instruction to channels or parameters in live, channel data is still visible
onstage, but that data is essentially rendered invisible to record commands. Similar to filters (see Record Fil-
ters on page 31), {Make Null} acts as an “ignore” instruction in live, not a remove instruction. When channel
data is nulled, the values for that data in the live display turn grey and an “N” appears next to the data field.

{Make Null} differs from park in that you can still manipulate data onstage (through manual control or through
playback) but that data will be unavailable for record actions.

Some examples of using {Make Null} in live are:
*» [11[Thru] [5] {Make Null} [Enter] - converts all parameters of channels 1-5 into null data.

?+ [2]{Color} {Make Null} [Enter] - changes only color data for channel 2 to null data.
?» [9] [Thru] [5] {Pan} {Make Null} [Enter] - changes only the pan data for channels 5-9 to null.

Null instructions are lifted in two different ways. First, as {Make Null} is a toggle state, it is possible to reselect
the channel and parameter followed by {Make Null} [Enter]. This lifts the null state.

Additionally, a Go To Cue instruction will remove the null state.

Make Null In Blind

When applied in blind, {Make Null} can be used to mask instructions in a cue after it has already been stored.
A {Make Null} instruction can also be applied to channels/parameters in palettes, presets, and submasters,
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thereby removing the data from the target entirely, in the same way that [At] [Enter] does.

When applied to channels/parameters in cues, {Make Null} doesn’'t remove the data from the cue, it simply
makes it unavailable for playback. It has the same effect on move instructions that it has on tracked values.

Some examples of using {Make Null} in blind are:

?* {Color Palette} [1] [Enter] [3] {Magenta} {Make Null} [Enter] - removes all magenta parameter data
for channel 3 from color palette 1.

» [Preset] [5][Thru] [9] [Enter] {Intensity} {Make Null} [Enter] - removes all intensity data for all chan-
nels in presets 5-9. (Use [Shift] + [Int Palette] to put Preset on the command line.)

# [Cue] [8] [Enter] [2] [Thru] [7] {Make Null} [Enter] - nulls all data for channels 2-7 in cue 8.
»* [Cue] [9] [Enter] {Intensity} [Make Null] [Enter] - nulls all intensity data for all channels in cue 9.

In the cue scenarios above, {Make Null} differs from using [At] [Enter] in that instead of allowing values estab-
lished in previous cues to track in, {Make Null} both restricts the recorded data from playing back and prevents
other values from tracking in. Therefore, if the cue were executed as an out-of-sequence cue, no data would
play back or track in for any nulled values.

Using {Query}

{Query} is used to select channels that meet criteria specified by you. These selections are conditional, based
on what type of luminaire a channel is or what that channel is doing, isn't doing, can do or cannot do. These cri-
teria are established in the command line using the softkeys, the keypad, and the direct selects.

p Note: On Element, {Query} is a softkey. To access {Query}, the command line has to be clear. ]

When {Query} is used, the softkeys change to:

2 Isin

# Isn'tin

# CanBe

# Can’tBe

» Or

»* Moves Only

# Unpatched

?* Less Than (includes equal to)

» Greater Than (includes equal to)

Note: Unless otherwise specified, Element assumes that a query will apply to current output. There-
fore use of the {Is In} softkey is optional.

The CIA also repaints to display all of the available softkeys and additional query states by which you can
search. These can be used in defining your query criteria.

»» {Default} - includes the query softkeys along with additional query conditions.

% {Text}

» {Keywords} - displays buttons for all the text used in the text 1-10 fields and for all of the default
keywords in Patch.

» {Gel}- displays all of the gels used in the current show file.
7 {Text 1} - {Text 10} - displays only the text used in that text field.
»» {Fixture Types} - displays buttons for all of the fixture types used in the current show file.

As a query is defined in the command line, channels will be specified in the live/blind display. When an [Enter]
command is used to end the query, the remaining channels of the query will be selected.
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For Example:
You wish to find channels which are in color palette 2 and have an intensity of 50%:
** {Query} <Is In> {Color Palette} [2] [At] [5] [0] [Enter]

In the live/blind display, any channels meeting this criteria will be selected.

You may use [Next] and [Last] to cycle through the query selection, one channel at a time to control
only a specific channel.
- J

Other examples of using a query are:

** {Query}{Isn"t In} {Beam Palette} [2] [5] [Enter]

?» {Query} {Luminaire} {Can Be} {Focus Palette} [8] [Enter]

** {Query} {Unpatched} [Delete] [Enter] [Enter]

** {Query} {Fixture Type} {Revolution} {Can Be} {Focus Palette} [6] {Isn"t In} [Cue] [4] [Thru] [9] [Enter]
?» [Next] [Next] [Enter] - selects one channel from the query result

Additionally, in patch you can define up to ten “query” keywords for each channel. These keywords can be
used to create a query condition as well.

Keywords defined in patch will appear in the CIA when {Query} is pressed. They can then be used in a query
like this:
#» {Query} {Your keyword} {Can’t Be} {Beam Palette 5} [Enter]

Buttons on the facepanel, such as [Time] can also be used to construct a query.

Working with The Cue List

Changes in this section impact the Working with the Cue List chapter.

Non-intensity Parameter Category Cue Timing

Timing can be applied for Focus, Color and Beam parameter categories at a cue level. By default, FCB timing is
the same as intensity upfade time. Once FCB timing is different than intensity upfade time, those times are no
longer affected by intensity upfade changes.

When you apply a time to an individual parameter category and that category has no movement, the time is
displayed in gray. The specified timing will remain in gray until that category is provided with a move instruc-
tion, at which point it the timing will display in white.

»» [Record] <Cue> [2] {Color} [Time] [7] [Enter] - records cue 2 with a cue level color time of 7.

7 [Record] <Cue> [2] {Color} [Time] [Enter] - resets the color time of cue 2 back to the default value.

* [Record] <Cue> [2] [Time] [Time] [Time] [7] [Enter] - records cue 2 with a cue level focus time of 7. In
this example, each press of the [Time] key steps through each timing value (up time, down time, focus
time, color time and beam time.

?» [Record] <Cue> [2] [Time] [7] [Enter]- records cue 2 and puts a time of 7 on all parameter categories
(if F, C, B all had the same times to begin with).
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Note: Itis not necessary to rerecord a cue to alter stored timing data. You can simply redefine the
time by specifying the cue and re-entering the time value(s).

?» [Cue] [5] [Time] [8] [Enter] -redefines the all category times to 8 seconds (If FCB all had the
same timing).

? [Cue] [2] {Color} [Time] [5] [Enter] - redefines color time to 5 seconds.

?» [Cue] [3] {Focus} [Time] [-] [2] [Enter] - removes 2 seconds from the current time.

% [Cue] [7]1{Beam} [Time] [+] [3] [Enter] - adds 3 seconds to the current time.

N J

Discrete Channel/Parameter Timing

Rather than using cue times, timing can be applied directly at a parameter or channel level. This is referred to
as discrete time.

Discrete timing can be applied to a specific channel or parameter. You must select the channels that you want
to apply the time to, otherwise the system assumes you are addressing the selected cue.

Following are some examples of use:

#* [channel list] {Color} [Time] [3] [Enter] - adds a time of 3 seconds to all of the color parameters of the
channel list that have a move instruction.

»» {Focus} [Time] [7] [Enter] - assigns a time of 7 seconds for the focus attribute of all selected channels.

7 {Select Manual} {Beam} [Time] [7] [Enter] - selects channels with manual data and applies a time of 7
to any manual beam values.

Discrete delay times can also be placed on a channel parameter.

»» [1]{Color} [Time] [4] [Delay] [3] [Enter] - places a time of 4 seconds and a delay of 3 seconds on all
color parameters of channel 1.

The [+] and [-] hardkeys can be used to increase or decrease discrete timing values.

» [channel list] [Time] [+] [3] [Enter] - increases the discrete timing values by 3 seconds.
? [channel list] [Delay] [-] [1] [Enter] - decreases the discrete delay value by 1 second.

When timing has been applied to a channel parameter in live, a small red “t” will be dis-
played with the channel.This indicates the timing must be stored or updated to the
required cue. When this is done, the “t” is displayed in blue. In the Playback Status Dis-
play, a “+" is displayed in the associated parameter category time field, indicating that
not all of the parameters in the cue will use the cue timing. The [About] +[Time] key can
be held down to see the discrete delay/time information for channels in Live/Blind. Delay
is displayed first, followed by the timing value. Pressing [About] +[Time]Time] will latch
the display to show discrete timing information.

Note: Reminder that any conditions places on channel/parameter in live (such as discrete timing)
must be stored or updated to the cue.

Discrete Time as a Percentage
Discrete times can be entered as a percentage of the cue time.

?» [channel list] [Time] [/] [5] [Enter] sets the time for channel 2 to 50% of the cue time.
? [channel list] {Focus} [/] [7][5] [Enter] - sets the focus category time to 75%.

Follow/Hang

A follow time creates an auto-follow which automatically activates the next cue in the sequence when the fol-
low time of the associated cue has elapsed. The follow time begins counting from the moment the cue is
executed.
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The hang time is also an auto-follow, but rather than counting from the moment the cue is executed, it is cal-
culated from the completion of the cue. You can assign a negative value to a hang time, allowing a sub-
sequent cue to overlap an active cue.

You can assign either a follow time or a hang time, but not both. Both features are accessed using the [Shift] &
[Delay] keys on the console or the softkey {Fw/Hg}. [Shift] & [Delay] or {Fw/Hg} will put Follow on the com-
mand line, and [Shift] & [Delay] [Delay] or double pressing {Fw/Hg} will put Hang.

Following are some examples of use:

»» [Record] <Cue> [5] [Shift] & [Delay] [8] [Enter] - records cue 5 and provides a “follow” time of 8
seconds which impacts the start of the next cue in the list. The following cue will automatically initiate
on the same fader when the follow time has elapsed. The follow time will begin counting down when
the associated cue (Cue 5) is executed.

** [Record] <Cue> [5] [Shift] & [Delay] [Delay] [8] [Enter] - records cue 5 and provides a “hang” time of
8 seconds which impacts the start of the next cue in the cue list. The following cue will automatically ini-
tiate on the same fader when the hang time has elapsed. The hang time will begin counting down
when the associated cue (Cue 5) is complete.

*+ [Record] <Cue> [5] [Shift] & [Delay] [Delay] [-] [5] [Enter] - records cue 5 and provides a ‘' "hang”
time of negative 5 seconds.

To remove a Follow/Hang time:
? [Cue] [x] [Shift] & [Delay] [Enter]

[Update]

Update is a powerful feature, and also very versatile. Using a combination of [Cue Only], [Track], [Trace], and
{Make Absolute}, the number of ways you can update specific information and manual data is virtually end-
less. Data can be updated to various record targets either at once, or individually.

Update Dialogue Box

When you press [Update], a dialogue box will open in the CIA. Update styles and modifiers for those styles will
be divided in the Update Dialogue Box.

Note: Default Update Modes are setin Setup>Desk>Record Defaults. See Update Mode on
page 2 for more information.

Update Styles

»+ {All} - this button will update the target cue and all references stored to that cue (nested and otherwise).

» {Make Absolute} - this button will update the target cue and convert all levels to absolute values,
thereby removing any references.

7+ {Ref Only} - this button will only update the palettes or presets used in the cue, but will not update the
cue itself. If a manual reference was used before using {Ref Only}, the last manual reference will be
updated.

Update Modifiers

»» {Last Ref} - this button will update using the last reference that was applied.

»» {Break Nested} -this button will update the target cue and any presets used, but breaks the reference
to any palettes nested in a preset. For example, if cue 1 channel 1 references preset 3, and preset 3 was
built using color palette 5. When updated with this option, preset 3 would be updated, color palette 5
would not, and the reference to CP5 would be broken in preset 3.

»» {Reset Update} - this button will clear any commands after the [Update] command to quickly undo
pending changes before [Enter] is pressed.
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Target Channels Update Update

Cue 2 1>3 Style Modifiers

Al Last Ref

Make Break
Absolute Nested

Ref Only

Reset
Update

The dialogue box also provides you with a listing (by record target) of what channels/parameters will be
impacted by the update instruction. If the channel contains a reference in the cue, itis indicated. If not, a “+”
is displayed. Channels that have been manually added to the stage output, but are not overrides of an active
cue will update to the selected cue list.

Once you have made a selection from the available options, press [Enter] and the target will be updated.
Targets may be deselected from the dialogue box, excluding them from the update without specifying the tar-
get number, for example, [Update] {Color Palette} [Enter].

Updating to References

When a cue is active, it is possible that various record targets (palettes or presets) will be played back within
that cue. As changes are made to the data in that cue, as well as to the individual palettes or presets, updating
both the cue and references within that cue is simple. When you have overridden a reference in a cue, the
data is displayed in red with a red “R" in superscript next to the channel’s intensity.

By default, Element updates any referenced data that was included in the cue.

4 Y

For Example:

Cue 5isrecalled Live. It contains references to color palette 1 and preset 2. You make changes to
channels included in these record targets. To update both the cue and the palettes/presets, press:

#* [Update] [Enter]

This will automatically take the manual changes and update them to color palette 1 and preset 2.
Therefore cue 5 now references these new values, and the modifications to CP1 and PR2 have
propagated through all of the show data.

If you had made changes to other channels that were not included in the palettes/presets used in cue
5, those values would also be updated to the cue as absolute data.

(. J

Updating Without References (Make Absolute)

If you want to record your changes to the cue without updating the references, you may use {Make Absolute}
to break the association to the reference. The {Make Absolute} command can be applied to the chan-
nels/parameters required before the update instruction, or they can be applied during the update.

» [Update] {Make Absolute} [Enter] - this will break the references for any parameters which have been
changed and update the cue with the changes. The referenced target will no longer be displayed in the
channels which were made absolute. All of the data updated in cue 5 will now be shown as absolute
data.

?* [5][Thru] [9] [Update] {Make Absolute} [Enter] - this will break only the references for channels 5-9
and record their manual values to the cue. Other manual values will not be included in this update.

You may also use [Record Only] to break references.
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For Example:

Cue 5is active and onstage. Channels 5-20 are currently referencing preset 1. You make changes to
channels 5-9. The data for these changes is now manual. Press:

»» [Record Only] [Enter] [Enter]
If there were other changes on stage, you could have used:
»» [5][Thru] [9] [Record Only] [Enter] [Enter]

Only the manual data will be recorded as an update to cue 5. The reference to preset 1 for channels
5-9 is broken and now the cue will display the absolute data rather than the reference indicator.
(& J

Update Using Cue Only/Track

The [Cue Only/Track] key can be used as an applied exception to the cue only/track system setting. Therefore
if the system is set to Cue Only, the key behaves as a [Track] command. Alternatively, if the system is set to
Track, the key behaves as a [Cue Only] button.

[Cue Only/Track] can be used in conjunction with record or update functions. Following are some examples of
use:

Note: In the following examples, the commands [Cue Only] and [Track] indicate the same key hit
of [Cue Only/Track] - a single button on the keypad. The system setting determines the actual con-
text of the button. For clarity, only the contextual function of the button is used in the examples.

With system set to “Track”
** [Record] <Cue> [5] [Cue Only] [Enter] [Enter] - rerecords cue 5. This will make the changes to cue 5
only. The changes will not track forward through the list.

#+ [-][Color] [Record] <Cue> [5] [Cue Only] [Enter] [Enter] - as above, but changes to color parameters
will not be included in the record and all data that was included will not track forward. Color data in the
cue remains unchanged.

** [Update] <Cue> [5] [Cue Only] [Enter] - updates cue 5 with only those manual parameters that were
receiving their instructions from that cue. The changes will not track forward in the list. Note that if the
data being updated were referenced, this action updates the referenced target as well.

** [-1[5] [Record] <Cue> [7] [Cue Only] [Enter] [Enter] - rerecords the specified cue, except the con-
tributions from channel 5. The changes will not track forward in the list.

With system set to “Cue Only”
? [Record] <Cue> [5] [Track] [Enter] [Enter] - rerecords cue 5. This will force the changes to track for-
ward in the list until the next move instruction or block.

?» [-1[5]1 [Color] [Record] <Cue> [7] [Track] [Enter] [Enter] - rerecords the specified cue, except the
color data from channel 5. The recorded changes will track forward in the list.

** [Update] <Cue> [3] [Thru] [7] [Track] [Enter] - updates cues 3 thru 7. Range updates are subject to
the normal rules of track/cue only in determining impact on subsequent cues.

Using Trace

{Trace} works just as Track does, except it allows changes to be tracked backwards through the cue list, until it
sees a move instruction. A trace will track into, but not beyond, a blocked instruction.

Following are some examples:

** [Update] <Cue> [5] {Trace} [Enter] -updates cue 5, and tracks changes backward until a move instruc-
tion is encountered. If the system is in track mode, the change will track forward in the cue list until the
next move instruction or block. If in cue only mode, this has no impact on subsequent cues.
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»» [Update] {Trace] [Cue Only/Track} [Enter] - updates the selected cue and tracks changes backward
until a move instruction is encountered. If the system is in track mode, the change is prohibited from
tracking forward in the list. If in cue only mode, the change is allowed to track forward.

When a channel that is inactive (at zero or null) in the cue list receives an active level, if update trace is used,
that channel will not trace the current setting into previous cues. To force that channel's new value to go back-
ward in the cue list, {Trace} {Trace} can be entered.

Updating the Current Cue
The current cue is updated by simply pressing [Update] [Enter].

Updating a Source Cue

To update the source of a level in the current cue (therefore, a move instruction in a prior cue) you must specify
a trace for the desired channel(s).

» [5] [Update] {Trace} [Enter] - Updates any manual changes for channel 5 in the current cue. Any
tracked values for channel 5 are traced back to the source of the value (the original move instruction)
and changed to the new value. The value for traced changes in the current cue will be magenta indic-
atingitis a tracked value.

» {Trace}{Trace} - If a channel was inactive in the cue (either because it had not previously been used in
the cue list, or it was a tracked zero) and is set to a new level, by default the new level will not track
back. You can force it by pressing {Trace} twice.

Updating a Non-Active Cue

It is possible to use the same update commands as current and source cues to update inactive cues (cues not
live onstage). In these situations, if the updated cue is not the source of a channel’s live value, manual data will
remain manual. If the updated cue is the source of the current value, the values will change to magenta (indic-
ating tracked) when the update is completed.

Update [Thru]

Using [Update] [Thru] allows you to update from a current cue to a destination cue without first entering the
current cue's number.

For Example:

If you are currently in cue 5 and you want to update through cue 10, you would use the following syn-
tax:

# [Update] [Thru] <Cue> [10] <CueOnly/Track> [Enter]

Update [+]
[+] can be used to specify a range of cues for updating. [+] can also be used with [Record] and [Record Only].

N\

p Note: If no cue number is entered before the [+], the current active cue will be used.

s N

For Example:
To update only cues 5, 10, and 15:

» [Update] <Cue> [5] [+] <Cue> [1][0] [+] <Cue> [1][5] <CueOnly/Track> [Enter]
To update the current cue and cue 7:
» [Update] [+] <Cue>[7] <CueOnly/Track> [Enter]
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Additions to Palettes

Changes in this section impact the Storing and Using Palettes chapter.

Palette Options
When recording palettes, three softkey options are available:

{By Type}

By Type palettes are created with 'default’ channels which contain values that can be assigned to any other
channel within the same fixture type. By Type palettes can also contain discrete channel values.

By Type palettes will display a ‘T" in the lower corner of the direct selects and in the palette lists. A ‘+" will dis-
play after the ‘T" if there are channels stored with discrete data.

See Using By Type Palettes on page 11 for more information.

{Absolute}

Absolute palettes are palettes that when recalled the data is displayed and treated like absolute data applied
to a channel. The data is never referenced.

An absolute palette will display with an ‘A’ in the lower corner of the direct selects and in the palette lists.

{Locked}
Locked palettes are palettes that are protected from being accidentally changed in Live.
A locked palette will display a “L" in the lower corner of the direct selects and in the palette lists.

Locked palettes can be updated by specifically calling the channels and the record target, [channel list]
[Update] [Record target] [Enter]. Using [Update] {Color Palette} [1] [Enter] would not work in Live for a
locked palette. However locked palettes are not protected in Blind.

Using By Type Palettes

Storing a By Type Palette

If {By Type} is used when recording, the lowest number channel of each fixture type will be the default chan-
nel. Generally, when storing by type palettes, you will want only one channel of each fixture type in use. Any
additional channels in that fixture type will be recorded with discrete data.

?» [1]1[Thru] [5] [Record] [Int Palette] [1] {By Type} [Enter] - Channels 1 through 5 are saved to Intensity
Palette 1. Channels 1 through 5 are of the same fixture type. Channel 1 will be the default channel and
channels 2 through 5 will be saved with discrete data.

?» [1]1[Thru] [5] [Record] {Intensity Palette 1} [Enter] - If a by type palette is recorded without using the
{By Type} softkey and the default channel is included in the record, the default channel’s level will
change and all other changes will be discrete.

#+ [11[Thru] [5] [Record] {Intensity Palette 1} {Discrete} [Enter] - If a default channel is included in a
record where {Discrete} is used and another channel is tracking it, the default channel will be changed
to having discrete data and the lowest numbered tracking channel will become the new default chan-
nel. All other channels in the record will also have discrete data.

Editing By Type Palettes in Blind

In Blind, the default channel’s levels will display in blue, discrete data for the other channels will display in
white, and any channels that are using the default channel value will display in magenta.

» [3]{By Type} [Enter] - makes channel 3 the new default channel for that device type. If another chan-
nel for that type was the default channel, its data will now be discrete.
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[1]1[0] [Thru] [2] [0] {Discrete} [Enter] - changes the levels for channels 10 through 20 to discrete. If
any of those channels are default, the lowest numbered tracking channel will become the new default
channel.

[5] [Thru] [8] [At] [Enter] - removes the discrete data for channels 5 through 8. They will now use the
default channel’s values.

{Color Palette} [2] {Discrete} [Enter] - changes all tracking and default channels to discrete.
[Intensity Palette] [5] {By Type} [Enter] - makes the first channel of each device type a default chan-
nel.

{Beam Palette} [3] {Cleanup} [Enter] - converts palettes created in earlier versions of Eos Family soft-
ware to by type palettes. This command will use the first channel of each type as the default, and allow
other channels of the same type to use that value upon recall.

{Make Null} can be used with by type palette when you wish to withhold a channel from responding to a by
type palette recall. The data will still display but will be in gray witha “N”. See Using {Make Null} on page 3.

Updating By Type Palettes

Pressing {By Type} after an [Update] command, with a channel tracking but no default channel included in the
update, will cause the lowest numbered tracking channel's level to be updated into the default channel. The
tracking channel will remain tracking. This means that when updating a default value in a by type palette, you
don’t need to know the default channel number.

When a default channel is included in an [Update] command without using {By Type} and another channel is
tracking it, the default channel’s data will be changed to discrete. The lowest numbered tracking channel will
then become the new default channel. Any other updated channels will be made discrete.
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Storing and Using Presets

This chapter contains the following topics:
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About Presets

Presets are very similar to palettes in that they are collections of data for specific channels to facil-
itate cue creation. Presets, however, can collect all data for a given channel (intensity, focus, color,
beam) rather than just one parameter type.

Up to 1000 presets may be stored in Element using decimals (up to three places) or whole numbers
and they can contain absolute data and/or a mix of IFCB palettes. Presets can not refer to other pre-
sets.

Preset Options

When recording presets, three softkey options are available.

{Absolute}

Absolute presets are presets that when recalled the data is displayed and treated like absolute data
applied to a channel. The data is never referenced. An absolute preset will display with an ‘A’ in the
lower corner of the direct selects and in the presets list.

{By Type}
By Type presets are created with 'default’ channels which contain values that can be assigned to any
other channel within the same fixture type. By Type presets can also contain discrete channel values.

By Type presets will display a ‘T" in the lower corner of the direct selects and in the presets list. A '+’
will display after the ‘T"if there are channels stored with discrete data.

{Locked}

Locked presets are presets that are protected from being accidentally changed in Live.
A locked preset will display a “L" in the lower corner of the direct selects and in the presets list.

Locked presets can be updated by specifically calling the channels and the record target, [channel
list] [Update] [record target] [Enter]. Using [Update]%Preset] [1]1 [Enter] would not work in Live for a
locked preset. However locked presets are not protected in Blind.

Storing Presets Live

Presets can be recorded live using the keypad and/or the direct selects. Both [Record] and [Record
Only] can be used to record presets, with or without filters.See Storing Data with Record Filters
(page 32) for more information.

[Record] will store all channels that are not at their default values, and it will record all information
about those channels, including parameters that are still at default. Therefore presets can contain all
of the same information as a cue, but they have no timing information or cue attributes (such as fol-
low, delay, or cue overrides). When recorded or re-recorded, presets are automatically recalled on
stage. Presets may be individually labeled and each has an optional notes field.

Storing Presets Using [Record]

The [Record] key will store all parameter data for channels that are not at their default values, as mod-
ified by the filter settings in the CIA. This will store all parameter data that is not default even if it is
not manual data. If filters are used, only the parameters enabled by the filters are stored.

VXhen you record data to a preset live, the channels involved in that preset will then actually be in
that preset.

Note: To access [Preset] on Element, press [Shift] + [Intensity Palette] or use the {Preset} but-
ton in ML Controls.

The following methods can be used to store presets using [Record]:
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»» [Record] [Preset] [5] [Label] [name] [Enter] - records all parameter data for all channels not at
default and adds a label to preset 5.

#» [Record] [Preset] [Next] [Enter] - records data to the next sequential preset number.

" [-_1(_[24 [Record] [Preset] [n] [Enter] - stores the preset, withholding the group or channels spe-
cified.

”» |[.channellllis(;[] [Record] [Preset] [6] [Enter] - stores the preset, but only the data for the channel
ist supplied.

7> [Record] & {Preset direct select}- stores the preset to the specified direct select.

#» [channel list] {AlINPs} [Record] [Preset] [8] [Enter] - records all non-intensity parameters for the
selected channels to the preset.

. Note: When using selective record, the user must specify the channel list to be included (or
excluded as the case may be) as part of the [Record] command. Otherwise, all parameters of
channels with non-default values will be stored in the preset.

N J

. Note: You may also use the filters and {Make Null} as additional tools to decide what data
will be stored. For more information on these features see Using {Make Null} (page 3) and
About Filters (page 31) .

. J

When you re-record an existing Preset, a confirmation will be required, unless confirmations have
been disabled in Setup>Desk>Record Defaults>Record Confirm.

Storing Presets Using [Record Only]

[Record Only] is a selective record process that stores only manual parameter data. Therefore, when
used to record presets, only manual data for channels will be stored in the preset. As with [Record],
filters and {Make Null} can be used to further modify what information is stored. See Storing Data
with Record Filters (page 32).

Double pressing [Record] will post Record Only to the command line.
The following methods can be used to store presets using [Record Only]:

#» [Record Only] [Preset] [5] [Label] [name] [Enter] - records manual parameter data for all chan-
nels and adds a label to preset 5.

¥ LRecord Only] [Preset] [Next] [Enter] - records manual data to the next sequential preset num-
er.

* [ [3]f[R§cord Only] [Preset] [n] [Enter] - stores the preset, withholding the group or channels
specified.

» [Channel list] [Record Only] [Preset] [6] [Enter] - stores the preset, but only the manual data for
the channel list supplied.

» [Channel list] {Color} [Record Only] [Preset] [7] [Enter] - stores only manual color data for the
specified channels to the preset.

Using By Type Presets
Storing a By Type Preset

If {By Type} is used when recording, the lowest number channel of each fixture type will bethe
default channel. Generally, when storing by type presets, you will want only one channel of each fix-
ture type in use. Any additional channels in that fixture type will be recorded with discrete data.

#» [1] [Thru] [6] [Record] [Preset] [1] {By Type} [Enter] - Channels 1 through 6 are saved to Preset
1. Channels 1 through 6 are of the same fixture type. Channel 1 will be the default channel,
and channels 2 through 6 will be saved with discrete data.

fra
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#» [1][Thru] [6] [Record] [Preset] [1] [Enter] - I a by type preset is rerecorded without using the
{By Type} softkey and the default channel is included in the record, the default channel's level
will change and all other changes will be discrete.

#» [1] [Thru] [5] [Record] {Intensity Palette 1} {Discrete} [Enter] - If a default channelis included in a
record where {Discrete} is used and another channel is tracking it, the default channel will be
changed to having discrete data and the lowest numbered tracking channel will become the
new default channel. All other channels in the record will also have discrete data.

Editing By Type Presets in Blind

In Blind, the default channel’s levels will display in blue, discrete data for the other channels will dis-
play in white, and any channels that are using the default channel value will display in magenta.

ch Intens Intensity MSpeed al Cyar Color Select Color Wheel Mode

1 FL 0 0 0 0 67 56 3 F1- 25
72 FL F1-

73 FL F1-
74 FL Fi-
75 FL 0 0 0 0 6 6 - F1-
76 FL 0 0 0 0 67 56 . Fi-

Softkeys available for editing presets in blind are {By Type}, {Discrete}, and {Cleanup}.

» [3]1{By Type} [Enter] - makes channel 3 the new default channel for that device type. If another
channel for that type was the default channel, its data will now be discrete.

»» [11[0] [Thru] [2] [0] {Discrete} [Enter] - changes the levels for channels 10 through 20 to dis-
crete. If any of those channels are default, the lowest numbered tracking channel will become
the new default channel.

»» [5][Thru] [8] [At] [Enter] - removes the discrete data for channels 5 through 8. They will now
use the default channel’s values.

»» [Preset] [2] {Discrete} [Enter] - changes all tracking and default channels to discrete.
»» [Preset] [5]1{By Type} [Enter] - makes the first channel of each device type a default channel.

»» [Preset] [3]1{Cleanup} [Enter] - converts presets created in earlier versions of Eos Fami(ljy soft-
ware to by type presets. This command will use the first channel of each type as the default,
and allow other channels of the same type to use that value upon recall.

{Make Null} can be used with by type preset when you wish to withhold a channel from responding
to a by type preset recall. The data will still display but will be in gray witha “N".

Updating By Type Presets

Pressing {By Type} after an [Update] command, with a channel tracking but no default channel
included in the update, will cause the lowest numbered tracking channel's level to be updated into
the default channel. The tracking channel will remain tracking. This means that when updating a
default value in a by type preset, you don’t need to know the default channel number.

When a default channel is included in an [Update] command without using {By Type} and another
channelis tracking it, the default channel’s data will be changed to discrete. The lowest numbered
tracdkm channel will then become the new default channel. Any other updated channels will be
made discrete.

Effects In Presets

Effects can be stored in a preset, and those presets can be used to create submasters and cues.
Hhowever, the effect's data is only copied to the submaster or cue, it is no longer referenced through
the preset.
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Note: If used with submasters and cues, the data is not referenced. So if changes are made
to the effect in the preset, the effect saved to the submasters and cues will remain
unchanged.

The preset list display has a column for effects.

Recalling Presets

Channels must be selected when recalling a preset. If a selected channel or parameter has no value in
the preset, it will stay in its current position. If you want to recall all channels in a preset, you can
press [Recall From] [Preset] [x]. Presets on direct selects will grey out if they are not applicable for the
current channel selection.

If you only want to recall certain parameters of the preset, select channels and enter the required
alram>eters (or those not required, using the [-] keyfln the command line (see command examples
elow).

When a preset is recalled, parameter changes will follow the manual timing defaults, if enabled.
You may recall presets using any of the following methods:

»» {Preset direct select}- recalls the associated preset data for selected channels.
7> [Preset] [2] [Enter] - recalls preset 2 for selected channels.
»» [Channel List] [Preset] [2] [Enter] - recalls the preset data for the channels in the selection list.

»» [Channel List] {Color} [Preset] [5] [Enter] - recalls only the color data from the specified preset
for the specified channels.

”» {%olor} |& {Preset direct select}- recalls just the color data from the specified preset for selected
channels.

#» [Recall From] [Preset] [3] [At] [5] <O> [Enter] - recalls all channels in preset 3, and sets all intens-
ity values at 50%. The original intensity data is still linked to the preset. If the intensity change
is desired you must update the ﬁreset to maintain the change and the link, or make the data
absolute before storing to another record target.

#» [Channel List] [Preset] [7] [Enter] [At] [/] [5] [Enter] - recalls preset 7 for selected channels.
Intensity values will be recalled at 50% of their recorded state. The intensity link is maintained.
If the intensit?/] change is desired the user either needs to update the preset to maintain the
change and the link, or make the data absolute before storing to another record target.

#» [Recall From] [Preset] [9] [Enter] - selects all channels with data stored in preset 9.

#» [1] [Recall From] [Preset] [1] [At] [5] [0] [Enter] - recalls the intensity of channel 1 from preset 1
at 50% of the stored value. If channel 1 was set to 50 in preset 1, it’s recalled value would be
25.

Editing Presets Live

There are two ways to edit a preset in Live. You may rerecord the preset or you may use [Update].

Rerecord

Rerecording follows the conventions of [Record] and [Record Only]. The only exception is that a con-
firmation is required to actually rerecord the preset.

Two different mode for rerecording:

#» [Record] [Preset] [5] [Enter] [Enter] - overwrites the content completely.
#» [Channel List] [Record] [Preset] [5] [Enter] [Enter] - merges the data.

Update

[Update] is used to record parameter modifications back to a preset. When updating, you must spe-
cify the preset to be updated. You may do this using the keypad or the direct selects.
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For the purposes of the following descriptions, assume that there are no active cues on stage. .

4 Y

For Example:
To update a preset, first recall the preset for any channels you wish to edit.

» [1]1[Thru] [5] [Preset] [1] [Enter]
or
»* [Recall From] [Preset] [1] [Enter]

Make required changes to the desired parameters using the keypad or encoders in the
ML Controls display. Once you have achieve the desired look, update the preset.

»» [Update] [Preset] [1] [Enter]
or
»» [Update] & {Preset 1}

A\ J

When updating a preset, only channels that are already in the preset will be updated. You need to
select channels or parameters to force new data into a preset when using [Update].

Using the Preset List

The preset list displays all recorded presets. List views only allow you to change attributes; no editing
can be done directly in list view.

Opening the Preset List

When you press the [Shift] + [Intensity Palette] twice, the preset list will open on a new tab (or brings
the list view into focus if already open). You can also open the list view from the home screen or by
pressing [Tab] + [2][6].

Pressin%the {Edit} softkey takes you to the blind view of the selected preset, in the last format you
used in blind. This will allow you to edit the preset. You can change the blind display to spreadsheet
or table view by pressing the [Format] key.

You can navigate the preset list using [Next] and [Last].

Copy To
You can copy presets within the list to another location in the list using [Copy To].
»» <Preset> [2] [Copy To] [9] [Enter] [Enter] - copies the contents of preset 2 to preset 9. Preset 2

will remain in the list. The second [Enter] is not required if you have disabled confirmations in
setup.

You can also use [Copy To] from palettes to presets.

Move To

You can move presets within the preset list using the {Move To} softkey. You can also hit [Copy To]
[Copy To] to access {Move To}.

7 <Preset> [3] {Move To} [8] [Enter] [Enter] - moves preset 3 to preset 8. Preset 3 will be removed
from the list. The second [Enter] is not required if you have disabled confirmations in setup.

" <hPreseth> [1]1 [Thru] [5] {Move To} [6] [Enter] [Enter] - moves presets 1 through 5 to presets 6
through 10.
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You can also move data from a palette to a preset and vice versa. It is important to remember that
wher|1 using the {Move To} command that data is removed from its current location and moved to its
new location.

Editing Presets in Blind
IAII presets can be viewed and edited in blind. To open a preset in blind, you can do any of the fol-
owing:

»» Press [Blind] & {Preset x} - opens to the specific preset.

#» Press [Tab] + [2][6] - opens the preset list.

¥ Press [Shift]+[Intensity Palette] twice and then {Edit} when a preset is selected in the list.

When editing presets in Blind, changes to presets are automatically stored. There-
fore no update or record command is required.

You can change the blind display to spreadsheet or table view by pressing the [Format] key. In blind,
the following softkeys are availa{)Ie when editing presets:

7 By Type

¥ Absolute

» Lock

» Cleanup

» Discrete

7 Offset

7 Make Null

¥ Make Absolute

7 Replace With

7 Query

Editing in Table View

Table view shows the data for one preset at a time in a table. Channels are displaf(ed on the Y axis
and parameters are shown along the X axis. Viewing presets in the table is useful if you want to see
data for numerous channels in one specific preset.

To change which preset you are viewing you may use the [Next] or [Last] keys or you may select the
exact preset from the keypad or direct selects. You can make changes to the preset by selecting
channels and altering parameter values. In addition to normal editin%functions, you may also use the
following commands in this view: [Copy To], [Recall From], {Make Absolute}, {Make Null}, {Move To},
and {Replace With}.

Here are some examples of the additional preset editing features you have while editing in table view:
» [select channels or parameters]{Make Abs} - changes the data for any palette references
within the preset into absolute data that no longer references another record target.

» [select channels or parameters] {Make Null} - removes the data for the specified channel or
parameter from the preset.

#» [select channels or parameters] [At] [Enter] - removes the data for the specified channel or
parameter from the preset.

7+ [Preset] [5]{Move To} [Preset] [9] [Enter] - this will move the contents of preset 5 to preset 9.
Preset 9 will be created and preset 5 will be deleted.

» [Preset] [1] [Copy To] <Preset> [5] [Enter] - this will copy the contents of preset 1 to preset 5.
You may also copy ranges of presets to new locations.

#» [1][Recall From][Preset][1][Enter] - will recall the contents for channel 1 in preset 1.
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Note: While editing presets in blind, hitting [Recall From] [Recall From] will put [Recall
From] [Preset] on the command line.

Editing in Spreadsheet View

Spreadsheet view shows a range of presets along the Y axis and channels/channel parameters along
the X axis. Viewing presets in spreadsheet view is useful when you want to compare data between
presets.

You may select a preset from the spreadsheet using the [Next] or [Last] keys to move through the list
or you may select the exact preset from the keypad. You may also select a range of presets to edit at
once. You can make changes to the preset(s) by selecting channels and altering parameter values.

In addition to the examples given in table view, here are some examples of the additional preset edit-
ing features you have while editing in spreadsheet view:

#» [Preset] [1] [Thru] [5] {Move To} <Preset> [9] <Thru> [Enter] - this will move presets 1-5 to pre-
sets 9-14 respectively. You do not have to supplz the end value for Element to perform the
move. If presets 9-14 already exist you will be asked to confirm this move.

#» [Preset] [1] [Thru] [5] [Enter] {Iris} [5] [0] {Replace With} <Iris> [2] [5] [Enter] - for presets 1-5,
this command will replace any iris parameter values of 50 with values of 25. This range editing
using {Replace With} can only be done in spreadsheet view.

Removing Channels From a Preset

You can remove specific channels from a preset. This can be done from blind.

4 Y

For Example:
Open the preset in blind:

»» [Blind] & [Preset]

Select the preset you wish to edit:
»* [Preset] [5] [Enter]

Remove channels by pressing:
» [2][+] [4] [+] [6] [Thru] [9] [At] [Enter]

Or you can remove a specific channel parameter from the preset by pressing:
2 [5]1[+][7]1{Color} [At] [Enter]

You may also remove a channel/parameter from a range of presets by pressing:
»* [Preset] [1] [Thru] [5] [Enter] [1] {Color} [At] [Enter]

You can remove channels from live by pressing:
» [channel list] [Delete] [Preset] [2] [Enter]

. J

Deleting Presets

You may delete presets in the following ways:

7+ [Delete] [Preset] [1] [Enter]
»» [Delete] [Preset] [1] [Thru] [5] [Enter]
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Presets can be deleted from any screen, at any time. A confirmation is required to delete, unless con-
firmations have been disabled in Setup>Desk>Record Defaults>Delete Confirm.

Storing and Using Presets
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Chapter 2
Using Fan

This chapter contains the following topics:

ADOUL FaNn 23
Fanning Parameter Data ... ... .. .. 23
FanFromthe Command Line ... ... .. . 23
Fanning References .. ... 24
Fanning Timingand Delays ... ... . 24
Using Subgroups with Fan ... .. 24
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About Fan

Fan provides the ability to spread parameter and.timin?. values in a range across a channel selection
set and have those values be evenly spaced. Fan is applied by channel selection or group order. By
default, fan operation is from the start channel.

When {Fan} s pressed after a channel selection, the softkeys will repaint to the following fan styles:

»» {Center}- The middle channel in the order is set as the start and will remain unchanged, and
the first and last channels will change in different directions. The level wheel will decrease the
iow?r nhumlber channels and increase the higher number channels. {Center} only affects the
evel wheel.

»» {Reverse} - The selected channel order is reversed before applying the fan.

»» {Mirror Out} - The middle channel in the selected order is used as the starting channel and the
first and last channels in the order are the end channels.

# [5][Thru] [1][0] [At] [1][0] [Thru] [3][0] {Fan} {Mirror Out} [Enter] - sets channel 1 to
30%,2t020%, 3t0 10%, 41020%, and 5t0 30%.

»» {Repeat}- The number of channels that are fanned before the pattern is repeated.

#» [1][Thru] [1][2] [At] [5][0] [Thru] [7][0] {Fan} {Repeat} [3] [Enter] - sets channels 1,4,7,
and 10 at 50%, 2,5,8,and 11 at 60%, and 3,6,9, and 12 at 70%.

”» {Clluster}— The channels are put into collections, which contains channels with all of the same
value.

7 [1]1[Thru] [11[2] [At] [5][0] [Thru] [8][0] {Fan} {Cluster} [4] [Enter] - sets channels 1
through 3 at 50%, 4 through 6 at 60%, 7 through 9 at 70%, 10 through 12 at 80%.

»» {Random} - The selected channels are put in a random order before fan is applied.

Fanning Parameter Data

Fan values can be adjusted with either the ML Controls or via the keypad. To adjust the fan values
with an virtual encoder in the ML Controls, select the required channels and provide a baseline, if
necessary, followed by {Fan}.

If no value is entered, the current values will be used. When using virtual encoders to adjust fan, it is

not necessary to specify the parameter to be fanned. This is determined by the virtual encoder used.

»» [1][Thru] [5]{Fan} [Enter] - selects the channels 1 through 5 and puts the virtual encoders and
level wheel into fan mode.

#» [1][Thru] [5] [At] [5] <0> {Fan} [Enter] - selects the channels 1 through 5, sets a start level of
50% and puts the virtual encoders and level wheel into fan mode.

»» [1] [Thru] [5]1{Fan}{Mirror} [Enter] - selects the channels 1 through 5 and puts the virtual
encoders and level wheel into fan mode with mirror style.

Fan From the Command Line

A level or time command that uses [Thru] or a list of references is a command line fan command.

P Note: The {Fan}key is not necessary unless a fan style other than the default is needed. ]

To adjust the fan values from the command line:

# [1]1[Thru] [5] [At] [1] <0> [Thru] [5] <0> [Enter] - sets channel 1to 10%, 2 t0 20%, 3 to 30%,
4t040%), and 510 50%. This is the default fan adjustment and the {Fan} command is not
necessary.

» [11[Thru] [5]1 [At] [1] <O> [Thru] [3] <0> {Fan} {Mirror} [Enter] - sets channel 1 to 30%, 2 to
20%,31t010%, 41020%, and 5t0 30%.
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Fanning References
When fanning references, such as palettes, if there are more that 2 reference lists are used then the
data will be referenced data. The fan will be repeated if there are more channels than references.

» 1 ]d['lhru] [5] [Int Palette] [1] [Thru] [3] [Enter] - sets channel 1 to IP1, 2 to IP2, 3 to IP3, 4 to IP1,
and 5to IP2.

g‘the list contains 2 or less references, fan will be set to the levels between the references as absolute
ata.

#» [1] [Thru] [5] [Int Palette] [1] [Thru] [2] [Enter] - (Intensity palette 1 is all channels at 0% and
Intensity palette 2 is all channels set to 100%.) sets channel 1t0 0%, 2 t0 25%, 3t0 50%, 4
t0 75%, and 5 to 100% as absolute data.

Fanning Timing and Delays
Fanning timing and delays work exactly like fanning parameters.
»» [1]1[Thru] [5] [Time] [6] [Thru] [1] [0] [Enter] - sets the discrete times for channel 1 to 6 seconds,
2 to 7 seconds, 3 to 8 seconds, 4 to 9 seconds, and 5 to 10 seconds.

#» [1] [Thru] [5] [Delay] [6] [Thru] [8] {Fan} {Mirror} [Enter] - sets the discrete delays of channel 1 to
8 seconds, 2 to 7 seconds, 3 to 6 seconds, 4 to 7 seconds, and 5 to 8 seconds.

Using Subgroups with Fan

Subgroups can be used with the Fan feature. Channels in the same subgroup will act as a single chan-
nel when fanned.

4 Y

For Example:

Group 1 is made up of channels 120 thru 130. Channels 120 thru 123 are one subgroup,
channels 124 thru 126 are not in any subgroup, and channels 125 thru 130 are another sub-

group.

» [Group] [1] {Fan} [Enter]

Selects group 1 and puts it into fan mode. Rolling up the level wheel creates the following
result. Channels 120 thru 123 share an intensity, channels 124 thru 126 each have different
intensities, and channels 127 thru 130 share an intensity.

(120 (121 (122 |(123 (124 |[125| (126 |[ 127 |[128 |( 129 |[ 130
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Chapter 3

Multiple Users

This chapter contains the following topics:

About Multiple Users _ ...
About User ID
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About Multiple Users

Element can be set to act as a separate user from other consoles on the Eos Family system, or it can
be set to act as the same user as another console. This is done by changing the user ID.

About User ID

When multiple users are on the Eos Family network, they can all act as one combined user, as all sep-
arate users, or any of the varying degrees between.

Any Eos Ti, Eos, and Gio console, RPU, lon, Element, RVI, ETCnomad, or ETCnomad Puck can be a
separate user on the Eos Family network. Certain devices work well as independent users while oth-
ers are intended to share a user ID with another device. For example, consoles and RPUs are likely can-
didates for working with a unique user ID while RVIs and ETChomads can be useful sharing an ID

with another device to track programming information from a second location.

Eos Family devices sharing User IDs will share certain data, while those with different IDs will not.
Below are the differences in multi-console data depending on User ID.

Data shared between Eos Family devices with the same User ID

¥ command line

» null channels in live
# selected channels
7 filters

7 selected cue

¥ live/blind mode

# setup>desk settings

Data specific to the Eos Family device, regardless of User ID

»» current fader page

¥» current encoder page

#» focus on displays without command line

#» display configuration (layout, format, visible parameters, flexichannel)
»» paging without changing selected target or channels

Data identical between all Eos Family devices, regardless of User ID

# all stage levels and edits
»» all data stored in the show file
»» playback, sub and grandmaster contents and progress

The default User ID for any Eos Famil;gdevice is 1. You may change this based on your preference to
allow/restrict the functionality described above.

Assigning User ID
User ID can be defined in Setup>Desk>Display>User ID. See User Id (page 2) for more information.

When multiple programmers are working on an Eos system, partitioned control can be used to
restrict a specific user’s access to certain channels. This can help avoid overlapping control of chan-
nels by multiple programmers at once.

For more information on partitioned control, see Using Partitions (page 28)

Multiple Users
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Using Partitioned Control

This chapter contains the following topics:

About Partitioned Control ... ... ... 28
Using Partitions .. . . 28
Creating New Partitions ... ... ... .. 28
Deleting Partitions _ ... . . . . 29
Flexichannel in Partitioned Control ... ... . .. . L 29
How to Use Partitions .. .. . .. . 29
Partition List .. . 29
Setting Up Partitioned Control ... ... . . 29

Using Partitioned Control



28

About Partitioned Control

Partitioned control allows discrete control and programming of channels between multiple pro-
grammers.

When multiple programmers are working on an Eos Family system, partitioned control can be used
to restrict a specific user’s access to certain channels. This can help avoid overlapping control of
channels by multiple programmers at once.

Channels can be included in more than one partition.
Partitions only affect which channels a user has access to.

Using Partitions

When partitions are enabled and a partition is selected, you may only record data for the channels
included in the partition, with the exception of parking and unparking channel parameters or playing
back cues. If you try to control a channel that is not in your partition, you must confirm that you
want to control that channel. You will not, however, be able to store information for that channel.

If you select a range of channels and set them to a level and some of those channels are not included
in the partition, you must confirm the command. After which, the command will be allowed on the
channels not in the partition

When you record a target (cue, preset, palette), only those channels that are partitioned to you are
recorded. Other |orogrammers’ record actions to the same target can add to it (they do not replace
|t).|L|JBIess chaénne s are shared. When shared, the last value provided at the point of the record action
will be stored.

Creating New Partitions

To create a new partition, press:
»» {Partition} [x] [Enter] - where “x" is a number that does not yet exist in the partition list.

This will create a new partition, highlight it in the list, and (if partition is enabled) assign it as your par-
tition.
To assign channels to that partition, enter them in the command line:

» [1][Thru] [9] [6] [Enter]

You can also use [+], [-], and [Group] to further modify the channels in the partition. When
adding/subtracting channels to a partition, if you do not use [+] or [-] before channel numbers, the
numbers will replace the channels in the partition, rather than adding to or subtracting from them.
This overwriting does require a confirmation (if enabled in setup).

When you are finished, you can press {Done} to return to the setup screen.

Partitions on the Cue List

A partition may be assigned to the cue list. If a partition has already been applied to the cue list, any
channels not in the cue list's partition will not be included in cues when they stored or replayed.

Any data for the cue list that already existed before a partition is applied, will be maintained, includ-
in%data for channels not included in the partition. If data existed before the partition was assigned,
in blind, channels that are not in the Partition will display without a channel graphic, any levels will be
in gray, and a small superscript N will display with it.

6 ? : 9 "

Channele: saved in the currentcue
butnotinthe assigned partition.
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Assigned partitions will display in the external links column in the cue list index.
To assign a partition to the cue list:

7 [Cue] [1] [/] {Partition} [n] [Enter]
To remove a partition from the cue list:
7 [Cue] [1] [/] {Partition} [Enter]

Deleting Partitions

To delete any partition, simply type the syntax in the command line:
7+ [Delete] {Partition} [S] [Enter] [Enter] - deletes partition 5 from the list.

Preprogrammed partitions cannot be deleted.

Flexichannel in Partitioned Control

When partitioning is enabled, a new flexi state, “Partitioned” is available as a softkey. When this is
enabled, the flexi state is limited to only those channels defined in the current partition. This view
may be further modified by use of the remaining flexi states.

How to Use Partitions

The primary use of partitioned control is to allow more than one programmer to work on a show file
at the same time without the risk of one user storing data for another user’s partitioned channels.

The most common example of this situation is when one user is programming moving lights while
another user programs conventional fixtures. Partitioned control allows these users to divide the
channels between them so they may work simultaneously. If one user stores data using record or
record only, partition control will guarantee that only data for their partitioned channels will be
storedd. Data for channels not in their partition will be ignored when performing any store com-
mands.

Partition List

To view the partition list display, press the {Partitions} button in Show Settings. This display lists all
existing partitions. There are four pre-programmed partitions in Element, they are:

»» Partition 0 - No channels and no fader control. This is the default for all users when partitioned
control is enabled for the first time on a show. To gain control, you must select a different par-
tition.

»» Partition 1 - All channels. Allows the user access to all channels.

»» Partition 2 - Single Parameter Channels. Allows the user access to only channels with a single
parameter.

»» Partition 3 - Multiple Parameter Channels. Allows the user access to only channels with mul-
tiple parameters.

» Toselect a partition in the list, enter it in the command line.
»» [Partition] [2] [Enter]
¥ If partitioned control is enabled, this will now be your assigned partition.

Setting Up Partitioned Control

Partitioned Control is enabled or disabled in show settings. Partition defaults to “Disabled”. Enabling
or disabling partitioned control is a systemwide setting.

Using Partitioned Control
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Chapter 5

Using Filters

This chapter contains the following topics:

About Fiters . 31
Record FIters . 31
Partial Filters . . . 31
Removing Filters . . . . 32
Storing Data with Record Filters

30



31

About Filters

Filters are used to determine which parameters can be stored to cues, palettes, and presets. The filter
selection tool in the CIA affects record operations as long as the filters are set.

Note: Channel and parameter filters can be applied to faders and submasters. Those type
of filters affect playback and not record functions.

Record Filters

Record filters are used to select specific parameter data to store to record targets. When no filters
are selected, all parameters can be stored, as appropriate to the [Record], [Record Only], and select-
ive record action used.

. Note: When storing show data, applied filters are highlighted and allow the associated
parameters to be stored in record targets.

. Note: When filters are deselected (not highlighted), they prohibit storing the associated
parameters.

. Note: There is no difference between having all filters selected and having no filters selec-
ted (default). In either state, all parameters are available for recording.

. J

Record filters are applied from the CIA using the following buttons: {Filter}, the parameter buttons in
the CIA, and the parameter category buttons.

The parameter category buttons can be used to select filters, as follows:

» Intensity (enables recording intensity data)
»» Focus (enables recording pan and tilt)

#» Color (enables recording color data)

#» Beam (enables recording all beam data)

To apply record filters by category:

1. ]E’lresl,qs {Filter}. The parameter buttons change to display filter selection. The {Filter}softkey will
ash.

2. Press the parameter category softkey {Intensity/Focus/Color/Beam} for the category you want
toinclude in the record target. All parameters in that category will be highlighted and “Filter
On" will appear above the softkey.

3. Press {Filter} again. The buttons return to their normal appearance.

In subsequent record functions, only the filtered categories will be recorded. You may apply multiple
category filters at once. Remember that applying all filters and no filters yields the same effect.

Partial Filters

If you do not want an entire category to be recorded, you may apply parameter specific filters (partial
filters) instead.

To apply partial filters:

1. ]E’lreshs {Filter}. The parameter buttons change to display filter selection. The {Filter}softkey will
ash.

Using Filters
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2. Press the parameter button (for example {Zoom}) for the parameter you want to include in the
rec]:cokrd target. That parameter will be highlighted and “Filter On" will appear above the
softkey.

3. Press {Filter} again. The buttons return to their normal appearance.
In subsequent record functions, only the filtered parameters will be recorded. You may apply as
many partial filters at once, as you wish. Any unfiltered parameters will not be included in record

actions. In live, unfiltered parameter data is displayed in its proper color, but a gray “N” (indicating
null data) will appear in the upper right corner of the parameter’s field.

Removing Filters

Applying filters is a toggle state. To remove any filter, simpl?/ repeat the application process
described above. When pressed again, any applied filter will be removed.

To remove all filters at once:
1. Press {Filter}. The parameter buttons change to display filter selection. {Clear Filters} appears in
the upper left corner of the parameter buttons.
2. Press {Clear Filters}. Any applied filters will be removed and the highlights will turn off.

3. Press {Filter} again. The buttons return to their normal appearance. All parameters are now
available to record functions.

Storing Data with Record Filters

If arecord target is stored with filters in place, the filters allow only associated parameter data to be
recorded in the target. Non-filtered data is not included when you record.

The various record targets are affected by filters in the following ways:
»» Palettes - Palettes by definition are already filtered. The color and beam filters can be used to
further modify what is stored in the color and beam palettes, however.
> Presets - Active filter settings impact what is stored in presets.

»» Cues - Active filter settings impact what is stored in cues, even when using “record only” com-
mands.

»» [Recall From] - Recall from instructions are not affected by the filters.
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Chapter 6

Virtual Media Server

Virtual Media Server

This chapter contains the following topics:

About Virtual Media Server . ... 34
Patching the Virtual Media Serverand Layers ... ... . . ... .. ... 36
CreatingaPixel Map ... . ... .. 36
Working with the Virtual MediaServer ... . . 38
Pixel Mapping inaMulti-Console System _ ... ... ... 45
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About Virtual Media Server

The virtual media server feature of Element is comprised of two areas, the virtual media server and its
virtual layers, and pixel maps. These areas are completely dependent on each other.

The virtual media server is a feature used to create layouts of fixtures, known asfpixel maps, which
then applies media content (images, movies, text, and procedurally generated effects) by way of vir-
tual media layers to the pixel map.

A ?ixel map is a layout of fixtures onto a grid, which determines order of playback and how the data
will be interpreted and outputted to create the desired image or effect. A pixel map creates rela-
tionships among the channels in an X-Y grid so that the channels and their parameters can be asso-
ciated with pixels in an image.

A virtual media layer contains one piece of media content. A pixel map can contain up to 12 virtual
media layers, which can be stacked on top of each other or used separately.

Note: You may need to install the Eos Family Pixel Mapping Installer before using this fea-
ture. Please see the Eos Family Pixel Mapping Installer v1.0. T Release Note for installation
instructions.

Media Content
Images, movies, text, and html files can be applied to a pixel map.

Note: A stock library of media is provided when the Eos Family Pixel Mapping Installer is
installed. Please see the Eos Family Pixel Mapping Installer v1.0.1 Release Note for install-
ation instructions.

Additional media content can be installed. Supported media file formats are:

»» Images - .png, .jpg, .gif, .tiff, and .svg

> Movies - any format that QuickTime® supports.(.3gp .3gpp .3gpp2 .3gp2 .3g2 .3p2 flc
.h264 .hdmov .m4a .m4b .m4p .moo .moov .mov .movie .mp4 .mpg4 .mpg4 .mqv .mv4 .pic
.pict .qif .qt .gti .qtif .tvod .vid)

» Text - .txt
» HTML - .htm, .html

Importing Media Content

There are three ways to import media. Those methods are:

»» Import All Pixel Map Media - An automatic method for importing media.
#» File Manager - A manual method for importing media.

»» Import Show Pixel Map Media - An automatic method of importing all media needed for the
current show file. Used by backup and clients. For more information on synchronizing media
content, see Synchronizing Media Archives (page 47).

File names for media content need to follow the naming convention of file number_filename. For
example, 002_Volcano.mov is a file name that would be recognized. When importing by using the
file manager, you need to number the files prior to importing. However using Import All Pixel Map
Media allows you to specify the library and file numbers, and the console will autonumber the file
names as needed during the import process.

Using Import All Pixel Map Media

To import go to Browser>File>Import> Pixel Map Media>All Pixel Map Media and select the device
with the media on it.
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Import All Media From Fi,

[ Library (1-255) [ File (0-255) |
v ( ) ( ) Start Import
1 0
e-order Libraries [ Re-order Files Overwrite
Cancel
No No N

Options in this display include:

b

b

b

b

b
bl

>

{Library (1-255)} - selects the library to import media.
{File (0-255)} - selects the file number.

{Reorder Libraries} - specify whether or not the library on the source device will be
renumberbed. If the source device’s library is not numbered, it will be assigned the specified lib-
rary number.

{Reorder Files} - specify whether or not the file(s) on the source device will be renumbered. If
the source device's file(s) is not numbered, it will be assigned the specified file number.

{Overwrite} - overwrite the existing media files.

{Start Import} - begins the import process. A progress bar will appear to indicate the status of
the import process. When finished, click {Done}.

{Cancel}- stops the import, and exits the display.

Importing with the File Manager

To import go to ECU> Settings>Maintenance>File Manager.

Note: Make sure your files follow the naming convention of file number_filename. If the
files do not, they will not be recognized as media files. You can always import using Import
All Pixel Map Media instead.

Select the device with the media on it in one window and in the other window select the Medi-
aArchive folder. Inside the MediaArchive folder, you will see numbered folders. Those folders cor-
respond to libraries. You can copy or move files.

Virtual Media Server
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Exporting Media Content
There are two ways to export media. Those methods are:

»» Export Pixel Map Media - An automatic method for exporting media.
#» File Manager - A manual method for exporting media.

Using Export Pixel Map Media

This is an automatic method of exporting all the media used in the current show file. This includes
any pixel map media stored in cues, presets, submasters, etc.

To export, go to Browser>File>Export>Show Pixel Map Media. Select the device you want to export
the media content to.

There are only two options available in this display:

#» {Start Export} - begins the export process. A progress bar will appear to indicate the status of
the import process. When finished, click {Done}.

» {Cancel}- stops the export and exits the display.
Using File Manager

Exporting with the file man_aﬁer is very similar to importing with it. You select the files in the Medi-
aArchive folder that you wish to export, and you can either copy or move them to your device.

Patching the Virtual Media Server and Layers

To get started using this feature, you must first patch a channel as the Virtual Media Server and addi-
tional channels as layers.

You will need to be in the patch by channel display.

In the patch display, enter the channel number that will be your virtual media server. Press {Type}
then {Manufctr} to display the fixture library. Select {ETC}, {Virtual}, and then {Server_Ver_1.0}.

Enter the channel numbers that will be your virtual media layers. Press {Type} then {Manufctr} to dis-
play the fixture library. Select {ETC}, {Virtual}, and then {Layer_Ver_1.0}.

For information about {Virtual Effect Layer}, see Using Two Color Gradients (page 44).

[ [ [ [ [ Effect [ [
Ehrgeiz Elements Ehrgeiz Elements Layer Ver
1.0
el
Elation Eliminator Elation Eliminator Layer Ver
— 1.1
Elation ’ Elation ’ Layer Ver
Arch Elite Elite 1.0
S
Elektralite | Elumen8 Elektralite | Elumen8 ervleEl ar
Element ErC Sgnsor Element
Labs Dimmer

p Note: No addresses need to be assigned in patch for the virtual media server and layers. ]

Creating a Pixel Map

A pixel map is a layout of fixtures onto a grid, which determines order of playback and how the
media content will be interpreted and outputted to create the desired image or effect.
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A pixel map creates relationships among the fixtures in an X-Y grid so that the channels and their
parameters can be associated with pixels in an image.

Limitations of pixel maps include:
¥ 40 pixel maps per show file

» 12 layers per pixel map
» 256,000 pixels per pixel map grid

Open up the Pixel Map display, Displays>More SK>Pixel Maps. The display can also be opened from
the home screen, or by using ['I'ab]p[Qi's

Note: Hovering your cursor above the pixel map will display the column and row location
for the pixel.

BLIND xel map* / X\ [© 2:53:14 PM

397
398
399
00
01

02
Width Height z Cha Pixels

400

| o pixel Map |

In the Pixel Map display, any numeric entry is assumed to be a Pixel Map. Each pixel map must have a
unique number.

To create a pixel map, type in the number you want to assign to it and hit [Enter].

The virtual media server and layer(s) need to be assigned to the pixel map. Using the softkeys, select
{Server Channel} and the channel you patched as the Virtual Media Server.

Then select {Layer Channels} and the channels you patched as Virtual Media Layers.

In Ejhﬁ dishplay you can also label the pixel map, assign the interfaces it will use, and adjust the width
and height.

Column and row guides can be created numerically in either the Pixel Map or in the Edit displays. The

guides can aid in viewing a pixel map.

¥Vhen that basic information has been assigned to the pixel map, press the {Edit} softkey to select the
IxXtures.

In the edit screen, you will be able to define the array and types of fixtures. To do this, you can select
pixels from the map by using a touchscreen or by holding down the left button on a mouse and drag-
ging across the pixels you wish to select.

Once the pixels have been selected, you need to select their fixture type and then assign the starting
address or starting channel.
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»» When either {Starting Channel} or {Starting Address} is selected, both fields will be cleared.

»  Address-based pixels can not overlap with channel-based pixels. This includes the entire DMX
fixture footprint.

»» If using {Starting Channel}, any overlapping channel-based pixels will be removed and any
overlapping address-based fixtures will be unpatched.

»» If using {Starting Address}, any overlapping address-based pixels will be removed and any over-
lapping channel-based fixtures will be unpatched.

#» When the [Data] key is latched, the address for channel-based pixels will display.
»» When [Format] is pressed, the address will toggle between port/offset and address number.
By default, the addresses will be organized in rows starting from the left to the right and top to bot-

tom. The edit screen shows a rearesentation of the current mapping. The pixels are color coded
based on if they have been patched or not. A color coding guide is provided on the screen.

. Note: Any pixel can have its size adjusted for better representation of the actual fixtures.
This is done by selecting the pixel and then dragging the vertical and/or horizontal borders.

(. J

. Note: A pixel map can be moved within the edit display by holding down the right mouse
button. The map can be zoomed either by using a mouse wheel or by holding down
[Format] and moving the level wheel.

A /

Options available for changing the mapping:

»» {Horizontal Order} - toggle state from left to right to right to left

»» {Vertical Order} - toggle state from top to bottom to bottom to top

»» {Direction} - toggle state from rows to columns

#» Click the {Apply} button to see the changes made while still in the edit display.

In the edit display, the softkeys will repaint to the following mapping options:

Note: To see the changes made by using the softkey mapping options, you don't need to
press {Apply}.

b

* {Rotate 90}
» {Flip V}
» {Flip H}
* {Invert}

The {Flash} button can be used to check the address output while still in the edit display. {Flash}
works the same as it does in Live.

When editing is finished, press the {Done} softkey to exit the edit display.

Working with the Virtual Media Server

Before you begin working with the Virtual Media Server, you will want to open the Pixel Map Preview
display from the home screen or by using [Tab] [1][0].

For manipulating the pixel maps, you can use the ML Controls, which can be opened from the home
screen, by using [Tabf[S], or by using the quick access tools.

gt

P Note: For any output, the Server Channel must be set to a level along with any layers you
are using.
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Note: You can use Park and Address Check for Virtual Media Server outputs. ]

Server Channel Controls
When working with the Server Channel, the following controls will be available:

bl
b
b
>
b

bl
b
b

{Intensity}

{Pan} and {Tilt} - used to adjust layers within the frame.
{Color} - filters color for all layers.

{FoView} - field of view, or perspective.

{Crossfade} - used to adjust the priority when devices in the pixel map are also used as desk
channels. -100 gives the pixel map priority, and +100 give the desk channel pri- .
ority. At O (the default) the output is calculated HTP for intensity and LTP for NPs.

The Virtual Media Server crossfade parameter level will display in subscript beside
the intensity.

{Scale} - adjusts Scale of all layers.
{Aspect Ratio} - adjusts aspect ratio of all layers.
{XYZ Rotation Controls} - rotation control for all layers

Layer Channel Controls
When working with the Layer Channels, the following controls will be available:

>

b

b

b

b

{Intensity}
{Pan} and {Tilt} - used to adjust the image of the individual layer within the frame.

{Color}- filters the color of the content. For example, if all the colors are set to full, the content
will play all colors normally. However if blue is at 0, then only the red and green pixels of the
content will play. The color and gel pickers can be used to select color filtering quickly.

{Negative On/Off} - with negative on, the output is the negative of the content. With it off,
the content plays back normally.

{iImage Brightness} - this varies from intensity. The following images illustrates the differences
between image brightness and intensity.

®

Note: All Virtual Media Layers operate in 16-bit color mode. ]

b

Virtual Media Server

0% Brightness, Full Intensity 50% Brightness, Full Intensity

{Playback Mode 1}:

»» {Display Centered}
7> {Display In Frame}
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{Display Out Frame}
{Play Loop Forward}
{Play Loop Reverse}
{Play Once Forward}
{Play Once Reverse}

{Stop}

{Playback Speed}

{In Point} - determines where in the clip (frame number) you want to enter in.
{Out Point} - determines where in the clip (frame number) you want to exit.
{Mix Modes} - sets how the layers will interact. The following table shows the various mixer

modes available. To illustrate the modes, the following layers were used:

Top Layer

Bottom
Layer

Mode

Description |Resu|t

{Over} (Default)

Top layer blended with bot-
tom layer

{in}

Top layer with opacity
reduced by opacity of bot-
tom layer

=

{Out}

Top layer with opacity
reduced by inverse opacity |We=g
of bottom layer

40
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Mode

Description

{Atop}

Top layer with opacity
reduced by opacity of bot-
tom layer and then blended
with bottom layer

{Add}

Top and bottom layers
color and opacity added
together

{Subtract}

Top and bottom layers
color and opacity sub-
tracted from each other

{Muttiply}

Top and bottom layers
color and opacity multiplied
together

{Screen}

Top and bottom layers col-
orsinverted and then mul-
tiplied together

Virtual Media Server
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Mode

Description

{Overlay}

Does a multiply or screen
effect based on the light-
ness or darkness of the bot-
tom layer

{Lighten}

Top layer’s color merges
with bottom layer’s color,
with thelighter color win-
ning

{Darken}

Top layer’s color merges
with the bottom layer’s
color, with the darker color
winning

{Dodge}

Bottom layer’s color
brightened to reflect top
layer's color

{Burn}

Bottom layer's color -
darkened to reflect the top | W= 2
layer's color
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Mode Description

Does a multiply or screen
{Hard Light} effect on the lightness or
darkness of the top layer

Darkens or lightens colors

{Soft Light} depending on the top layer

Top layer with opacity
reduced by inverse opacity
of bottom layer, and then
{Xor} blended with the bottom
layer with opacity reduced
by the inverse opacity of
thetop layer

»» {Library} - selects the image library.
»» {File} - selects the media file within the selected library.

#» {Mask On/Off} - masks takes a lower layer and a higher layer, finds only the non-transparent
pixels they have in common, and then displays the common pixels of the higher layer.

»» {FoView} - perspective

»» {Scale}- changes the scale of the content to either be larger or smaller than the standard con-
tent playback.

»» {Aspect Ratio} - stretches or shrinks the content only along the X axis, making it wide or
squished looking. Z Rotate can be used to modify the aspect ratio along the Y axis.

7> {XYZ Rotation Controls}

Effect Layers

The Virtual Media Server allows you to use procedurally generated content. This is content that is cre-
ated algorithmically in real time, instead of rendering file based media.

In order to use rogedurallydgenerated content, you must patch the pixel map layer as a virtual effect
layer instead of a virtual media layer. Settln? up the pixel map is the same as for using virtual media
layers. There are two versions of the effect layer, {Effect Layer Ver 1.0} and {Effect Layer Ver 1.1}.

Virtual Media Server
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Types of Effects

There are three main effect types:

» TV\fo color gradients - adjustable gradients with start and end
colors

»» Rainbow gradients - fixed gradient, full hue spectrum
» Perlin noise - good for animating random color effects,
adjustable gradients

The effects are stored in file 1. File 1:0 is ahome positionofno
effect. 1-3 are Eerlln noise effects, 4 is a perlin noise/rainbow gradi-
ent, 5-9 are rainbow gradients, and 10-19 are two color gradients.

Effects have various options of additional control.

Using Two Color Gradients

For the effects that use two color gradients (two color and perlin noise), there are several options for
;or;tzjol of the gradients. The two colors are known as the start and end colors. Those options
include:

» {Intensity} and {Intensity 2} - specifies the opacity of the start and end colors respectively for
Virtual Effect Layer 1.0. If you want to fade a two color effect using this layer, you will need to
fade both {Intensity} and {Intensity 2}.

» {Intensity 2} and {Intensity 3}- specifies the opacity of the start and end colors respectively.
{Intensity} is a master opacity control for the entire layer. This is for Virtual Effect Layer 1.1. If
you want to fade a two color effect using this layer, you can just fade the {Intensity}.

> {Red}, {Green}, {Blue} or {Hue} and {Saturation} - specifies the start color. You can also use the
Start Color picker.

7> {Red 2}, {Blue 2}, and {Green 2} - specifies the end color. You can also use the End Color picker.

»* {In Point 1} and {Out Point 1} - changes the distribution of the two colors in the gradient. In
Point 1 moves the start color position closer to the end color. Out Point 1 moves the end color
position closer to the start color.

»» {Playback Mode 1} - basic animation, forward or reverse.

»» {Playback Speed 1} - speed of animation.

» {Layer Effect} - adjusts the number of repeats in the gradient. La?;er Effect has arange of -
100% to 100%. At the home value of 0%, one full gradient is shown. Moving toward 0%,

you will see less of the gradient and moving toward 100%, you will see up to four repetitions
of the gradient.

p Note: The button {Layer Effect 2} is for use with perlin noise effects. ]

Using Rainbow Gradients

For Rainbow Gradients, the colors cannot be adjusted. But the number of repeats can be adjusted by
using {Layer Effect}. {Playback Mode 1} and {Playback Speed 1} work in the same way as for two color
gradients.

Using Perlin Noise

For perlin noise effects, there are different options for control:

»» {Playback Mode 1} - basic animation of noise, forward or reverse.
»» {Playback Speed 1} - speed of animation.
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» {Layer Effect} - adjusts the amount of noise. -100% equals very little noise, and 100% equals
alot of noise.

» {Layer Effect 2} - adjusts the horizontal scrolling speed. -100% equals a fast left scroll, 0%
equals no scrolling, and 100% equals a fast right scroll.

Effects Color Pickers

The effect layers have a two color pickers for selecting the start and end colors.

Color Start Color End Color

Yhou can copy or swap a color between the two color pickers using the buttons located between
them.

Copies Start Color to End Color
Swaps Start Celor and End Color

Copies End Color to Start Color

Pixel Mapping in a Multi-Console System

When using file based media in a multi-console environment, the primary console should be used as
the ‘base’ media archive.

Media can be imported to the primary, and the backup console and/or any other clients can then syn-
chronize their own, local media archives with the primary. The backup must synchronize media with
the primary in the event that the backup must take control as the master. For clients, synchronizin
the media is optional but useful if you wish to see the media playing back in the Pixel Map Preview dis-

play.

Steps for Configuring a Multi-Console System

Once the Eos Family Pixel Mapping Installer has been installed on all consoles, follow these steps to
configure your multi-console system:

Setting up the Primary

On the primary console, exit to the Eos Configuration Utility (ECU).
Press the {Settings} button.
Press {General} if needed.

Make sure that the {Share Media Archive} box is checked. This will allow for sharing of the
primary’s media archive. Copy the path name, you will need it to setup the backup and/or cli-
ent.

N =
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10.
11.

12.

13.

14.

15.

—
Show Archive Path | D:\ShowArchive\ || Restore Default

: "W\ TechCommGio\
sername=GIO (leave P; rord blank)

Latitude |0 o ~ ' |South =
Longitude |0 = v ' 'West

Calibrate Elo External Touch Screen

Setting up the Backup and Clients

On the backup or client, exit to the Eos Configuration Utility (ECU).
Press the {Settings} button.

Press {Maintenance}.

Press {Network Drives}.

Network Drives

Done

In the Network Drives display, click the {Add} button.
In the Add Network Drive display, choose a drive letter for {Local Drive}.

Add Network Drive

Local Drive zZ:

Network Path |:|

Network Path Type Ton

Cancel

Enter in the {Network Path}. The path name is listed next to the primary’s {Share Media
Archive} checkbox.

Select the appropriate console type for the {Network Path Type}.

Add Network Drive

Local Drive

Netwaork Path WOEM-1Ti MediaArchive

Network Path Type
ok Cancel

Click {Ok}. You will now be able to access the r_)rimary’s media archive from the backup or cli-
i

ent. This new drive will appear in the browser like a USB drive.

Click {Done} and launch the Eos application.
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Synchronizing Media Archives

To view media playback in the Pixel Map Preview display, you will need to first import the required
media into your backup and/or client’s local media archive. This is done from the browser. There are
two options for importing media:

# Import Show Pixel Map Media - This import function should be used by the backups and cli-
ents. Itis the easiest way to ensure that your console will have all of the media required by the
current show file.

»» Import All Pixel Map Media - This import function should be used by the primary to load the
base media content and later to load media on the fly as required. This import function
provides more complex options, like targeting which Library and File the media data will be
Imported into. See Importing Media Content (page 34).

Steps for Synchronizing Show Pixel Map Media

Virtual Media Server
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On the backup or client, navigate to the browser.
Expand File>Import>Import Pixel Map Media>Import Show Pixel Map Media.

N

> Show Pixel Map Media

v All Pixel Map Media

>[7] Max Touch (F:\)
>[7) TECHCOMMGS (E:\)

> Gobo Images

W

Select the appropriate network drive.
The Import Show Media display will open. Press the {Start Import} button.

5. A progress bar will appear to indicate the status of the import process. When finished, click
{Done}. You will now be able to see the media playing in the Pixel Map Preview display on the
backup and/or clients.

o
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ETC Supplement

Eos Family v2.6.0 Supplement to Manual

The following information is new for version 2.6.0. For more information about the topics covered in this sup-
plement, please see the Eos Titanium, Eos, and Gio v2.0 Operations Manual, lon v2.0 Operations Manual,
and Elementv2.1 User Manual, and should be used in conjunction with it.

Note: Many functions and controls available on other Eos Family consoles were added to Element
with version 2.6. Please see the Element v2.6.0 Supplement for additional information on those func-
tions and controls.

Managing Show Files

Changes in this section impact the Managing Show Files chapter.

Partition and Fader Configuration Tiles

Partitions and Fader Configuration have both been added as component options in the partial show loading,
merge, print, and clear target areas.

Exporting Logs

The ability to save log files has been added to Display>File>Export. Select the location for the export, the
Show File Archive, a File Server (if connected), or to a USB device, and press [Select].

An exporting logs message will appear while the log files are being created.

'Brow.ser: File Export... Logs \TECHCOMMGS (E:\) \_Log Files

¥ Logs
v TECHCOMMGS (E:\)
> 260
v _Log Files

Exporting logs {one moment)...

Importing CSV Files
The ability to import CSV files has been added to Displays>File>Import.

Toimporta CSV file, navigate within the Browser to: File> Import> CSV>(Name of File to Import) and press
[Select]. You will be asked to confirm the import.

Note: Not all data is saved to a CSV file. It is recommended that you first export as a CSV file,
modify the file as needed, and then import.

Print Includes Scenes and Cue Notes
When printing to a PDF file, scenes and cue notes are now included with cues.

Changes to About
This section discusses the changes to About.

SACN Information in About Address
The [About] Address display now has rows for SACN source, address, and level.

caliig Corporate Headquarters = Middleton, WI, USA m Tel +608 831 4116 m Service: (Americas) service@etcconnect.com

ce .c. London, UK = Tel +44 (0)20 8896 1000 m Service: (UK) service@etceurope.com

Ceee m— Rome, IT = Tel +39 (06) 32 111 683 m Service: (UK) service@etceurope.com

0000 = TC Holzkirchen, DE = Tel +49 (80 24) 47 00-0 m Service: (DE) techserv-hoki@etcconnect.com

tely — ® Hong Kong = Tel +852 2799 1220 m Service: (Asia) service@etcasia.com

ves -ov : Web: www.etcconnect.com m © 2017 ETC. All Rights Reserved. = Product information and specifications subject to change.
o 4250M1211-2.6.0 m Rev A m Released 2017-07 m ETC intends this document to be provided in its entirety.
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[1/100, 1/101]

Go To
Patch

Value Library Data

0
Lamp
Controls

MNext / Last
Unpatched | |

Column Added to About IFCB Palettes

In [About] IFCB Palettes, a new column, Stored in Presets, has been added to {Usage}. This column displays
the presets that the selected palette are stored in.

Changes to Displays

The section discusses the changes to Displays.

Quick Access
Quick Access tools are available at the top of each display.

| X\ ©1]11:56:28 AM

There are three icons:

» Wand - popup magic sheet
»* Moving Light Beams - popup moving light controls
»* Camera -popup snapshots

Popup Magic Sheet

This option allows you to view a favorite magic sheet in a small popup window over your current display. The
popup Mmagic sheet functions just like a traditional magic sheet and is interactive.

Press the wand icon to close the display when opened.

A popup magic sheet can be assigned in Setup>Show Settings>Popup Magic Sheet. If a magic sheet has
not been assigned in Setup, when you first click the popup magic sheet icon, you will be able to select a
default magic sheet from a list of the available ones.

In Setup>Show Settings>Popup Nav Lock, you can enable or disable the zoom and scroll navigation for
popup Mmagic sheets. This option is enabled by default.
Popup ML Controls

This option allows you quick access to the ML controls display in a small popup window over your current dis-
play.
Press the moving light beams icon to close the display when opened.

Popup Snapshots

This option displays assigned snapshots in a small popup window for quick access. Select a snapshot to recall it.

Snapshots can be assigned to display here by clicking Favorite when you record the snapshot or by going to the
Snapshot List. See Snapshots on page 6 for more information.

Press the camera icon to close the display when opened.
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About + Display Toggles

While in live/blind, you can use the [About] key to view additional information.

When in an [About] mode, the mode type will display in the upper left hand corner of the live/blind display.
The following is a list of the [About] modes available in the live/blind displays:

D Note: Double press [About] + [key] to latch the mode. ]

D Note: To display non-manual data, press [Data] twice now. ]

*» [About] + [Live] - displays the DMX values.

*+ [About] + [Address] - displays the addresses.

*» [About] + [Data] - displays non-manual levels.

** [About] + [Park] - displays the parked levels.

»» [About] + [Part] - displays the cue part number for each parameter.

*» [About] + [Cue] - displays the source target type and number. For cues, the cue list and cue number
that contained the last move will display.

*» [About] + [Mark] - displays the mark cue used by the channels.

*+ [About] + [Next]/[Last] - displays the next cue that the channels move in or the last cue that the chan-
nels moved in.

»» [About] + [Label] - displays the reference labels. [Shift] + [Label] adds a note to a currently selected
cue.

»» [About] + [Time] - displays the discrete time.
*» [About] + [Path]/{Color Path} - displays the color paths.

D Note: To page while in these modes, release the second button while keeping [About] held down. ]

Scenes on Custom Direct Selects

Scenes can be assigned to custom direct selects. To assign a scene to a direct select, you can either tap on a dir-
ect select to open the configuration window, or you can use the command line.

Target Type: Scenes

Scenes:

Cancel

From the configuration window, you can select the target type of scene, and the scene number. Only one
scene can be assigned at a time.

From the command line, you can select a scene, such as [Cue] [1] {Attributes} {Scene} [1] [Enter]. Then
double click on a direct select to assign the selection.

Reset Columns
A new option has been added to the tab tools menu.

?* Reset Columns - resets all of the column widths in the selected tab to Eos defaults. This option will only
be available for displays with columns.
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Collapsing the Parameter Display

The parameter display can be collapsed when working with some displays that use the CIA, such as About and
Query. A collapse/ expand arrow will display in the last column where this option is available.

When collapsed, only the {All NPs}, {All Speed}, and {Expand Arrow} buttons will be displayed.

alsl

Frame b 2

AllNPs A A A

Shutter Gobo Wheel
All Speed scroller Strobe Mode AlINPs

A Yellow Zoom

Gobo Select Frame a 2 All Speed

Position
IntensMo MEpeed Magenta Edge Gobo Mode || Frameb4

Intensity
Wspeed it Tndigo Gobo Ind/Spd || Frame a4

Intens cyan

Intensity Color Shutter address Intensity Focus

Playback Status Display Configuration Menu

An option for displaying scenes has been added to the configuration menu. When enabled, the scene green
bar will display above the cue that the scene is associated with in the PSD. By default, this option is enabled.

~ | Reorder Columns

: A
+/ Intensity
#| Focus v
' Color
#/ Beam
+#) Dur (Duration)

~ |« Flags
« M (Mark)

Target Gid | Top
Lock Status Unlocked

) Display Cue Parts

| Display Cue Links

o) Display Scenes

) Display PSD Time Countdown

| Display Master Playback Status

) Display Fader Ribbon
Display Notes

) Display Command Line
Break Link to Live/Bind

Set Current as

) B (Block)

# A (Asserted )
#! P (Preheat)

) AfF (Allfade)
#| MV (Moves)
) R (Release)

Reset to Default o ¥
#/ Attributes

! Fw/Hg (Follow/Hang)
#/ Link
| Loop
' Curve
#/ Rate
| Label
Notes
) Effects
) Bxt Links

Reset to Eos

. Default

& LockFrame

Q Zoom Out @ Zoom In

\ 2pspuist1juist 2 | +

Blind Spreadsheet Label Column
A label column has been added to the blind spreadsheet display. This column displays cue labels.

Monitor Mapping

A new monitor mapping option has been added to the Display Controls Screen.
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7/ XU @ 9:06:58 PM

mn=m=EE=
HEDBEH

Select this icon to arrange your monitors without having to go into the ECU. This function gives you better con-
trol of your snapshots.

Monitor Mapping

Since lon and Element are limited to two monitors, the monitor mapping display is slightly different.

Monitor Mapping

Click on a monitor to display the available numbers, and then click on the number to assign it.

D Note: On-board touchscreens are locked, and their arrangement cannot be changed. ]

D Note: A left to right arrangement is recommended. ]

Alphanumeric Keyboard Change

When the virtual alphanumeric keyboard displays, you can change the language of the keyboard by using the
flag drop-down menu.
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Cue 1 Label

™= Gunrapckv - Brnrapua
Esc . = catala - Espanya
. EIJBEEPTL." -
SRR T AL

Tab r i ™ Cedtina - Ceska’rrepublika

4= dansk - Danmark
Caps i == Deutsch - Deutschland
=8 American English - United States
Shift = espanol de Espana - Espana

Sym

Storing and Using Submasters

Changes in this section impact the Storing and Using Submasters chapter.

New Submaster Options
The following are new button options for submasters:

»» Mark NPs - If no non-intensity parameters are owned by the submaster, it will fade the parameters on
any dark channels in bump up time. If any non-intensity parameters are owned by the submaster, it
releases the non-intensity parameters in bump down time. Dwell time and mode are ignored. A sub-
master must be mapped before this option will be available.

»» Start Stop Effect - starts the effect while ignoring dwell times. Will stop effects if any are running. (In
previous software versions, there was only a {Stop Effect} option.)

»* Macro - allows you to assign a macro as a button action.
The following are new submaster fader options:

7 Effect Master - masters the entry/exit mode of the effects (size, rate or both).
7+ Levels Only - masters the channel levels without mastering the effect.

The following is a new submaster property:

7 {FX Off 0} - starts the effect when master fader is moved from 0, stops the effect when it is moved to O.
This is enabled by default.

Storing and Using Snapshots

Changes in this section impact the Storing and Using Snapshots chapter.

Snapshots

In version 2.6, you have greater control over what s all included in a snapshot. When recording a snapshot,
you will see a preview of all of the displays as they will be recorded in the snapshot. You can choose to
select/deselect various components, monitors, frames, etc from your snapshot.
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(@ visile Workspaces O Alworkspaces

Faders Encoders

Filters o Direct Selects

o* Favorite o CustomDS

Color: Dark

Monitor 2 Ames. Monitor 1 ames Monitor 3 ames. Monitor 4

From the snapshot menu, the following options are available:

*» Visible Workspaces - includes only the visible workspaces.
»»  All Workspaces - include all workspaces, including those not visible at the time of recording.

»» Faders - captures the current state of the faders including: fader page mapping, position of all sub-
masters, and pending cues based on configuration.

»» Encoders - records the current page of the encoders.
*» Filters - records the current setting of the record filters.

*+ Direct Selects - when used without visible workspaces selected, this option will recall all direct select
tabs and their settings.

»» Favorite - the snapshot will display in the quick access window. See Quick Access on page 2 for more
information.

» Custom DS - a snapshot will recall the targets that each of the custom direct select buttons are mapped
to, unless the snapshot does not have custom direct select button mapping.

*» Color - assign colors ({Red}, {Green}, or {White}) or {Dark} to a snapshot. {Dark} assigns no color to the
snapshot. The colors will display beside the snapshots name in a direct select, and/or if that snapshot
has been assigned to one of the customizable hardkeys on Eos Ti, Gio, Gio @ 5, and RPU.

7 Reset - sets the menu back to its defaults.

You can choose to include or exclude monitors, frames, and tabs in the area below the snapshot menu by
checking or unchecking in the list.

When a frame or tab has been excluded, an - icon will display to indicate that not everything on that monitor
will be saved. A checkmark icon will display when everything on the monitor will be saved.
> = al

¥ = Monitor 1
¥ |= Frame 1

¥ » Monitor 2
¥ I Frame 1

Monitors and frames can also be selected or deselected in the preview area. Use the {Frames/Monitors} but-
ton to select whether you will see monitor or frame numbers in the preview area.
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When a monitor or frame has been deselected, it will be greyed out. Deselected frames will also have a small
red circle with a slash on them.

See Monitor Mapping on page 4 for information about arranging your monitors for better control when cre-
ating snapshots.

Manual Control

Changes in this section impact the Basic Manual Control or the Advanced Manual Control chapter.

Copy To From Absolute
The ability to use [Copy To] with {From Absolute} was added in version 2.6.

? [1][Copy To] [2] {From Absolute} [Enter] - sets channel 2 to channel 1's absolute level.

Priority Mark

When setting mark cues, you assign a priority marking using the softkeys {High Priority} and {Low Priority} .

When marking, channels will attempt to mark to high priority cues first. Cues that are flagged with just Mark
are considered normal priority. Channels will attempt to mark to them second if a high priority cue can not be
used. Low Priority cues will be used last if a high or normal priority cue could not be used.

The following indicators are used in the Mark flag area:
» mh -indicates that a cue has been flagged as high priority mark, but nothing is marking to it yet.
» MH - cue has been flagged as high priority, and lights are marking to it.
»» ml-indicates that a cue has been flagged as low priority mark, but nothing is marking to it yet.
» ML - cue has been flagged as high priority, and lights are marking to it.

Target Numbering Up to Three Decimal Places
Record targets can now be stored with numbers that use up to three decimal places.
** Whole numbered target
» Tenths (.1) numbered target
#* Hundredths (.01) numbered target
»* Thousandths (.001) numbered target
Those record targets include:
# Cues
#* Presets
» Palettes
7 @Qroups
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Fader Configuration

Changes in this section impact Fader Configuration.

Manual Time Master
A new target type has been added to fader configuration. A fader can be mapped as a manual time master.

D Note: Manual Time Master applies to changes made manually, not to playback. ]

Cue List

Sub

Focus Palette

Color Palette

Beam Palette

Preset

Grandmaster

Man Time

unmapped

A manual time master can be used to impact any manual control timing. For a manual time master, you need
to assign a minimum and maximum time settings to the fader. By default, the minimum is set to 0 seconds
when the fader is completely down, and maximum is 5 seconds when the fader is at full. To change the timing,
click on the box and enter the time from the popup number pad.

Master(0,5)
Master

Fader Disabled

Enter

The fader buttons can be assigned as bump, disabled, or macro. It is recommended that the bottom button be
set to bump for turning the fader on/off. When turned on, the LED will be solid green.

Note: The setting of the manual time master is ignore unless turned on. Changing the manual tim-
ing master will not impact any manual changes already in motion.

The fader ribbon will display the label of M Time to indicate a manual time master fader.

D Note: Channel and parameter filters can be assigned to a manual time master.
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You can override a manual time master by using a command line entered sneak time.

Copying Faders Using Attributes Only

When copying faders, you can use {Attrs Only} to copy over all of the fader properties except levels, effects,
and labels.

7+ [Fader] [1] [Copy To] [Fader] [4] {Attrs Only} [Enter] [Enter] - copies all of the fader properties from
fader 1 and places it in fader 4. Levels, effects, and labels are not copied when using the {Attrs Only}
softkey.

Additional Topics

Outputs

ETC has changed our policy for output upgrades. Rather than incremental 1K, 2K, or 4K upgrades above base
output, we will offer two levels only. The base console and an unlocked version.

Minimum/maximum capacity is now as follows:

7+ Eos Ti (with Display port) - 4K base, 24K unlocked
»* Eos Ti (with DVI) - 4K base, 16K unlocked

» Gio (with Display port) - 4K base, 24K unlocked
»»  Gio (with DVI) - 4K base, 12K unlocked

 Gio @5 - 4K base, 24K unlocked

** Eos RPU3 (with Display port) — 4k base, 24K unlocked
** Eos RPU3 (with DVI) — 4k base, 12K unlocked

» lon (Win 7) - 1K base, 6K unlocked

** lon (XP) — 1K base, 3K unlocked

** lon RPU (Win 7) - 2K base, 6K unlocked

?* lon RPU (XP) — 2K base, 3K unlocked

»* ETCnomad — 512 base, 6K unlocked

»» ETCnomad Puck (4 USB) - 512 base, 6K unlocked
#* ETCnomad Puck (3 USB) — 512 base, 2K unlocked

For any devices in the field, when you install version 2.6 software, you will see the following:

?» If you have an ETCnomad 256 or ETCnomad Puck 256, you will now have 512 output.
» If you have an ETCnomad 1024 or higher, you will now have 6,144 output.

?» If you have an ETCnomad Puck (4 USB) 1024 or higher, you will now have 6,144 output.
7+ If you have an ETCnomad Puck (3 USB) 1024 or higher, you will now have 2048 output.
»* If you have a Win 7 lon 1536 or higher, you will now have 6,144 output.

7 If you have a Win XP lon 1536 or higher, you will now have 3,072 output.

?* If you have a Gio or Gio @ 5 2K or 3K - you will now have 4,096 output.

» If you have a Gio @5 5K or higher, you will now have 24,576 output.

7 If you have a Gio (Display port) 5K or higher, you will now have 24,576 output.

»* If you have a Gio (DVI) 5K or higher, you will now have 12,228 output.

»» If you have an Eos Ti (Display port) 5K or higher, you will now have 24,576 output.

# If you have an Eos Ti (DVI) 5K or higher, you will now have 12,228 output.

D Note: If you downgrade from version 2.6 to an earlier release, your previous output will be restored. ]
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These output counts will be maintained from version 2.6 through the life of the product.

Patch Fixture Search

A virtual keyboard icon has been added to the Fixture Search display in Patch. Click the icon to open the virtual
alphanumeric keyboard.

» ETC Arch
» ETC Dimming

SACN Universes

Any sACN universes within the 1-63,999 standard range can now be used. 256 universes total can be used.
The address range equals 1 to 32,767,488, which is 63,999 times 512.

This is set in ECU>Settings>Network>Output Protocols>Allowed Output Addresses.

MIDI Over USB

Version 2.6 adds support for third party MIDI over USB devices. In the ECU, you will need to enable their use in
Settings>Local I/0>USB MIDI.

Facepanel Shortcuts

Overview

The following is a list of button pushes: single, maintained, or combined. It is highly recommended that you
read and familiarize yourself with this list.

Displays
*» [Data] (maintained press) - toggles the display to show data living under referenced data. Keep [Data]
depressed to page.
*+ [Data] + [Data] - locks the display to the absolute data display.
*» [Time] (maintained press) - toggles the display to show discrete timing. Keep [Time] depressed to page.
** [About] + [Time] - locks the display to discrete time display.

»» [Data] + [Focus Encoder Page] / [Color Encoder Page] etc - to expand/suppress categories on dis-
plays (lon)

»+ [Data] + [Parameter Tiles] - to suppress/display individual parameters from the display when not in sum-
mary view (lon)

*» [Params] + [Focus] / [Color] / [Beam] - to expand/suppress categories on displays (Ti/Eos/ Gio)

*» [Params] + Parameter Tiles - to suppress/display individual parameters from the display when notin
summary view (Ti/Eos/Gio)

*» [Displays] + [Level Wheel] - dim the Littlelites or backlighting/LCDs (as selected by the user).
»» [Displays] [Displays] - resets the CIA to the browser

*+ [Shift] + [Left], [Shift] + [Right] - move columns

*+ [Shift] + [Up], [Shift] + [Down], [Shift] + [Level Wheel] - resize columns

*» [About] + [Path]/{Path} - toggles the display to show the color paths.

*» [Shift] + [Select] - reset Display Columns
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[Shift] + [Tab] - clear all tabs on the current monitor (but keep locked frames) (Does not clear tab 1 and
2)

[Shift] + [Tab] [Tab] - clear all tabs on all monitors (but keep locked frames) (Does not clear tab 1 and
2)

[Shift] + [Tab] [Tab] [Tab] - clear all tabs on all monitors (including locked frames) (does not clear tab 1
and 2)

[About] + [Label] (maintained press) - toggles the display between default view of referenced data and
alternate view. Keep About depressed to page.

[About] + [Label] [About] + [Label] - double press to lock reference labels on. Press [About] + [Label]
again to unlock.

[Shift] + [Live/Blind] - advances the displays to the next instance of live or blind
[Live] (when already in live) - resyncs the selected cue to the most recently activated cue

[Blind] (when already in blind) - resyncs the selected cue to the live selected cue (when blind cue has
been changed or when preserve blind cue has been enabled).

[Flexi] + [Time] - to invoke flexi time view on displays

[Format] + [Level Wheel] - zooms the display in focus

Left Mouse Button + Scroll - zooms the display in focus on a PC
Scroll with two fingers - zooms the display in focus on a Mac
[Tab] + [Up/Down Arrow] - cycle workspaces

[Tab] + [Left/Right Arrow] - move displays

[Tab] + [number] - open or focus specific displays

[About] + [Live] - displays the DMX values.

[About] + [Address] - displays the addresses.

[About] + [Data] - displays non-manual levels.

[About] + [Park] - displays the parked levels.

[About] + [Part] - displays the cue part number for each parameter.

[About] + [Cue] - displays the source target type and number. For cues, the cue list and cue number
that contained the last move will display.

[About] + [Mark] - displays the mark cue used by the channels.

[About] + [Next]/[Last] - displays the next cue with that the channels move in or the last cue with that
the channels moved in.

[About] + [Path]/{Color Path} - displays the color paths.

Facepanel

bl
b
b
>
b
b
b
b
bl
b

b

[Shift] + [Escape] - to lock and unlock face panel

Encoder Paging Keys + [Number] - pages to the desired encoder control page

[Escape] + Encoder Paging Keys - locks the encoders. Press any encoder page button to unlock.
[Flexi] + Encoder Paging Key - to invoke flexi encoder states

[Fader Controls] + [Bump Button] - select a fader page on wings

[Fader Page] + Rate Wheel - rolls the selected fader page (Ti/Eos/Gio)

[Fader Page] + [number] - select a fader page on integral faders (Ti/Eos/Gio)

[Fader Page] - increments the fader page by (Ti/Eos/Gio)

[Shift] + [Fader Page] - decrements the fader page by 1 (Ti/Eos/Gio)

[Off] + [Load] - releases control of content, restoring to background and leave cue list with pending cue
intact

[Release] + [Load] - releases control of content, restoring to background, and resets cue list to top
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*+ [Shift] + [Go] or [Shift] + [Back] - cuts the pending cue or the previous cue
»» [Shift] + [Load] - to remove content from a fader
Operations
?+ [At] [Enter] - removes move information from selected channel/parameters.
7 [At] [At] - set to Level (as defined in Setup).
** [Color] (Encoder page key) + Encoder Movement - hold Color Point while adjusting parameters

bA]
kA
»

b

»
bA]
b
b
e

kA

b
b
e
b

»
bA]
b
b
e
b
bA]
kA
»
bA]
b
b
e
b
bA]
kA
»

b

[Copy To] [Copy to] - posts Move To on the command line.
[Full] [Full] - sets selected channels intensity to “full” and self terminates

[Label] [Label] - appended to a record target command, clears the current label, this includes show file
labels

[Recall From] [Recall From] - posts Recall From Cue to the command line. If in a target list display, such
as presets, it will post Recall From Current Target, such as Recall From Preset or Recall From Focus
Palette.

[Record] [Record] - posts Record Only to the command line.

[Select Active] [Select Active] - Select Active minus submaster contributions

[Shift] + [Select Active] - posts Select Non-Sub Active

[Select Last] - repeats last command line, unterminated; does a loop of last five commands

[Shift] + [At] - recalls last channel(s) and parameters without terminating; does a loop of last five com-
mands

[Shift] + [Enter] - reselects the last command and leaves it unterminated; does a loop of last five com-
mands

[Shift] + [Block] - posts Intensity Block to the command line
[Shift] + [Clear] - clears the command line
[Shift] + [Delay] - posts follow

[Shift] + Encoder Paging Key - posts the category to the command line. For beam subcategories, press
Image, Form or Shutter twice to post Beam. (lon/Gio)

[Shift] + Encoder Movement - accesses fine mode

[Shift] + Encoder Toggle - posts the parameter to the command line (lon)

[Shift] + Gel Tile - cycles through three modes of Brightness

[Shift] + [Full] or [Shift] + [Out] - flash On or Flash Out

[Shift] + [+] or [Shift] + [-] - same as +% or -%

[Shift] + [Highlight] - appends highlight to the current channel selection.

[Shift] + [Parameter] - from the encoder controls, posts the parameter to the command line.
[Shift] + [Select Last] - posts additional channel selection options to the softkeys

[Shift] + [Sneak] - makes manual data unmanual.

[Shift] + [Update] - shortcut to Save

[Shift] + restore manual channel faders - reset faders to zero without asserting control.
[Shift] + [Direct Select] - posts DS to the command line without terminating.

[Shift] + [Label] - adds a note to a currently selected cue

[Shift] + [Int Palette] - puts Preset on the command line. (Element only)

[Sneak] [Sneak] - releases NPs of selected channels and self terminates

[Timing Disable] + [Go] or + [Back] - cuts the next cue or cuts the last cue

[Thru] [Thru] - [Thru] command accesses only channels displayed in the current flexi-state (unless the
range specified is NOT in the current display). [Thru] [Thru] selects the range regardless of the flexi
mode.

[Trace] [Trace] - forces a previously inactive light to track its new intensity setting backwards
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v
L

[Undo] - clears an unterminated command line. Otherwise opens undo controls
[Update] + [Sub Bump] - to update a specific submaster

* [n1[At] [ /1 [m] [Enter] - sets direct DMX value (m) for channel (n).

» [Shift] + [Delay] [Delay] - posts hang to the command line

e
T
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Fader Configuration

Changes in this section impact Fader Configuration.

Unmap Faders

When deleting a submaster, you can choose to unmap it from the faders by using the {Unmap Faders}
softkey. If the softkey is not used, any faders mapped to that submaster will remain mapped.

?» [Delete] [Sub] [8] {Unmap Faders} [Enter] - submaster 8 is deleted and any faders mapped to sub-
master 8 are unmapped.

Clear Button Added to Channel and Parameter Filters

Clear buttons have been added to the Channel and Parameter Filter areas. Press the red [X] to clear the
channel or parameter filters listed.

Chan Fitter
10

Param Filter

Working with Cue Lists

Changes in this section impact the Cue Playback chapter.

Go To Cue Complete

Double pressing [Go To Cue] will post Go To Cue Complete to the command line. You can then select
the appropriate cue number and level of completion.

Manual Control

Changes in this section impact the Advanced Manual Control chapter.

Change to Copy To and Recall From

Previously when using [Copy To] or [Recall From], the commands for {DMX} and {Make Abs} had to be
used at the end of the command line. While that syntax is still valid, you can also use {DMX} and {Make
Abs} directly after [Copy To] and [Recall From].

** [1] [Copy To] {DMX} [2] [Enter]
** [1] [Recall From] {Make Abs} [2] [Enter]
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System Basics

Changes in this section impact the System Basics chapter.

Labels for Linked Cues

If alinked cue has a label, the label will be displayed in the link cue indicator in the Playback Status Dis-
play.

Direct Selects

The Direct Selects display has been changed for version 2.5. Classic and x25 modes have been combined.
To access the configuration menu, right click or tap on the direct select's tab to see the configuration menu.

A new direct selects type has been added. See Custom Direct Selects on page 2 for more information.

Direct Selects Configuration Menu

# of Banks:
Current Bank:  ALL
Lavout
25 50
Rows: ( ) ) Cols
—— Ty T
Control Button Position: Right

Use Record

‘Y‘ Close Tab | Use Select Select

= Use Flexi Flexi
Lﬂ Replace Tab Yz ! el
. | Use Expand
[l]* close allTabs But This
: | Use Arrows Use Milennial Buttons

Close All Tabs I — Ly

Increment: i =
Lock Frame
Skip Empty Flexi Space |# Use Color Swatch

] Dired Saleds Maximize Button Size

Reset to Default Set Current as Default

Reset to Eos Default

The following options are available:

*» # of Banks - sets the number of direct select banks that will display.
7+ Current Bank - selects whether the menu options will affect all of the direct select banks or just a
selected one.
Layout

7 25, 50, 100, 200 - allows you to select the number of buttons that will display per bank.
** Rows - allows you to select the number of rows in the banks.
#+ Columns - allows you to select the number of columns in the banks.

Control Buttons

#» Control Button Position - allows you to set if the control buttons will display on the left side or the
right side of the banks.

#» Use Record - displays the {Record} button.
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7+ Use Select - displays the {Select} button.

#* Use Flexi - displays the {Flexi} button.

#+ Use Expand - displays the {Expand} button.

7+ Use Arrows - displays the page up and down arrows.

»* Use Millennial Buttons - displays the century and millennial buttons that were used with Classic
mode. These buttons allow you to jump to pages in the hundreds and thousands.

Other

»* Increment - allows you to select if the direct select buttons will display as 1 (whole numbers), .1

(tens), .01 (hundreds).

»» Skip Empty Flexi Space - will display a vertical bar instead of empty space between a range of but-
tons when in Flexi mode.

#+ Use Color Swatch - displays a triangular color swatch in the lower left corner of a color palette dir-
ect select.

** Maximize Button Size - sets the size of the direct select buttons to fill the available space. This is
similar to Fit to Screen in previous versions of software.

7+ Reset to Default - will restore the settings to the default state. If no default state has been set, the
Eos default settings will be used.

7+ Set Current as Default - allows you to set the current settings to be used as a default state.
** Reset to Eos Default - restores the settings to Eos defaults.

Custom Direct Selects

{Custom} has been added as a direct select type. {Custom} allows you to select multiple targets to dis-
play in the same bank of direct selects.

Assigning Targets

After selecting {Custom} as the direct select type, the direct selects will first display as being empty. To
assign a target to a direct select or multiple direct selects, you can either tap on a direct select to open the
configuration window, or you can use the command line.

Target Type: Channels

Start:

End:

Cancel

From the configuration window, you can select the target type, and the starting and ending target numbers,
which allows you to assign a range of targets.

Groups
Intensity Palettes
End: Focus Palettes

Start:

Color Palettes
Beam Palettes
Presets
Macros
Effects
Snapshots

Magic Sheets

From the command line, you can select a range of targets that you want to assign, such as [Presets] [1]
[Thru] [5] [Enter]. Then double click on a direct select to assign the selection.
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Note: Toassign arange of channels to the direct selects, you will need to use the configuration
window. From the command line, you can only assign one channel at a time.

Clearing Direct Selects

You can clear a custom direct select by using the [Escape] key. Hold down the [Escape] key and then
press the direct select that you want to clear. To clear a range of direct selects, hold down the [Escape]
key and press the first direct select in the range until a red X appears on it. With [Escape] still held down,
press the last direct select of the range.

Custom DS Added to Snapshots

A {Custom DS} button has been added to the Snapshots List. When {Custom DS} is enabled, a snapshot
will recall the targets that each of the custom direct select buttons are mapped to, unless the snapshot
does not have custom direct select button mapping.

When {Visible Workspaces} is enabled, {Direct Selects} and {Custom DS} are enabled by default.

Visible
e

All

Workspaces

Faders

Encoders

Fader Configuration

Changes in this section impact Fader Configuration.

Channel and Parameter Filters on Faders
Channel and Parameter Filters can be used to allow only specified data to be played back. These are play-
back filters, and do not impact how data is recorded.
Channel and Parameter Filters can be associated with the following targets for playback:
** Cuelists
#» Submasters

7 Presets
¥ Palettes

Note: For presets and palettes, channel and parameter filters can only be assigned in the fader
configuration display (Tab 36) or in the fader list (Tab 35).

For cue lists and submasters, channel and parameter filters can be set in the following areas:

#* Cue List Index
#»  Submaster List
*» Fader configuration display (Tab 36)
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#+ Faderlist (Tab 35)
#* InLive using the {Properties} softkey

Tap or click on {Chan Filter} to assign channels or groups. Tap or click on {Param Filter} to open a list of
available parameters that you can filter.

P Note: Filters will travel with their assigned cue lists and submasters wherever they are
mapped.

When a filter has been applied, an indicator will display in the fader ribbon. C will display for channel filter,
and F is for parameter filter.

Temporary Fader Mapping

Presets and palettes can be used to create a temporary list of content that can be played back on a fader.

D Note: This list is not recorded. If the fader is unloaded, the list cannot be recalled. ]

To create alist, press the [Load] button of an unmapped fader. You can then select presets or palettes to
add to your list either by the command line or from the direct selects.

7 [Load] {DS 1} {DS 2} {DS 2} [Enter]
#+ {Fader} [1][0] [Preset] [1] [Preset] [2] [Preset [3] [Enter]

Once mapped, the fader will default to Master Only mode. See Master Only on page 4 for more inform-
ation.

The list will use the timing assigned to the fader.

A fader with temporary mapping will have the cue list options for Back From First and Go From Last. These
are Cue List Properties, please see the 2.4.0 Supplement for more information.

The list of targets will display in the Fader Configuration List (Tab 36), in the Fader List (Tab 35), and in the
Fader Ribbon.

Master Only

Master Only has been added as a fader option that can be assigned in the fader configuration display (Tab
36) or in the fader list (Tab 35) for submasters, presets, and palette faders. Submasters can also be con-
figured in the Submaster List (Tab 15).

Master

Effect Rate

Effect Sze

Rate Master

Fader Disabled

Master Only
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Master Only faders are used to set a level for content to fade to. The slider can be used to live adjust levels
when the fader has been activated via the bump button.

Master Only faders default to Full.
To set the fader level from the command line, use [Fader] [n] [At] [level] [Enter].

Note: If content is set to proportional, Master Only fades all content to the setting of the fader
when bumped. If set to I-Master, the fader masters the intensity, but non-intensity goes to the end
state in time when the content is triggered.

Solo
[Solo] has been added as a fader playback button option that can be assigned in the fader configuration dis-
play (Tab 36) or in the fader list (Tab 35).
[Solo] can be associated with the following targets:
#» Cuelists
*» Submasters (only additive and effect submasters)

7 Presets
7 Palettes

Note: Forpresets and palettes, solo can only be assigned in the fader configuration display
(Tab 36) or in the fader list (Tab 35).

When a [Solo] button is held down, it will suppress any intensity output except that provided by the asso-
ciated content.

D Note: Soloisa temporary condition. Solo is removed as soon as the [Solo] button is released.

D Note: Shielded and Parked outputs are not affected by [Solo].

Exclusions

Exclusions can be applied to faders via the Fader Configuration (Tab 36), the Cue List Index, or the Sub-
master List.
Those exclusions include:

#» Exclude From Record - output is not recorded into any other record target.

*» Exclude From Grandmaster - content cannot be mastered by a grandmaster.

#+ Exclude From Inhibitive Sub - content cannot be mastered by an inhibitive submaster

» Exclude From Solo - content will ignore solo. See Solo on page 5 for more information.

Setup
Changes in this section impact the Setup chapter.

Show Reference Labels

{Show Reference Labels} has retumed to Setup > Desk Settings > Displays. \When enabled, ref-
erenced record targets (such as presets or palettes) with labels will have their labels displayed rather than
their target type and number. This is disabled by default.
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{Show Reference Labels} is a global setting that will affect all displays. For some displays such as live
and blind, {Show Reference Labels} can be enabled at the individual tab level by accessing the tab's con-
figuration menu. This will override the setting in Setup.

Manual Control

Changes in this section impact the Basic Manual Control or the Advanced Manual Control chapter.

Encoder Shutter Controls

New shutter controls have been added to the shutter encoder display.

Note: Forlon, ETCnomad, RPU, and RVI, the encoder display can be accessed by using
CTRL + ALT + \onan alphanumeric keyboard. ALT + , can be used to change encoder pages.

Shutter Graphic

Tap or click on the shutter graphic to open up the shutter controls window.

Angle Home Pair BD

Thrust Home Inverse AC Inverse BD

Pair All

The shutter controls window allows you to move individual shutters by holding down one of the letters
inside of the shutter graphic. To rotate the shutters, use the <A>, <B>, <C>, or <D> buttons around the out-

side of the shutter graphic.
Angle Home Pair BD

Thrust Home Inverse AC Inverse BD

Pair All

Encoder Buttons

Note: The encoder buttons are used with the encoders for shutter control. These buttons do not
work with the shutter graphic control.

The following buttons are available for shutter control:

# Angle Home- sets the angle of all of the shutters to their home position.

7+ Thrust Home- sets the thrust (how far in or out of the beam the shutter travels) of all of the shutters
to their home position.

# Pair AC - pairs the A and C shutters together so they move together.
»* Pair BD- pairs the B and D shutters together so they move together.
#+ Pair All- pairs all of the shutters so they move together.
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#+ Inverse AC - pairs the A and C shutters so they move in the opposite directions from each other.
** Inverse BD - pairs the B and D shutters so they move in the opposite directions from each other.

#*  A>D - sets the encoders to use the custom encoder pages for the shutters. Thrust for all of the shut-
ters is on one page, Angle for all is on another page.

Release

Release has been added as an extension of the {Make Null} command in Blind. When Release is used, it
behaves like Make Null, but it also releases the channel and parameter data to its background state, if one
is available, or fades out the intensity instead.

Release can be used to mask instructions in a cue after it has already been stored. The data is not removed
from the cue.

Release is applied in Blind by using the {Release} softkey or by using the [Release] hardkey if available on
your console.

*+ [Cue] [3] [Enter] [2] {Release} [Enter] - releases all data for channel 2 in cue 3.
#» [Cue] [2] [Enter] [3] {Color} [Release] - releases the color data for channel 3 in cue 2.

Note: Release tracks forward through a cuelist until the Release command is removed or a
move instruction happens.

When release has been applied, the released content will display in gray with a R in Blind.

Revolution Wybron

A Release flag has been added to the Playback Status Display.

[Thru] [Thru] in Blind

While in any of the Blind displays, you can use the [Thru] [Thru] command to create targets and switch to
their appropriate Blind mode.

For example,

** InBlind, [Preset] [1] [Thru] [Thru] [5] [Enter] will create presets 1-5 and put you in the Blind preset
mode.

Fanning Multiple Targets in Blind

By using [Thru] [Thru] in Blind, you can create multiple targets, such as presets. You can then fan channel
levels across those targets.

For example,

In Blind,[Preset] [1] [Thru] [Thru] [5] [Enter] will create presets 1-5 and put you in the Blind preset mode.
You can then use the following syntax to fan channel levels across those five presets . [1] [Thru] [1][0]
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[At] [5] [0] [Thru] [1] [0] [0] [Enter] will fan the levels of channels 1-10 from 50 to 100 across the newly cre-
ated five presets.

#* Preset 1 will have channels 1-10 at 50%.
7+ Preset 2 will have the channels at 63%.
%+ Preset 3 will be at 75%.

** Preset 4 will be at 88%.

#+ Preset 5 will have the channels at full.

Working with Cue Lists

Changes in this section impact the Working with a Single Cue List, Working With Multiple Cuelists, or Cue
Playback chapter.

Record Via Load

You can record a cue 1 to the next unused cuelist by using the Load button for an unmapped fader.
[Record] [Cue] [Load] will create a cue 1 in a new cuelist and map that cuelist to the fader.

Additional Topics
RPU Sync LED

The Sync LED on a RPU will now blink if there is a network issue.

[Shift] + [Custom]

On Eos Ti, pressing [Shift] + [Custom] will put Focus on the command line. On Eos, pressing [Shift] +
[Custom] can still be used to put Intensity onto the command line.
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Addition to Facepanel Shortcuts

[Escape] + [Load]

[Escape] + [Load] can be used to unmap all instances of the target (cue list, submaster, palette, or preset)
on a selected fader.

Changes to Storing and Using Macros

Number of Macros

You can now create up to 99,999 macros. Macros can be recorded with a number identifier from 1 to
99,999.

Additions to Show Control

\_) Note: Other show control methods can be used to trigger cues, submasters, and macros. For
more information, please see the Eos Family Show Control User Manual, which is available for
download at www.etcconnect.com.

SACN Input

SACN (streaming ACN) is a protocol (ANSI E1.31-2009) that allows for the transfer of DMX packets over a
network using the ACN protocol. SACN allows for there to be multiple sources. These sources (configured
at the source device) can each be given a priority. The valid priority range is 1 (lowest) to 200 (highest). If
sources have the same priority, sSACN will use Highest-Takes-Precedence (HTP).

sACN Input can be used to trigger the following actions:
#+ Cue-fires acue

#» Submaster - bumps a submaster, turns on or off a submaster, or sets a submaster fader action,
which maps the input percentage to the submaster's percentage.

»» Macros - fires a macro

With the exception of a submaster fader action, SACN triggers the action when the level rises above 50%
(DMX 127). It does not fire again when the level drops below 50% (DMX 127). It only fires again when the
level drops below 50% and then rises above 50%.

\_) Note: sACN input only listens to a single SACN adddress. It is 8bit only. To listen to a 16bit
input source, you will need to have the console listen to the high/coarse part of the 16-bit pair of
addresses.

Using sACN Input
Open the show control display.

7 [Tab] + [1][1]

Create a new event list.
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7+ <Event> [1][ [/] [Enter]
Define the type of input.
7+ <Event> [1][ [/] {Type} {Network} [Enter]
Create a new event.
#+ [1] [Enter]
Assign the sACN address using the universe / address format.
#» {sACN} [4] [/] [1] [Enter]
Add the action to execute. Actions can be either a cue, submaster, or a macro.
#+ {Action} {Cue} [1] [Enter]

String Input

String Input, which includes Open Sound Control (OSC) and ASCII / UDP strings, can be used to trigger
the following actions:

»* Cue-fires acue

#* Submaster - bumps a submaster, turns on or off a submaster, or sets a submaster fader percentage
by using UDP. Fader levels cannot be set using OSC.

*» Macros - fires a macro

Using String Input
Open the show control display.
» [Tab] + [1]1[1]
Create a new event list.
2 <Event> [1][ [/] [Enter]
Define the type of input.
7 <Event> [1][ [/] {Type} {Network} [Enter]
Create a new event.
2+ [1] [Enter]
Select Input String and type the appropriate UDP or OSC command
#* {Input String}

UDP
Type in the string you want the console to listen to.

** The sending device needs to add “SC” (case-sensitive) to the beginning of the string in
order for it to be correctly processed.

** The string needs to be terminated with a carriage retumn (hex OD), \r, or #. For example,
type Hello in the Input String field. On your UDP sending device, have it send SC Hello#.

** To set the submaster fader percentage using UDP, you need to include a number (0-100)
after the string. For example, blue 50#.
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OSC
Type in the command you want the console to listen to.

#» The sending device needs to start with /eos/sc/ in order for the console to listen to it. For
example, type Hello in the Input String field. On your OSC sending device, have it send
/eos/sc/Hello.

\. J

Then add the action to execute. Actions can be either a cue, submaster, or a macro.
#+ {Action} {Cue} [1] [Enter]
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System Basics

Changes in this section impact the System Basics chapter.

Configuration Menus
For displays that had configuration options in Setup, such as Live/ Blind and Playback Status, most of
those options are now available from the display's tab.

For displays that used a gear menu, such as Color Tools and the x25 DS, those options are now available
from the display's tab.

Right click or tap on the display's tab to see their configuration menus.
Live and Blind Configuration Menu
The Live/Blind displays have a new configuration menu. The configuration settings previously found in the

Setup are now available by double clicking and then clicking on (in this example) live table, or by selecting
the gear icon, which is located by the tabs, and then pressing (iin this example) live table.

(1) Note: Eachinstance of Live/Blind may be configured individually.
1y,
e,

Close Tab

Replace Tab

Close All Tabs But This

Suppress Target Status Bar
Close All Tabs

Show Reference Labels
Lock Frame

+ Group Channels By 5

) Zoom Out @\ Zoom In + High Contrast
Live Table ) @ Disable 100 Channel Display Mode
O Enable 100 Channel Display Mode - 5x20
O Enable 100 Channel Display Mode - 4x25
Reset to Default -
(Tab 1)

Reset to Eos Default

The following options are available:

7+ Suppress Target Status Bar - Hides the target status bar from the display. The target status bar
displays at the bottom of the Live/ Blind displays.

Proporti
A M

Int Up Int Down Focus Color Beam Dur MBAP F Link Loop Curve

10 10
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7+ Show Reference Labels - When enabled, referenced record targets (such as presets or palettes)
with labels will have their labels displayed rather than their target type and number. The option was
previously found in Setup.

[/\j) Note: [Shift] & [Label] can be used to temporally toggle between views. ]

** Group Channels By 5 - When enabled, five channels are grouped together with space separating
each group of five. This setting is enabled by default.

»* High Contrast - When enabled, high contrast brightens the magenta used to show tracked values.
This setting is enabled by default.

*+ Disable 100 Channel Display Mode - By default, 100 channels are displayed at a time in the live
summary view.

# Enable 100 Channel Display Mode - 5x20 - This is a variation of the 100 Channel Display Mode,
which displays 5 rows of 20 channels.

#+ Enable 100 Channel Display Mode - 4x25 -This is a variation of the 100 Channel Display Mode,
which displays 4 rows of 25 channels.

Default

You can save your settings as a default state for Live/Blind. The default is identified with parentheses.
»* Reset to Default - Will restore the settings to the default state. Live/ blind tabs will normally default
to the settings for Tab 1.0, if no other tab has been assigned as default.

?» Set Current as Default - Allows you to set a Live/ Blind tab other than 1.0 as the default. The
default tab will be shown in parentheses , for example (Tab 1).

el Display Mode - 4x25

Reset to Eos Default

** Reset to Eos Default - Restores the settings to Eos defaults.

Playback Status Display Configuration

Playback Status Display (PSD) has a new configuration menu, which is accessed by double clicking and
then clicking on the PSD tab, or by selecting the gear icon, which is located by the tabs, and then pressing
PSD.

The following options are available in the PSD Configuration Menu:
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#+ Target Grid - this option is only available when the PSD is split, and is used along with the Lock
Status option. Target Grid allows you to select either the top or bottom display. Press [Format] to
split the PSD.

#» Lock Status - allows you to lock the PSD to a certain cue list. When the PSD is split, you will use
Target Grid to first select top or bottom of the display, and then you can use Lock Status to select
the cue list.

_) Note: Phantom cue lists will display but cannot be locked to. See Cue List Properties
(on page 7) to learn more about phantom cue lists.

*» Display Cue Parts - displays the individual parts of a part cue. When not enabled, the number of
parts for that cue will display as a superscript number beside the cue's number.

*» Display Cue Links - displays the Link Cues (on the next page) information.

*» Display PSD Time Countdown - displays the cue category times countdown in the PSD as a cue
is fading.

Display Master Playback Status - displays the current cue's status information.

b

Master:

*» Display Fader Ribbon - displays the fader ribbon, which shows the current fader page under the
Master Playback Status.

*» Display Notes - displays the Cue Notes (on page 21) in a horizontal bar at the bottom of the PSD.
*» Display Command Line - displays an optional command line on the PSD.

*» Break Link to Live/Blind - When selecting the Live/Blind display, the PSD will also come into
view if it is currently hidden. This option allows you to break the link between the PSD and the
Live/Blind displays so that the PSD will no longer come into view when selecting Live/Blind.

Reorder Columns

Reorder columns allows you choose what data displays in the PSD and what order it displays in. By
default, all columns except notes will be displayed. The arrow keys on the right can be used to move
columns around. Columns are moved in groups. To select a column header to move, click or tap the name.
The check boxes suppress or enable. When an item is enabled to display, a check mark will be in the cor-
responding box.

Default
You can save your settings as a default state for the PSD. The default PSD is identified with parentheses.

** Reset to Default - returns the settings to the default state that you created.

*+ Set Current as Default - uses the current settings to create a default state. The default tab will be
shown in parentheses , for example (Tab 2).

Break Link to Live/Blnd

D efault

*» Reset to Eos Default - retumns all settings to the Eos defaults.

Paging the Playback Status Display

You can page the Playback Status Display (PSD) now if focus is on a Live/Blind tab.
[Shift] + [Page A] or [Shift] + [Page ¥] will page the display up or down.
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I:/ ijl Note: This action will page the PSD that is showing the currently selected cue list. If there is no
~ PSD visible showing that cue list, nothing will be paged.

Link Cues

Cues that link to other cues now display this information in a row under the cue in the Cue List Index and
the Playback Status Display. This can be suppresed in the PSD configuration. See Playback Status Dis-
play Configuration (on page 2) for more information.

Additional Cue List Information

Additional information about cue lists has been added to the Playback Status Display (PSD). Previously
this information was only available in the Cue List Index.

The following information will now display in the PSD as well as the Cue List Index:

»» Partitions on Cue Lists
» Cue List Executes
#* 0O0S Sync

Preview Mode in Live

A {Preview} softkey has been added to Live Summary.{Preview} is not available in Live Table. {Preview}
allows you to display the intensity values for another cue under the current values in the Live Summary tab.
An indicator of what Preview mode you are in will display in the upper left hand corner of the Live Summary
display.

Tracking | Preview Pending

1 2

In {Preview} mode, the following softkeys are available:

#+ {Previous} - previews the last cue run from the selected cue list.
7+ {Pending} - previews the pending cue from the selected cue list.

The following examples show other functions that are available in Preview:
7+ {Preview}[Next] will allow you to preview the cue higher than the one currently selected. If there is

no cue already selected in preview mode, [Next] will behave the same as {Pending}.

# {Preview}[Last] will allow you to preview the cue lower than the one currently selected. If there is no
cue already selected in preview mode, [Last] will behave the same as {Previous}.

% {Preview}<Cue>[5] will preview cue 5.
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Fader Configuration

Fader configruation has had some major changes with version 2.4.In addition to putting cue lists and sub-
masters on faders, it is also possible to map presets and IFCB palettes to faders.

Faders are no longer configured in Setup. The fader configuration display is found on Tab 36 .The Fader_
List (on page 17), which shows all of the faders and their assignments, can be found in Tab 35.

At the top of the fader configuration display, you can select the fader page, which has increased from 30
pages to 100 pages of 10 faders each page. You can configure the master fader pair at the top of the dis-
play. See Master Fader Configuration (on page 7) for more information.

The fader configuration display shows a virtual mockup of each fader and its buttons. The various parts of
the virtual fader can be clicked or tapped to open configuration options.

Fader Header

Configuration

Button

Fader

Each fader is color coded based on its assigned target type. Grandmasters and inhibitive submasters are in
red, additive submasters are yellow ,playback faders display in green ,and presets and palettes are orange.

] 1x 1 1x IP 220 % 1x GM 1x Pr 1scenel 1x

Master = Master

GroupAssert

Bump Bump Blackout Bump

Fader Configuration Window
Click on the fader header to open the fader configuration window.

Target

Target

This setting allows you to map a cue list, submaster, intensity, focus, color, or Deerete Instance
beam palette, preset, or grandmaster to a fader.

Buttons & Sider

ID

This sets the number of the target assigned to the fader, such as Cue List 2 or
Submaster 5. For alist of available Target IDs, click or press the {...} button
beside ID.
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Z:\ﬂ) Note: Content can also be loaded to faders from Live, using the command line and load, just
like previous software releases.

Discrete Instance

This setting defaults to Yes and applies to cue lists. When a fader is discrete, it will track other faders that
are running the same cue list, BUT if a fader that it is tracking manually changes to a different cue list, a dis-
crete enabled fader will not change its content. When set to No (or disabled), once a fader is in sync with
another fader running the same cue list, it will stay in sync when content is changed. Discrete disabled is
noted in the fader ribbon with a link icon.

Size

A fader can be mapped so its content takes up 1, 2, or 3 faders. 1x will take up 1 fader, 2x will use 2 faders,
and 3x will use three.

Z:/ ﬁ Note: If afaderis mapped to 1x, the top button will be locked as a load button. When mapped to
2x or 3x, the top left button will be locked as a load button.

Buttons & Slider

When set to Default Mapping, the button and fader configuration is drawn initially from the cue list or sub-
master list properties for that content. If changes are made to that mapping in Tab 36, it filters BACK to the
cue or submaster list and changes any other instances where that content is mapped. If set to Local, any
changes made in Tab 36 impact only that instance of the content. See Cue List Properties (on the facing
page) and Submaster Properties (on page 10) for more information on default mapping.

Additional Configuration

Clicking on the configuration box will open additional configuration options that are dependent on the target
type assigned to the fader.

For detailed information on these various options, please see the following topics:

»* Grandmaster Configuration (below)

* Cue List Properties (on the facing page)

7 Submaster Properties (on page 10)

# Presets and Palettes Properties (on page 14)

fra

Grandmaster Configuration

When a fader is configured as a grandmaster, you can set the fader itself as a master or dis-
able it. Fader size is set to 1x, and can not be changed.

The first button is locked as a load button, and cannot be configured. The second button is dis-
abled and cannot be configured. The third button can be configured as a blackout button or dis-
abled. When configured as a blackout, both buttons must be pressed to set the grandmaster to
blackout.

Master

Blackout
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Master Fader Configuration

Click or tap Master Fader to open the master fader configuration window.

Target
This setting allows you to map a cue list to a fader.

ID

This sets the number of the target assigned to the fader, such as Cue List 2.
For alist of available Target IDs, click or press the {...} button beside ID.

Discrete Instance

This setting default to Yes and applies to cue lists. When a fader is discrete, it will track other faders that
are running the same cue list, BUT if a fader that it is tracking manually changes to a different cue list, a dis-
crete enabled fader will not change its content. When set to No (or disabled), once a fader is in sync with
another fader running the same cue list, it will stay in sync when content is changed. Discrete disabled is
noted in the fader ribbon with a link icon.

Size
Master fader is set to a size of 2 faders and cannot be changed.

Buttons & Slider
You can select to use default mapping for the fader, or you can use local mapping.

o

Z:\D Note: When a userfirst joins a session, the master fader is unmapped. Once a cue list is estab-
lished for that user, any other devices joining the user group will have the same cue list auto-
matically mapped to their master. If a device changes its user ID, the cue list on the master will be
remapped accordingly.

Additional configuration options are available. Please see Cue List Properties (below) for more inform-
ation.

Cue List Properties

Click or tap the configuration box to access this properties display in the fader configuration display.
The following options are available when a fader is configured as a playback:

unmapped 1x

HTP  Assert Priority ~ Phantom Back From First Go From Last Stomp Mode

Background

Background

If a fader has been configured for default mapping ( See Fader Configuration (on page 5) for more inform-
ation), the fader will receive its configuration from the Cue List Index. Changes made to a cue list in the cue
list index will be shared with any default mapping faders loaded with that cue list. If changes are made to a
fader set to default mapping in the fader configuration display, those changes will also happen in the Cue
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List Index. If set to Local, any changes made in the fader configuration display will impact only that
instance of the content.

Analog TX/RX

Master HTP Assert Priorty  Phantom  Back From First Go From Last Stomp Mode

# Background

Master

A fader can be assigned as a Master. When it is a master, its behavior as a Proportional Master, Manual
Master or Intensity Master (I-Master) is drawn from this setting.

#+ Proportional faders, when the slider is set to zero prior to the execution of a cue, will withhold play-
back of intensity data until the fader is raised. Intensity data will then be played back proportionally
according to the level of the fader. Once the fader reaches full, the cue is considered complete and
the cue is released from the manual fader. If the fader is at any value other than zero when the cue is
executed, intensity values will play back normally. If the slider is returned toward zero, intensity in
the cue will face to the previous level.

#* Intensity Masters will master the intensity level for cues during playback. Therefore, intensity mas-
ters set below 100% will proportionally limit playback of intensity data relative to the level that the
fader is set. All non-intensity parameters are unaffected by the fader. Once the fader has reached
full, control of intensity is retained. If the fader is moved toward zero, intensity will proportionally
fade toward zero (not the previous state as per proportional faders).

#* In Manual Master mode, cues are triggered manually by faders without using the [Go] button. With a
cue list on a fader set to manual master, a cue will fire in manual time when the fader is moved from
0% or from Full.

HTP

Intensity playback behavior can be set to HTP (highest takes precedence) or LTP (latest takes pre-
cedence). For cues, it defaults to LTP.

Assert

Assert can be turned on or off at the fader level. This property sets the entire cue list to be asserted on play-
back (even track instructions are replayed). Please see the Cue Playback chapter of your console's
manual for more information.

Priority
The Independent setting for a cue list has been changed to Priority.

Priority is used to protect values from being affected by submasters or playback faders that have a lower
priority level. They will, however, still be impacted by manual control, grandmaster, blackout, park instruc-
tions, or other playback faders and submasters at the same or higher priority.

There are 10 levels of Priority that cue lists can have. 1 is the lowest level and 10 is the highest. The default
priority level is 4.
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Background

Background can be enabled or disabled at the fader level. When enabled, the content of the cue list will act
as a background or previous state for other cues and submasters.

Background Priority
Background can have a priority assigned to it.

In previous software releases, when content was released, it always returned to the last fader that owned
it. Background priority releases to the highest priority content that previously had ownership, provided that
content has not be turned off or released.

There are 10 levels of Priority. 1 is the lowest level and 10 is the highest. The default priority level is 4.

Phantom

When a cue list is set to Phantom, pressing GO will not change the selected cue on the command line, or
an unlocked playback status display.

Back From First
Back From First controls the behavior that happens when you press the back button while in the first cue.
The following are Back From First options:

*» Do Nothing - keeps the first cue active.

*» Cue Out(Default Setting) - only fades out channels in that cue list. Other channels will remain.
Intensity and non-intensity parameters will be homed. This setting uses the Back time for fading.

** Wrap - puts the last cue in the list in pending.

#» Restore Background - any background cue, submaster, and effect levels are restored following
background priority. Manual levels will not be restored. This setting uses the Release time.

Go From Last
Go From Last controls the behavior that happens when you press the Go button while in the last cue.
The following are Go From Last options:

** Do Nothing (Default Setting) - keeps the last cue in the list active.

#» Cue Out - only fades out channels in that cue list. Other channels will remain. Intensity levels will
go out. Non-intensity parameters will remain. This setting uses the Go to Cue timing for fading.

*» Wrap - puts the first cue into pending.

*» Restore Background - any background cue, submaster, and effect levels are restore following
background priority. Manual levels will not be restored. This setting uses the Release time. The
pending cue will be set to the first cue in the list. If there is no background state, the non-intensity
parameters will not fade.

Stomp Mode

Stomp refers to when all the content owned by a cue is now being controlled by other targets. The cue is
being removed from the background , and once that happens, it would not be eligible to fade back. You can
assign behavior that will happen when a cue is stomped.

The following are Stomp Mode options:
#» Off When Stomped - Puts the content into an off state, the same behavior encountered when
pressing [Off] + [Load].
#» Unload When Stomped - Unloads the fader.
** Nothing When Stomped - Nothing happens.
#» Release When Stomped - Resets a cue list to the top of the list.
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Fader and Button Configuration
Click or tap on the virtual buttons or fader to see a list of available configuration options.

Button Options
The following options are available for playback buttons:

#* Go - executes the cue currently in the pending file of the associated fader.

#+ Stop Back - instantly stops all fader activity. Pressing twice will fade to the previous
cue on that fader.

*» Assert - can be used to re-run the active cue on that fader, to regain control of all cue
contents, to apply a newly set independent state to the associated fader, or make any
changes in blind to an active cue on stage.

#* Group Select - selects the channels stored in the cue.

** Freeze - halts all effect activity on the fader. Press Freeze again to resume effect activ
ity.

# Off - removes the content and if the fader is set to Master, the fader will remain where it currently is.

7+ Release - removes the content and if the fader is set to Master, the fader will reset to 0.

»+ Stop Effect - stops the running effects.

#+ Button Disabled - no action is assigned to the button.

Fader Options
The following options are available for a playback fader:

#+ Master - fader will be a proportional master, a manual master, or an intensity master.

»» Effect Rate - fader centers to home. It controls the rate of any running effects (same behavior as
using rate via the Effect Status Display). The adjusted setting from this control cannot be stored.

»» Effect Size - similar to Effect Rate but for effect size.

7+ Rate Master - homes to center. It adjusts the cue rate, just like rate and load.
** Down Fade - see default behavior of master fader.

** Fader Disabled - no action is assigned to the fader.

Submaster Properties

Click or tab the second row of the fader page to access this properties display. You can also access these
properties from the submaster list.

The following options are available when a fader is configured as a submaster:

Master HTP  Exclusive Restore Priority Up Time Stomp Mode Unmark at 0%

Background Dwel Time

Down Time

Background

If a fader has been configured for default mapping ( See Fader Configuration (on page 5) for more inform-
ation), the fader will receive its configuration from the Submaster List. Changes made to a submaster in the
submaster list will be shared with any default mapping faders loaded with that submaster. If changes are
made to a fader set to default mapping in the fader configuration display, those changes will also happen in

Eos Family Operations Manual Supplement 10 Electronic Theatre Controls, Inc.



ETC Supplement

Eos Family v2.4.0

the Submaster List. If set to Local, any changes made in the fader configuration display will impact only
that instance of the content.

v e

Stomp Mode Unmark at 0%

Mode

You may define your submaster as additive (contributes to the live output), inhibitive (limits live output) or
an effect submaster. Eos defaults to submasters being additive.

Master

A fader can be assigned as a Master. When it is a master, its behavior as a Proportional Master or Intensity
Master (I-Master) is drawn from this setting.

Please see the Storing and Using Submasters chapter of your console's manual for more information on
Proportional and Intensity Masters.

HTP

Intensity playback behavior can be set to HTP (highest takes precedence) or LTP (latest takes pre-
cedence). Submasters default to HTP.

Exclusive

Submasters can be placed in exclusive mode. This prohibits storing the contribution of the submaster into
any record targets.

Restore

Submasters can be placed into restore modes of minimum or background, which is the default. When a sub-
master is in the restore to background mode, the restore column of the submaster list display will be blank.
When in minimum mode, 'Min' will display in the restore column.

The restore mode of background means that when the submaster is returned to zero, control will be
restored to the background value, such as another submaster or a cue.

The restore mode of minimum means that when the submaster is faded down, control does not go to the
previous background state but to the parameters’ minimum value.
Priority

The independent setting for submasters has been changed to priority. There are 10 levels of priority for sub-
masters. 1 is the lowest and 10 is the highest. Submasters can still be shielded, which means that their con-
tent is automatically made exclusive and can't be controlled by anything other than that submaster and

park, including by manual control. Shielded has a higher priority than 10.

Background

Submasters can have their background states disabled. Background states are enabled by default. When
enabled, the content of the submaster will act as a background or previous state for other cues and
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submasters.

Background Priority
Background can have a priority assigned to it.

In previous software releases, when content was released, it always returned to the last fader that owned
it. Background priority releases to the highest priority content that previously had ownership, provided that
content has not be turned off or released.

There are 10 levels of background priority for submasters. 1 is the lowest and 10 is the highest.

Up Time

This is the time for the submaster to fade from its home position to its target position (0 to Full if additive,
Full to 0 if inhibitive). The default time is 0.

Dwell Time
This is the time the submaster look will hold before starting the downfade. This can be set to a specified

"«

time, or to “Hold” or “Manual”. “Hold” time maintains the submaster values until the bump is pressed a
second time. “Manual” time applies the submaster values only as long as the bump is held. The default is
“Manual’.

Down Time
This is the time for the submaster to fade from its target position to its home position. The default time is 0.

Stomp Mode

Stomp happens when all the content owned by a submaster is now being controlled by other targets. The
submaster is being removed from the background , and once that happens, it would not be eligible to fade
back. You can assign behavior that will happen when a submaster is stomped.

The following are Stomp Mode options:
2+ Off When Stomped - puts the content into an off state, the same behavior encountered when press-
ing [Off] + [Load].
* Unload When Stomped - unloads the fader.
* Nothing When Stomped - no action happens to the submaster.
* Release When Stomped -This function behaves the same as Off When Stomped.

.

Unmark at 0%

When this option is on, marked content controlled by the submaster will automatically be released when
the fader reaches 0%. When the bump button is next pressed, the submaster will fire. If this option is off,
you would need to first press the bump button to reset the submaster before pressing the bump again to fire
it.

[I:/ j) Note: This option is for submasters that are set to Intensity Master. ]
e,

Fader and Button Configuration
Click or tap on the virtual buttons or fader to see a list of available configuration options.
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Button Options
The following options are available for submaster buttons:
*» Bump - plays back the submaster at 100% of the recorded level. It will continue to do
so until released, unless the submaster has a time assigned or the {Hold} property set.

** Group/ Assert - selects all the channels associated with the submaster, if the sub-
master is inactive. If the submaster is active, the contents of the submaster will be
asserted.

*» Assert - regains control of all of the channels associated with the submaster.

#+ Group Select - selects the channels stored in the submaster. This is the same as
[Group] [Sub] [n].

*» Freeze - halts all effect activity on the fader.

*» Off - removes the content and if the fader is set to Master, the fader will remain where it currently is.
#* Release - removes the content and if the fader is set to Master, the fader will reset to 0.

*» Stop Effect - stops the running effects.

*» Button Disabled - no action is assigned to the button.

Fader Options
The following options are available for a submaster fader:

#» Master - fader will be a proportional master, a manual master, or an intensity master.

*» Effect Rate - fader centers to home. It controls the rate of any running effects (same behavior as
using rate via the Effect Status Display). The adjusted setting from this control cannot be stored.

»» Effect Size - similar to Effect Rate but for effect size.

** Rate Master - homes to center. It adjusts the cue rate, just like rate and load.
*» Down Fade - see default behavior of master fader.

** Fader Disabled - no action is assigned to the fade

Execute List

The execute list for submasters can be used to trigger actions such as macros, snapshots, MIDI Raw,
Serial Strings, and cues. This works similar to the External Links for cues.

There is an {Execute} softkey that is available after you press the [Sub] button in either Live, Blind, or the
sub list display.

When you press {Execute}, the softkeys will change to {String}, {Macro}, {Relay}, {On}, {Off}, {Snap-
shot}, and {MIDI Raw}.

Triggering an Action
Pressing the bump button of a submaster will trigger any actions assigned to its execute list.

Adding a Trigger

** [Sub] [1] {Execute} {Macro} [2] [Enter] - triggers macro 2 when submaster 1's bump button is
pressed.

Removing a Trigger

** [Sub] [1] {Execute} {Macro} [Enter] - removes the trigger from submaster 1's execute list.
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Freeze and StopEffect on Submasters

Freeze

[Freeze] can be used to halt all effect activity on any active submaster. To activate a freeze for only a spe-
cific submaster, press [Freeze] & [Load].

There are two ways to remove the freeze command:

** Press [Freeze] & [Load] again for the specific faders to unfreeze the activity.
*+ Press [Assert] & [Load] or [Go] or [Stop/Back] for the specific faders to resume the activity.

StopEffect

The [Stop Effect] button can be used to stop all effects from operating on any or all faders, or it may be
used with the control keypad to stop a specific effect.

#+ To stop all effects on a fader, press [Stop Effect] & [Load] of the associated fader.

#+ To stop a specific effect regardless of the fader it is operating on, press [Effect] [2] [StopEffect]
[Enter].

When an effect is stopped, all impact of the effect is removed and the stage output is as though the effect
had never been activated.

Presets and Palettes Properties

Presets and Palettes can be mapped to faders.
Click or tab the second row of the fader page to access this properties display.
The following options are available when a fader is configured as a preset or palette fader:
CP 1darkblue  1x
Master HTP  Exclusive Restore Priority Up Time Stomp Mode Unmark at 0%

Background Dwell Time

Down Time

Background

Mode

You may define your fader as additive (contributes to the live output), inhibitive (limits live output) or an
effect fader (presets only).

Master

A fader can be assigned as a Master. When it is a master, its behavior as a Proportional Master or Intensity
Master (I-Master) is drawn from this setting.

Please see the Storing and Using Submasters chapter of your console's manual for more information on
Proportional and Intensity Masters.
HTP

Intensity playback behavior can be set to HTP (highest takes precedence) or LTP (latest takes pre-
cedence).
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Exclusive

Faders can be placed in exclusive mode. This prohibits storing the contribution of the fader into any record
targets.

Restore

Faders can be placed into restore modes of minimum or background, which is the default. When a fader is
in the restore to background mode, the restore column of the fader list display will be blank. When in min-
imum mode, 'Min" will display in the restore column.

The restore mode of background means that when the fader is returned to zero, control will be restored to
the background value, such as another fader or a cue.

The restore mode of minimum means that when the fader is faded down, control does not go to the previous
background state but to the parameters’ minimum value.

Priority

The Independent setting for faders has been changed to priority. There are 10 levels of priority for faders. 1
is the lowest and 10 is the highest. faders can still be shielded, which means that their content is auto-
matically made exclusive and can't be controlled by anything other than that fader and park, including by
manual control. Shielded has a higher priority than 10.

Background

Faders can have their background states disabled. Background states are enabled by default. When
enabled, the content of the fader will act as a background or previous state for other cues and faders.
Background Priority

Background can have a priority assigned to it.

In previous software releases, when content was released, it always returned to the last fader that owned
it. Background priority releases to the highest priority content that previously had ownership, provided that
content has not be turned off or released.

There are 10 levels of background priority for faders. 1 is the lowest and 10 is the highest. When
LTP content is released to background, it will go to the background state with the highest available priority.

Up Time

This is the time for the fader to fade from its home position to its target position (0 to Full if additive, Full to 0
if inhibitive). The default time is 0.

Dwell Time
This is the time the fader look will hold before starting the downfade. This can be set to a specified time, or

"«

to “Hold” or “Manual”. “H old” time maintains the fader values until the bump is pressed a second time.
“Manual” time applies the fader values only as long as the bump is held. The default is “Manual”.

Down Time
This is the time for the fader to fade from its target position to its home position. The default time is 0.

Stomp Mode

Stomp happens when all the content owned by a fader is now being controlled by other targets . Thefader is
being removed from the background , and once that happens, it would not be eligible to fade back. You can
assign behavior that will happen when a fader is stomped.

#+  Off When Stomped - puts the content into an off state, the same behavior encountered when press-
ing [Off] + [Load].
#* Unload When Stomped - unloads the fader.
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7+ Nothing When Stomped - no action happens to the fader.
7+ Release When Stomped -This function behaves the same as Off When Stomped.

Unmark at 0%

When this option is on, marked content controlled by the fader will automatically be released when the
fader reaches 0%. When the bump button is next pressed, the fader will fire. If this option is off, you would
need to first press the bump button to reset the fader before pressing the bump again to fire it.

[j) Note: This option is for faders that are set to Intensity Master. ]

Fader and Button Configuration
Click or tap on the virtual buttons or fader to see a list of available configuration options.

Button Options
The following options are available for fader buttons:

** Bump - plays back the content at 100% of the recorded level. It will continue to do so |-y
until released, unless the submaster has a time assigned or the {Hold} property set.

?* Group/ Assert - selects all the channels associated with the fader, if the fader is inact-
ive. If active, the contents of the fader will be asserted.

# Assert - regains control of all of the channels associated with the fader.

7+ Group Select - selects the channels stored in the fader. This is the same as [Group]
[Sub] [n]. Bump

** Freeze - halts all effect activity on the fader.
»»  Off - removes the content and if the fader is set to Master, the fader will remain where it currently is.
# Release - removes the content and if the fader is set to Master, the fader will reset to 0.

#+ Stop Effect - stops the running effects.

*+ Button Disabled - no action is assigned to the button.

Master

Group/Assert

Fader Options
The following options are available for a fader:

#+ Master - fader will be a proportional master, a manual master, or an intensity master.

*+ Effect Rate - fader centers to home. It controls the rate of any running effects (same behavior as
using rate via the Effect Status Display). The adjusted setting from this control cannot be stored.

»» Effect Size - similar to Effect Rate but for effect size.

7+ Rate Master - homes to center. It adjusts the cue rate, just like rate and load.
** Down Fade - see default behavior of master fader.

»* Fader Disabled - no action is assigned to the fade
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Fader List

The Fader List, which shows all of the faders and their assignments, can be found
in Tab 35.

You can also make changes to a fader's configuration while in the fader list dis-
play by clicking on a column. A virtual fader will be displayed. Click on the appro-
priate area of the fader to access the configuration options. Selection can be done
by clicking in the column or from the command line.

Range editing is possible in this display by selecting all the needed faders.
Changes made to the configuration will be made to all of the selected faders.

With a fader selected, the CIA will also display a virtual fader and the con-
figuration options for that fader.

Button 1 Slider Button 3

Load M ( t Bump
Blackout

Bump

Bump

"‘\,'

Priority Up Time Stomp Mode Unmark at 0%

LTP Off Background  Background Dwel Time ;)

Background

Fader Ribbon

The fader ribbon has been updated to show the fader color coding that is used in the fader configuration
tools.

Grandmasters and inhibitive submasters are in red, additive submasters are yellow ,playback faders dis-
play in green ,and presets and palettes are orange.

Master:

In the above screenshot, Fader 1 has discrete off . There is a link icon that displays to indicate that discrete
is off. Fader 4 is set to an intensity master and is displaying an IM to indicate that.

Changes to ML Controls

There are several changes to the ML Controls display:

#» There are now category shortcut keys on the left side of the ML Controls display. Press a key to
quickly access those controls.
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»» Button size has increased for better touchscreen control.

#* When there is room, multiple rows of parameters will now display, and you can scroll the display ver-
tically.

»* The palette buttons have been removed from the ML Controls display.

Z:/\j) Note: Element consoles will display the palette buttons on the left side of the ML controls dis-
play.

Managing Show Files

Changes in this section impact the Managing Show Files chapter.

Lightwright Import Addition

A new option, {Import Text/Notes/Labels Only}, has been added to the Lightwright import display. This
option allows you to import just the patch database text.

Park Buffer

The contents of the park buffer are now saved with a show files. But by default will not open with a show
file.

You can load the park buffer, but it requires an additional step of confirming that you want to open the park
buffer. You will need to click or press the check box by the text Yes, Include the Park Buffer.

Deselect

N Advanced
All

Using [Thru] and [At] in Advanced Views

In the {Advanced} views within Show File managing options, such as Merge and Open, you can use the
[Thru] key to jump to the End column and [At] to jump to the Target column.

Patch

Changes in this section impact the Patch chapter.
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Patch Softkeys

The softkeys in Patch have changed. With a channel selected, the softkeys that display when you press
{Attributes} are now the same as when you press {Patch}.

Those softkeys are:
** {Replace}
7 {Swap}
#» {Properties}
» {Offset}
#+ {Unpatch}

Footprint Column Added to Fixture List

A column for DMX footprint has been added to the fixture list in Patch. The DMX footprint tells the number
of addresses the fixture needs.

Reordering Shutters

Shutters can be reordered in the Patch {Attributes} page. . Press the {Shutter Order} button to open the
shutter order display. The {Shutter Order} button will only display if a channel with shutters is currently
selected

Scra
ETC Scroll
Proportion  InvertPan | Gobo Select
Disabled
Curve Invert Tilt
Disabled

Swap P/T
Disabled
Color Path

[ i;l Note: Shutters have been renamed from 1-4to A - D. J
e,

In this display, you can invert the shutter order or rotate the order using the arrow buttons. After you have
created the order needed, press {Apply} for your changes to take effect.

j;,l Note: Shutter parameter names have also changed. Frame In is now Thrust and Frame Angle
~ is Angle. Any macros that used shutter parameters in older show files will need to be updated to
the new names.

Invert Rack

An {Invert Rack} option has been added to Patch>Attributes>Scrollers/Wheels. This option will only dis-
play when a fixture with a shutter frame assembly parameter is selected.
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The shutter frame assembly parameter allows for the shutter assembly to be tumed. When {Invert Rack}
is disabled, a encoder will move the frame assembly from the right. When enabled, the frame assembly will
move from the left.

Setup

Changes in this section impact the Setup chapter.

Allow +% and - % to be More Than 100%

In Setup>Desk>Manual Control, you can now assign +% and -% to values that have up to five digits.

Cell Editing

In Setup>Desk>Displays, a new option called {Cell Editing} has been added. When disabled, this set-
ting prevents changes to be made to the cells in the Live/Blind and Playback Status Displays. {Cell Edit-
ing} is enabled by default.

[/\j) Note: Options in the CIA are not affected by this setting. ]

Cue Time

You can assign [Cue] as a timing value for the {Go to Cue Time} and {Back Time}in
Setup>Desk>Manual Control>Default Times. The syntax, {Go to Cue Time} [Cue] [Enter} or {Back-
Time} [Cue] [Enter} will assign cue as the timing value.

When [Go To Cue] [n] [Enter] or [Back] is used, the fade will happen in the time set in the destination cue.

Display Setup Options Moved

Several options that were previously available in Setup>Desk>Displays have been moved to the Live Con-
figuration Menu. That menu is accessed by double tapping or right clicking on either the Live Table or Live
Summary tabs.

Those options are:

* High Contrast

#» Show Reference Labels
# Group Chans by 5

#* 100 Channel Display

v

St

See Live and Blind Configuration Menu (on page 1) for more information.

Some options are available in the Playback Status Display Configuration (PSD) menu. That menu is
accessed by double tapping or right clicking on the PSD tab.

Those options are:

»» Cmd Line on PSD
»» PSD Time Countdown

See Playback Status Display Configuration (on page 2) for more information.

Release and Off Times Added to Setup

Previously the Release and Off functions used the Assert timing from Setup. Now you can assign separate
timing values to the Release and Off functions by going to Setup>Desk>Manual Control>Default Times.
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Manual Control

Changes in this section impact the Basic Manual Control or the Advanced Manual Control chapter.

Color Path Option in Record Targets and Managing Show Files

You can access the Color Path list from the CIA by going to Browser>Record Target List>Color Path.

Color Path is also now included in the list of show components for show file functions such as partial show
loading, printing, and merging,

Copy To and Move To for Labels, Scenes, and Notes

The [Copy To] and Move To ([Copy To][Copy To]) commands can be used to copy or move labels
between any target types that can have labels. A {Labels Only} softkey will display.

** [Sub] [1] [Copy To] [Sub] [3] {Labels Only} will copy submaster 1's label to submaster 2.

Labels, scenes, and notes can be copied or moved between cues. The {Labels Only}, {Scene Only}, and
{Notes Only} softkeys will display.

** [Cue] [3] [Copy To] [Copy To] [Cue] [6] {Notes Only} will move the note from cue 3 to cue 6.

Working with Cue Lists

Changes in this section impact the Working with a Single Cue List, Working With Multiple Cuelists, or Cue
Playback chapter.

New Cue Softkeys

When [Cue] is pressed, a new softkey called {Attributes} will display.
Press {Attributes} to access the following softkeys:

#» {Rate}
*» {Note}
*» {Scene}
#+ {Curve}
*» {Preheat}
7 {AF/MF}

Scene and Note are new softkeys. For more information on their functions, see Scenes (on the next
page) and Cue Notes (below).

Cue Notes

Cues can have notes attached to them.

These notes can be viewed in the Playback Status Display and the Cue List Index by hovering a mouse
over or tapping on the + in the Label column.

Label

scenel

To add a note to a cue:
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# [Cue] [n] {Attributes} {Notes}

You can use the virtual alphanumeric keyboard or an external keyboard to enter the desired text.
See Playback Status Display Configuration (on page 2) for additional display options.

See Copy To and Move To for Labels, Scenes, and Notes (on the previous page) for more inform-
ation.

Go After Loop
A {Go After Loop} softkey has been added as a Cue {Execute} option.

{Go After Loop} will execute the next cue after a follow link/loop sequence has ended. By default, the loop
will end with the last cue in the sequence. {Go After Loop} will use the follow time assigned to the last cue
in the sequence.

7+ [Cue] [5] {Execute} {Go After Loop} [Enter] - assigns the {Go After Loop} command to cue 5.
Go After Loop will display in the Ext Links Column of the PSD.

Scenes

Scenes are a cue organization tool that provide a visual identifier for breaks in your show. Scenes allow for
quick cue list navigation without needing to remember a cue's number.

B OO Cricket & Cache*

String RX Analog TX/RX Proportional
Int Up IntDown  Focus Color u 3 AP 20 FwHg Lk Loop  Curve ate | Label

cool stuff

blue blinder

jets

Scenes display in the playback status display as a green bar above the cue they are associated with in the
list. An end of scene can also be created, and those display as a green bar under their associated cue.

Creating a Scene Break

You can add a scene break by using the {Scene} softkey. For example, [Cue] <1 > {Attribute} {Scene}
will add a scene to cue 1.

The virtual alphanumeric keyboard will open. You will need to label the scene before it is created.

Scene End

You can specify where a scene ends by using the {Scene End} softkey. For example, [Cue] <5 > {Attrib-
ute} {Scene End}will add a scene end to cue 5.

You can create a scene and a scene end at the same time by using [Thru]. For example, [Cue] [1] [Thru]
[5] {Scene} will add a scene to cue 1 and a scene end to cue 5.

Updating a Scene

The {Scene End} softkey can also be used when updating the cues in a scene. For example, [Update]
<Cue> [1] [Thru] {Scene End} will put the last cue of that scene on the command line.
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( i;l Note: Tracking/ cue only rules still apply. If your console is in tracking mode, and you want the
~ update to stop at the scene end, you will need to use the [Cue Only] command.

Using A Scene Break

You can recall a scene to quickly jump to a cue without needing to remember its number. To recall a scene,
use the [Go to Cue] button and select the {Scenes} softkey.

This will open up the scene selection display in the CIA. The scene's label and cue will display. Press or
click on the scene to select it.

Scenes can also be recalled by using the direct selects. See Scenes on Direct Selects (below) for more
information.

Scenes on Direct Selects

Scenes (on the previous page) can be selected from the direct selects. From the direct selects display,
press {Select} and then {Scenes} to view your scenes on the direct selects. The direct select will show the
scene's label and cue.

Act 1 Act 2

(1/1) (1/5)

Pressing a scene direct select will post the cue number associated with that scene as a terminated com-
mand onto the command line.

Double pressing a scene direct select will fire the cue, if {DirSelDbl Clk} has been enabled in
Setup>Desk>Displays.

To post as an unterminated command, hold down [Shift] as you press the direct select.

Go to Cue Options

In previous versions of software, you could only home a cue list toits first cue.You can now home a cue list
toits last cue by using [Shift].

#* [Go to Cue] [Home] [Enter] homes the currently selected cue list to its first cue. [Go to Cue] [x]
[/1 [Home] [Enter] homes a cue list toits first cue.

#+  [Go to Cue] [Shift] [Home] [Enter]homes the currently selected cue list to its last cue.[Go to
Cue] [x] [/]1 [Shift] [Home] [Enter] will take you to the last cue in a cue list.

Command Line Behavior for Cue List Index

The command line while in the Cue List Index now defaults to cue list selection. Previously it would default
to cue selection. The softkeys that display will default to cue list control.
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[Next] and [Last] will select the next or last cue list if no cue list or a cue list but no cue is on the command
line.

When a specific cue is selected, [Next] and [Last] will move through the cues in that same list, and the
softkeys will change to be for a single cue control.

Cues Column in Cue List Index

A column that shows the number of cues in a cue list has been added to the Cue List Index.

Creating and Using Effects

Changes in this section impact the Creating and Using Effects chapter.

Beats Per Minute Sample Change

Previously you had to press [Enter] five times for the console to learn the desired beats per minute (BPM).
Now you can just press [Enter] three times to learn the BPM.

Using About

Changes in this section impact the Using About chapter.

What's New Button

In the [About] display, a {What's New} button has been added. Tap on this button to open
the user documentation on the console. The documentation will open in Tab 100. For 2.4,
the manual supplement is available on the console. E

You can also open the documentation from the Display Management Home Screen by Manual 100
pressing the Manual icon.

[I:f ijl Note: Only one instance of the documentation can be open at a time. ]
o

Texts and Notes in [About] Address

Information stored in the Text 1-10 and the Notes fields in Patch>Database will now display in the [About]
Address table.

[About] Cue Discrete Time/ Delay Column

A new column has been added to the [About] Cue display. The Discrete Time/ Delay column shows all the
channels in that cue that have discrete or delay times.

Allowed Output Addresses in [About]

The default [About] display now shows the Allowed Output Addresses, which is a range or ranges of
addresses that can be assigned to limit the number of output addresses. Allowed Output Addresses is a
setting in the ECU. Go to Settings>Network>Output Protocols>Allowed Output Addresses to make
changes if needed.

jj Note: If you have created ranges for the Allowed Output Addresses, those will display in
[About] as well.

_/
S
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Storing and Using Snapshots

Changes in this section impact the Storing and Using Snapshots chapter.

Snapshot Colors
In the Snapshot Editor, you can assign colors ({Red}, {Green}, or {White}) or {Dark} to a snapshot. {Dark}

assigns no color to the snapshot. The colors will display beside the snapshots name in a direct select,
and/or if that snapshot has been assigned to one of the customizable hardkeys on Eos Ti, Gio, and RPU.

Storing and Using Macros

Changes in this section impact the Storing and Using Macros chapter.

Macro Colors

In the Macro Editor, you can assign colors ({Red}, {Green}, or {White}) or {Dark} to a macro. {Dark}
assigns no color to the macro. The colors will display beside the macro name in a direct select, and/or if
that macro has been assigned to one of the customizable hardkeys on Eos Ti, Gio, and RPU.

v (D D O O

1 Thru 5 @ Full ¢

Macro | Label Target Device Macro Contents

There is also a {Toggle Blink} softkey. By default a customizable hardkey will blink when the macro
assigned to it is running. This softkey will turn off the blinking if it is enabled and a BD will display in the
color column when blinking is disabled.

Target Devices for Macros

suno ( O O O

1 Thru 5 @ Full ¢

Macro | Label Color Mode Target Device Macro Contents

an Red

2 Green
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A macro can have a Target Device assigned to it. This allows a cue to execute a macro only on a certain
console.

The Target Device can be a device name or User ID. These are assigned to a macro in the Macro Display
by using the {Target} softkey and either selecting {Device} and {User}. Pressing {Target} will also display
a list of connected devices and additional target options.

Al Users

All But Me

Backup Only

Master Only

Using Magic Sheets

Changes in this section impact the Using Magic Sheets chapter.

Magic Sheet Display Tools

The display tools for Magic Sheets are now available by either right clicking or double tapping on the Magic
Sheet's tab.

Add View ¥

E Save Screenshot

~ Magic Sheet Browser
& o«
© zwomwn
N
Zoom to Selection
A

Z:/\j) Note: You can click and hold or tap and hold on the Magic Sheet's tab to do a zoom to all of the
Magic Sheet display.

Show Reference Labels
A new display option, Show Reference Labels, has been added to the Magic Sheet Display Tools.

When enabled, referenced record targets (such as presets or palettes) with labels will have their labels dis-
played in the Magic Sheet rather than their target type and number.

[Shift] & [Label] can be used to temporally toggle between views.

Facepanel Shortcuts

Overview

The following is a list of button pushes: single, maintained, or combined. It is highly recommended that you
read and familiarize yourself with this list. For keyboard shortcuts, see Eos Family Hotkeys (on page 30)
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and Element Hotkeys (on page 32).

Displays
#» [Data] (maintained press) - toggles the display to show data living under referenced data. Keep
[Data] depressed to page.
*» [Shift] + [Data] - locks the display to the absolute data display.

»» [Time] (maintained press) - toggles the display to show discrete timing. Keep [Time] depressed to
page.
*+ [Shift] + [Time] - locks the display to discrete time display.

#» [Data] + [Focus Encoder Page] / [Color Encoder Page] etc - to expand/suppress categories on
displays (lon)

*» [Data] + [Parameter Tiles] - to suppress/display individual parameters from the display when not in
summary view (lon)

*» [Params] + [Focus] / [Color] / [Beam] - to expand/suppress categories on displays (Ti/Eos/ Gio)

*» [Params] + Parameter Tiles - to suppress/display individual parameters from the display when not
in summary view (Ti/Eos/Gio)

*+ [Displays] + [Level Wheel] - dim the Littlelites or backlighting/LCDs (as selected by the user).
*» [Displays] [Displays] - resets the CIA to the browser

** [Shift] + [Left], [Shift] + [Right] - move columns

#+ [Shift] + [Up], [Shift] + [Down], [Shift] + [Level Wheel] - resize columns

** [Shift] + [Path)/{Path} - toggles the display to show values behind referenced data

*+ [Shift] + [Select] - reset Display Columns

#» [Shift] + [Tab] - clear all tabs on the current monitor (but keep locked frames) (Does not clear tab 1
and 2)

*» [Shift] + [Tab] [Tab] - clear all tabs on all monitors (but keep locked frames) (Does not clear tab 1
and 2)

** [Shift] + [Tab] [Tab] [Tab] - clear all tabs on all monitors (including locked frames) (does not clear
tab 1 and 2)

*» [Shift] + [Label] (maintained press) - toggles the display between default view of referenced data
and alternate view. Keep Shift depressed to page.

*» [Shift] + [Label] [Shift] + [Label] - double press to lock reference labels on. Press [Shift] + [Label]
again to unlock.

*» [Shift] + [Live/Blind] - advances the displays to the next instance of live or blind
#» [Live] (when already in live) - resyncs the selected cue to the most recently activated cue

** [Blind] (when already in blind) - resyncs the selected cue to the live selected cue (when blind cue
has been changed or when preserve blind cue has been enabled).

** [Flexi] + [Time] - to invoke flexi time view on displays

#+ [Format] + [Level Wheel] - zooms the display in focus

** Left Mouse Button + Scroll - zooms the display in focus on a PC
#» Scroll with two fingers - zooms the display in focus on a Mac

#» [Tab] + [Up/Down Arrow] - cycle workspaces

*» [Tab] + [Left/Right Arrow] - move displays

#+ [Tab] + [number] - open or focus specific displays

Facepanel

#+ [Shift] + [Escape] - to lock and unlock face panel
*» Encoder Paging Keys + [Number] - pages to the desired encoder control page
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#+ [Escape] + Encoder Paging Keys - locks the encoders. Press any encoder page button to unlock.
** [Flexi] + Encoder Paging Key - to invoke flexi encoder states

*+ [Fader Controls] + [Bump Button] - select a fader page on wings

7+ [Fader Page] + Rate Wheel - rolls the selected fader page (Ti/Eos/Gio)

»» [Fader Page] + [number] - select a fader page on integral faders (Ti/Eos/Gio)

#+ [Fader Page] - increments the fader page by (Ti/Eos/Gio)

#* [Shift] + [Fader Page] - decrements the fader page by 1 (Ti/Eos/Gio)

»» [Off] + [Load] - releases control of content, restoring to background and leave cue list with pending
cue intact

# [Release] + [Load] - releases control of content, restoring to background, and resets cue list to top
2+ [Shift] + [Go] or [Shift] + [Back] - cuts the pending cue or the previous cue
2+ [Shift] + [Load] - to remove content from a fader

Operations

»* [At] [Enter] - removes move information from selected channel/parameters.

7+ [Aft] [Af] - set to Level (as defined in Setup).

** [Color] (Encoder page key) + Encoder Movement - hold Color Point while adjusting parameters
#* [Copy To] [Copy to] - posts Move To on the command line.

2+ [Full] [Full] - sets selected channels intensity to “full” and self terminates

** [Label] [Label] - appended to a record target command, clears the current label, this includes show
file labels

?* [Recall From] [Recall From] - posts Recall From Cue to the command line

#+ [Record] [Record] - posts Record Only to the command line.

7+ [Select Active] [Select Active] - Select Active minus submaster contributions

#+ [Shift] + [Select Active] - posts Select Non-Sub Active

7+ [Select Last] - repeats last command line, unterminated; does a loop of last five commands

** [Shift] + [At] - recalls last channel(s) and parameters without terminating; does a loop of last five
commands

** [Shift] + [Enter] - reselects the last command and leaves it unterminated; does a loop of last five
commands

#+ [Shift] + [Block] - posts Intensity Block to the command line
2+ [Shift] + [Clear] - clears the command line
** [Shift] + [Delay] - posts follow

*+ [Shift] + Encoder Paging Key - posts the category to the command line. For beam subcategories,
press Image, Form or Shutter twice to post Beam. (lon/Gio)

7+ [Shift] + Encoder Movement - accesses fine mode

** [Shift] + Encoder Toggle - posts the parameter to the command line (lon)

#+ [Shift] + Gel Tile - cycles through three modes of Brightness

2+ [Shift] + [Full] or [Shift] + [Out] - flash On or Flash Out

»* [Shift] + [+] or [Shift] + [] - +% or-%

# [Shift] + [Highlight] - appends highlight to the current channel selection.

2+ [Shift] + [Parameter] - from the encoder controls, posts the parameter to the command line.
** [Shift] + [Select Last] - posts additional channel selection options to the softkeys

7+ [Shift] + [Sneak] - makes manual data unmanual.

7+ [Shift] + [Update] - shortcut to Save

*+ [Shift] + restore manual channel faders - reset faders to zero without asserting control.
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[Shift] + [Direct Select] - posts DS to the command line without terminating
[Sneak] [Sneak] - releases NPs of selected channels and self terminates
[Timing Disable] + [Go] or + [Back] - cuts the next cue or cuts the last cue

[Thru] [Thru] - [Thru] command accesses only channels displayed in the current flexi-state (unless
the range specified is NOT in the current display). [Thru] [Thru] selects the range regardless of the
flexi mode.

[Trace] [Trace] - forces a previously inactive light to track its new intensity setting backwards
[Undo] - clears an unterminated command line. Otherwise opens undo controls

[Update] + [Sub Bump] - to update a specific submaster

[n] [Af] [/] [/1 [m] [Enter] - sets direct DMX value (m) for channel (n).

[Shift] + [Delay] [Delay] - posts hang to the command line
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Eos Family Hotkeys

To enable Eos functions on Mac Function keys:

#» Open Systems Preferences
** Go into the Keyboard section
#» Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

(T
( i;l Note: Some interational keyboards require “Use Shift Key as Eos Shift” to be disabled in the
~ General section of the ECU Settings. Use Z as shift to access shortcut functions in these cases.
-
Console Key PC Console Key PC Console Key PC
Shortcut List ; Capture Control Alt P Control3
? Clear Backspace FocusFilter Control F
0 0 Clear Command Line Shift Backspace Focus Palette AltF
1 1 Control Alt Backspace | Follow/Hang Shift D
2 2 Clear Label Control Backspace Control Alt D
3 3 Color Filter Control C Format F4
4 4 Color Palette Alt C Control4
5 5 Color Path Control Alt W (Scroller) Frame | Control Alt C
6 6 Copy To C Freeze Control Alt F
7 7 Cue Q Full F
8 8 Cue Only/Track X Go Spacebar
9 9 Data ControlD GoTo Cue Control G
. (decimal) . (decimal) Data Mode Control Shift D Goto CueZero | Control Alt G
- (minus) - (minus) Delay D Group G
+(plus) = Delete Delete Help Alt/
+ Delete (Mac) Fn Delete Highlight \
+% Shift = Displays F9 Control Alt H
Control Alt = Control9 Home Home
+% (Mac) Shift Fn Up Arrow Effect AltE ControlH
-% Shift - Effects Softkeys Alt Shift E Home (Mac) [ Fn Left Arrow
Control Alt - Encoder Display (Gio) Control Alt\ Intensity Block Shift B
-% (Mac) Shift Fn Down Arrow [ Encoder Page Color” Control Alt [ Control Alt B
/ / Encoder Page Focus” Control Alt, Intensity Filter Controll
About Y Encoder Page Form» Control Alt; Intensity Palette Alt
Address/Dimmer Alt A Encoder Page Image” Control Alt] Label/Note L
AlINPs ControlN Encoder Page Intensity Alt . Last Page Up
Assert ControlW Encoder Page Shutter” Alt, Control,
Assert (Playback) Control Alt A Enter Enter Last (Mac) Fn Up Arrow
At A Escape Escape Learn Alt L
@ Expand F5 Level \
* Control 5 Live F1
Beam Filter ControlB Fader Pages Control P Control 1
Beam Palette AltB Fan W Load Control Alt L
Blind F2 FlexiChannel F3 Macro M
Control 2 Macro801* | Control Alt 1
Block B Macro 802* | Control Alt 2
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Console Key PC Console Key PC Console Key PC
Macro 803* Control Alt 3 Record R Update u
Macro 804* Control Alt 4 RecordOnly ControlR Virtual Keyboard [ ControlK
Macro 805* Control Alt 5 Release Control Alt S Workspace Jor[
Macro 806* Control Alt 6 Rem Dim H
Macro 807* Control Alt 7 Scroll Lock F6 Shell Shortcut
Macro 808* Control Alt 8 Control 6 Shell Key PC
Macro 809* Control Alt 9 Select Control Enter 0 0
Macro 810* Control Alt 0 Select Active Control A 1 1
Magic Sheet Alt M Select Last ControlL 2 2

Manual Override Control Alt M Select Manual ControlM 3 3
Control Alt N Setup AltS 4 4
Mark K Shift Z 5 5
Mirror, Start Alt F1 Snapshot Control S 6 6
Mirror, Stop Alt F2 Sneak N 7 7
ML Controls F7 Softkey 1 Alt 1 8 8
Control 7 Softkey 2 Alt 2 9 9
More Softkeys Alt 7 Softkey 3 Alt 3 . (decimal) . (decimal)
Next Page Down Softkey 4 Alt 4 - (minus) - (minus)
Control. Softkey 5 Alt5 +(plus) =
Next (Mac) Fn Down Arrow Softkey 6 Alt6 / /
Off Control Alt O | Spacebar Disable Alt G Arrow, Down | Arrow, Down
Offset ControlO Stop/Back Control Spacebar Arrow, Left Arrow, Left
Out 0] Control Alt Q Arrow, Right | Arrow, Right
Page Left Left Arrow Stop Effect Control Alt E Arrow, Up Arrow, Up
Page Right Right Arrow Control Alt K Back Esc
Page Up Up Arrow Submaster S Clear Backspace
Page Down Down Arrow Tab Tab Delete Delete
Parameters (Display) ControlD Time | Enter Enter
Park Alt K Time (Displays) Shift | Escape Esc
Part P Control Alt | Select Return
Patch 0 Timing Disable Control Alt T
Pixelmap Alt X Toggle Hotkeys F8
Preset Alt P Control 8
Query ControlQ Trace J
Rate Control AltR Thru T
Recall From E Undo Control X

*Some Shortcut Key combinations are not available on all physical keyboard layouts.

MAlternatively use Encoder Display + category to change the encoder pages.
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Element Hotkeys

To enable Eos functions on Mac Function keys:

#» Open Systems Preferences
** Go into the Keyboard section
#» Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

(T
( i;l Note: Some interational keyboards require “Use Shift Key as Eos Shift” to be disabled in the
~ General section of the ECU Settings. Use Z as shift to access shortcut functions in these cases.

-

Console Key PC Console Key PC Console Key PC
Shortcut List ; Clear Command Line Shift Backspace Help Alt/
? Control Alt Backspace Home Home
0 0 Clear Label Control Backspace ControlH
1 1 Color Filter Control C Home(Mac) | Fn Left Arrow
2 2 Color Palette Alt C Intensity Filter Controll
3 3 Color Path Control Alt W Intensity Palette Alt
4 4 Copy To C Label/Note L
5 5 Cue Q Last Page Up
6 6 Cue Only/Track X Control,
7 7 Data Control D Last (Mac) Fn Up Arrow
8 8 Data Mode Control Shift D Learn Alt L
9 9 Delay D Level \
. (decimal) . (decimal) Delete Delete Live F1
- (minus) - (minus) Delete (Mac) Fn Delete Control 1
+(plus) = Displays F9 Load Control Alt L
+ Control9 Macro M
+% Shift = Effect Alt E Macro 801* Control Alt 1
Control Alt = Macro 802* Control Alt 2
+% (Mac) Shift Fn Up Arrow Enter Enter Macro 803* Control Alt 3
-% Shift - Escape Escape Macro 804* Control Alt 4
Control Alt - Expand F5 Macro 805* Control Alt 5
-% (Mac) Shift Fn Down Arrow Control 5 Macro 806* Control Alt 6
/ / FlexiChannel F3 Macro 807* Control Alt 7
About Y Control 3 Macro 808* Control Alt 8
Address/Dimmer Alt A FocusFilter Control F Macro 809* Control Alt 9
AlINPs ControlN Focus Palette AltF Macro 810* Control Alt 0
At A Follow Shift D Magic Sheet AltM
@ Control Alt D Manual Override | Control Alt M
* Format F4 Control Alt N
Beam Filter Control B Control4 Mirror, Start Alt F1
Beam Palette Alt B (Scroller) Frame Control Alt C Mirror, Stop Alt F2
Blind F2 Full F ML Controls F7
Control 2 Go Spacebar Control 7
Block B GoTo Cue Control G More Softkeys Alt7
Capture Control Alt P Goto CueZero Control Alt G Next Page Down
Clear Backspace Group G Control.
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Console Key PC Console Key PC Shell Shortcut
Next (Mac) Fn Down Arrow Snapshot Control S Shell Key PC
Offset Control O Sneak N 0 0
Out o] Softkey 1 Alt 1 1 1
Page Left Left Arrow Softkey 2 Alt 2 2 2
Page Right Right Arrow Softkey 3 Alt 3 3 3
Page Up Up Arrow Softkey 4 Alt 4 4 4
Page Down Down Arrow Softkey 5 Alt5 5 5
Parameters(Display) ControlD Softkey 6 Alt6 6 6
Park Alt K Spacebar Disable Alt G 7 7
Part P Stop/Back Control Spacebar 8 8
Patch W Control Alt Q 9 9
Rate Control AltR Stop Effect Control Alt E . (decimal) . (decimal)
Recall From E Control Alt K - (minus) - (minus)
Record R Submaster S +(plus) =
RecordOnly ControlR Tab Tab /
Release Control Alt S Time | Arrow, Down | Arrow, Down
Rem Dim H Timing Disable Control Alt T Arrow, Left Arrow, Left
Scroll Lock F6 Toggle Hotkeys F8 Arrow, Right | Arrow, Right
Control 6 Control 8 Arrow, Up Arrow, Up
Select Control Enter Thru T Back Esc
Select Active Control A Undo Control X Clear Backspace
Select Last ControllL Update u Delete Delete
Select Manual ControlM Virtual Keyboard ControlK Enter Enter
Setup AltS Workspace Jor|[ Escape Esc
Shift Z Select Return

*Some Shortcut Key combinations are not available on all physical keyboard layouts.
MAlternatively use Encoder Display + category to change the encoder pages.
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Welcome

This document is supplemental to information in the Eos Titanium, Eos, and Gio v2.0 Operations Manual,
lon v2.0 Operations Manual, and Element v2.1 User Manual, and should be used in conjunction with it.

Channel Selection

In previous versions of software, selecting channels from either the Summary or Table displays would
append the newly selected channels to existing channels if there was a completed command line.
Now selecting channels from either of those displays will start a new command line.

Emergency Mark

In Setup>Desk Settings>Record Defaults, {Emergency Mark} has been added.

{Emergency Mark} can be used to automatically set a mark flag if you had not previously done so. If using
{Earliest M} and no cue with a mark flag has already been set, {Emergency Mark} will set a mark flag.

{Emergency Mark} can be set to either Earliest or Latest. Latest is the default setting.

#+ If set to Earliest, {Emergency Mark} will set the mark flag on the earliest cue after the cue which
fades the intensity out for the selected channel.

#» If set to Latest, {Emergency Mark} will not set a mark flag. It will instead create a broken mark,
which will display an x in the previous cue in the Playback Status Display.

Step Times and Parameters Added to Absolute Effects

A column for step times has been added to the Absolute effects editor display.

Action Param

1

Default step times will display in gray and in parentheses, and assigned step times will display in white
without parentheses.

[ j;l Note: The default step time is the time value plus the dwell value. }
S

London, UK = Tel +44 (0)20 8896 1000 = Service: (UK) service@etceurope.com
Rome, ITuTel +39(06) 32 111 683 m Service: (UK) service@etceurope.com
Holzkirchen, DE m Tel +49 (80 24) 47 00-0 m Service: (DE) techserv-hoki@etcconnect.com
Hong Kong = Tel +852 2799 1220 m Service: (Asia) service@etcasia.com
Web: www.etcconnect.com m © 2016 ETC. All Rights Reserved. m Product information and specifications subject to change.
4250M1211-2.3.3 m A m Released 2016-01 m ETC intends this document to be provided in its entirety.

- Corporate Headquarters m Middleton, WI, USA m Tel +608 831 4116 m Service: (Americas) service@etcconnect.com
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If no step time has been assigned, the step will begin once the fade and dwell times for the previous step
have completed. If a step time has been assigned, the next step will begin after that set amount of time has
elapsed.

You can also now define specific parameters for Absolute effect actions. To apply a parameter to a specific
action, click in the Param column and select the desired parameter.

sACN Universes

Eos now allows you to use any sACN universes from 1-63,999. You can assign the starting offset in
ECU>Settings>Network>Output Protocols.

Port 1 Default

Priority: 100 SACN Start Release Version

[@ Note: InPatch, you will still use universe numbers 1 to 128 for patching. ]

Z:/ i Note: The number of universes that can be used at a time is still limited to a block of 128 con-
tiguous universes.

Installer Archive

Eos has implemented an installer archive, which saves selected installers directly onto the console's local
hard drive. You can now save multiple software versions onto your console's hard drive in case you wish to
downgrade.

J) Note: Onnew consoles, some versions are preselected to be archived when it initially ships

from ETC. This includes the version of software that is currently installed from the factory as well
as any patches to that version (if available). For future release, you will need to download the Eos
Family software from the ETC website, www.etcconnect.com.

When the software update window (ECU> Settings>General> Software Update) launches, it will show
you all available Eos software versions found on an attached USB drive and/or locally stored on the con-
sole's hard drive.

Software Update

If there is an available update and you want to install it, follow the steps for updating the console's soft-
ware.

While installing the software, you can also archive the installer used. Check the Archive Installer box for
the selected version, and it will archive while installing the software. If you would like to archive installers
without installing their software, you can do that by using the File Manager utility in ECU>Set-
tings>Maintenance.

You can also retrieve these versions from the archive to save them to a USB drive by using the File Man-
ager.

Release notes for any newer version can be found on www.etcconnect.com.
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Show Control Indicators in the Playback Status Display

If any show control options are currently enabled in Setup>Show>Show Control, they will display in the
top right corner of the Playback Status Display (PSD).

11:42:29 PM

String RX Analog TX/RX

Rate Label

Virtual Alphanumeric Keyboard

The virtual alphanumeric keyboard, which displays when you are labeling, now has a {Sym} button. Press
{Sym} to switch the keyboard from alphanumeric to symbols. When in symbol mode, press {Abc} to return
to the alphanumeric keyboard.

Workspace Access From the Command Line

A {Workspace} softkey is available by pressing [Displays]. Press {Workspace} and then type 1, 2, or 3 to
go to that workspace.

From an alphanumeric keyboard, the [ button or the ] button can be used to select the {Workspace}
softkey, and then type in the number of the workspace you wish to view.

Go to Cue Out and Solo Mode

The [Go to Cue] [Out] command will not affect a cue list that is in solo mode.

[Shift] + [Highlight]

On a command line with a channel selection, you can use [Shift] + [High]( on lon use {Highlight}) to go
into Highlight mode and send the selected channels to the default Highlight setting. This command will self
terminate the command line.

If you just use [High] or {Highlight}, the command line will be cleared.

{In Use} Flexi State

A new flexi state of {In Use} has been added. {In Use} shows intensities that are above 0 or fading to 0,
running effects, non-intensity moves, and any channels marking.

Fixture Library and Software Updates
{Software Update} under ECU>Setting>General will now recognize .zip files provided by ETC, which
contain either fixture library files or software update executable files.

Fixture library update files will now be distributed as a .zip file, which can be installed on Eos Family con-
soles, ETCnomad PC, and ETCnomad Mac devices.

London, UK = Tel +44 (0)20 8896 1000 = Service: (UK) service@etceurope.com
Rome, ITuTel +39(06) 32 111 683 m Service: (UK) service@etceurope.com
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Updating with a .zip file
1. Select the desired .zip file from the Software Update window.

2. You will be asked to confirm that you want to install the selected file. Click {Yes} to continue or click
{No} or {Cancel} to return to the Software Update window.

3. A window will open showing the progress of extracting the .zip file. The installer will then launch
after the file has been extracted.

Backup and Restore System Settings

The ability to backup and restore all of the ECU system settings, including Net3 services, has been added
to the ECU.{Backup System Settings}and {Restore System Settings} is found in ECU>Maintenance.

Restare Show Archive...

Backup System Settings...

—
Restt istem Settings..

This is useful for sharing settings between consoles, including ETCnomad.

Backup System Settings

{Backup System Settings} will open a window that allows you to save .ini file to a selected drive. To
backup settings, select a drive from the drop down menu, and press {Accept} to save or {Cancel} to exit
without saving.

Backup System Settings
Please select a drive to backup system settings to...
TECHCOMMGS (E:\) (E:\ - 11 Gb free) ~

‘.
Accept 1 Cancel
|

Restore System Settings

{Restore System Settings} will open a window that allows you to select a saved.ini file.Select the desired
file and press {Ok} to restore settings. Press {Cancel} to close the window without restore settings.
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Enable RDM

RDM can be enabled for each local DMX port on a console or a Gadget by going into ECU>Set-
tings>Local 1/0. By default, RDM is disabled. To enable, click in the box to the right of the RDM label.

Console IfO Car
Port 1 Addre l:‘ Doubled l:‘ Speed Maximum

Port 2 Addre

[About] Library Data
A {Library Data} button has been added to the About Channel display. This button is also available in the
About Address display.
{Library Data} displays information found in the fixture library such as:
# Revision Number
» Release Date

# Alternate Names
# Usage Notes

Effect List Navigation
Using the [Next)/ [Last] keys will now only move between effects in the effect list display. To navigate the
effect editor, you will need to use the page arrow keys.

You can use [Page dJor [Page P] when in the effect list display to begin navigating in the effect editor.
This only works for step or absolute effects. You can press [Escape] to return focus to the effect list dis-

play.

+ After Color Path

When multiple channels are selected that have different color paths assigned to them, a + will display by
the color path name in the color path preview bar.

1Oy

Show Gels

Two new options have been added to the gel picker. You can either select {Show Gels as Gel Against
White Background} or {Show Gels as Gel + Lamp Output}. The button toggles between the two
options.
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Brightest Brightest

Sort Hue Sort Hue

Similar

A

oW gels as gel + lamp output

Similar

Show Show

7+ {Show Gels as Gel Against White Background} displays the raw gel color as it would look
against a white background.

7+ {Show Gels as Gel + Lamp Output} displays the gel swatch color as if it was being used with a
tungsten lamp.

Double Tap {Address} for Patch
Double tapping the {Address} softkey will now open the Patch display on lon.

Artnet and sACN Offset Displayed
The Artnet and sACN offset will display in Patch if they are above 0.

Interface

Preserve Native
Disabled

Move To

Changes have been made to how Move To works in Patch.

# [1] [Copy To] [Copy To] [2] - moves channel 1's data to channel 2. Channel 2's data is replaced by
channel 1's. Channel 1 is unpatched.

# [M][Copy To] [Copy To] [2][Part][2] - creates a part 2 for channel 2 and moves channel 1's data to
the new part. Channel 2's data remains in part 1. Channel 1 is unpatched.

Search

A search option has been added to the patch fixture library.

Eos Family Operations Manual Supplement 4 Electronic Theatre Contrals, Inc.



ETC Supplement

Eos Family v2.3.2

+ Anclis
* ETC Fixtures
Outsight

Press {Search} to open the search window. You can search by manufacturer name, fixture name, part of a
name (example shown in the above screenshot), and by DMX footprint. You can also navigate the list as

you would the browser.

For example, if you searched for 31, you would see all of the fixtures that have a DMX footprint of 31.

Double clicking on a fixture name will patch it.

Updating a Single Monitor Snapshot

A single monitor snapshot can be updated or deleted by right clicking on its icon in the Snapshot area of the

Display Controls screen.

>

Snapshot 1

Update Snapshot

Delete

Color Coding of Direct Selects

The direct selects are now color coded.

Focus Color Beam
Palettes Palettes Palettes

Channels Groups Palett Y

The colors used are:

#» Channels - Blue

*» Groups - Slate

#+ Intensity Palettes - Yellow
*» Focus Palettes - Green

Magic

Macros Effects Snapshots Sheats

#+ Color Palettes - Gray (A color swatch will display in the lower left hand corner if enabled in the direct

selects configuration menu.)
** Beam Palettes - Royal Blue
*» Presets - Aqua
** Macros - Brown
#+ Effects - Purple
*» Snapshots - Red
#» Magic Sheets - Magenta
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When the direct select is chosen and on the command line, it will have a gold border around it. If content is
available for selected channels, the tile is highlighted. An unrecorded direct select will have a dark back-
ground with dark gray text.

devire || e | | e
green
h 1 2 h 3 h 4

Z:/\j) Note: To adjust the brightness of the direct selects, use the Color Brightness slider in Setup.
When the slider is set to 0, the color coding is removed. See Color Brightness (below) for more
information.

Color Brightness

You can adjust the brightness of the color coding and color swatch used for the Direct Selects. This is done
by going to Setup>Desk Settings>Brightness Settings. Use the slider for Color Brightness to adjust the
color coding of the direct select and the color palette direct select color swatch's brightness.

If the slider is set to 0, the color coding for the direct selects is removed.

Facepanel Shortcuts

Overview

The following is a list of button pushes: single, maintained, or combined. It is highly recommended that you
read and familiarize yourself with this list. For keyboard shortcuts, see Eos Family Hotkeys (on page 9)
and Element Hotkeys (on page 11).

Displays

o

* [Data] (maintained press) - toggles the display to show data living under referenced data. Keep
[Data] depressed to page.

** [Shift] + [Data] - locks the display to the absolute data display.

# [Time] (maintained press) - toggles the display to show discrete timing. Keep [Time] depressed to
page.
7+ [Shift] + [Time] - locks the display to discrete time display.

*+ [Data] + [Focus Encoder Page] / [Color Encoder Page] etc - to expand/suppress categories on
displays (lon)

»* [Data] + [Parameter Tiles] - to suppress/display individual parameters from the display when not in
summary view (lon)

»» [Params] + [Focus] / [Color] / [Beam] - to expand/suppress categories on displays (Ti/Eos/ Gio)

#+ [Params] + Parameter Tiles - to suppress/display individual parameters from the display when not
in summary view (Ti/Eos/Gio)

7+ [Displays] + [Level Wheel] - dim the Littlelites or backlighting/LCDs (as selected by the user).
[Browser] button on Element

*+ [Displays] [Displays] - resets the CIA to the browser

** [Shift] + [Left], [Shift] + [Right] - move columns

2+ [Shift] + [Up], [Shift] + [Down], [Shift] + [Level Wheel] - resize columns

#* [Shift] + [Path]/{Path} - toggles the display to show values behind referenced data
7+ [Shift] + [Select] - reset Display Columns
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#+ [Shift] + [Tab] - clear all tabs on the current monitor (but keep locked frames) (Does not clear tab 1
and 2)

#» [Shift] + [Tab] [Tab] - clear all tabs on all monitors (but keep locked frames) (Does not clear tab 1
and 2)

*» [Shift] + [Tab] [Tab] [Tab] - clear all tabs on all monitors (including locked frames) (does not clear
tab 1 and 2)

** [Shift] + [Label] (maintained press) - toggles the display between default view of referenced data
and alterate view. Keep Shift depressed to page.

*» [Shift] + [Live/Blind] - advances the displays to the next instance of live or blind
#+ [Live] (when already in live) - resyncs the selected cue to the most recently activated cue

*» [Blind] (when already in blind) - resyncs the selected cue to the live selected cue (when blind cue
has been changed or when preserve blind cue has been enabled).

*» [Flexi] + [Time] - to invoke flexi time view on displays

** [Format] + [Level Wheel] - zooms the display in focus

#» Left Mouse Button + Scroll - zooms the display in focus ona PC
*» Scroll with two fingers - zooms the display in focus on a Mac

#+ [Tab] + [Up/Down Arrow] - cycle workspaces

*» [Tab] + [Left/Right Arrow] - move displays

*» [Tab] + [number] - open or focus specific displays

Facepanel

*+ [Shift] + [Escape] - to lock and unlock face panel

#» Encoder Paging Keys + [Number] - pages to the desired encoder control page

*» [Escape] + Encoder Paging Keys - locks the encoders. Press any encoder page button to unlock.
#+ [Flexi] + Encoder Paging Key - to invoke flexi encoder states

*» [Fader Controls] + [Bump Button] - select a fader page on wings

*» [Fader Page] + Rate Wheel - rolls the selected fader page (Ti/Eos/Gio)

#+ [Fader Page] + [number] - select a fader page on integral faders (Ti/Eos/Gio)

*» [Fader Page] - increments the fader page by (Ti/Eos/Gio)

*+ [Shift] + [Fader Page] - decrements the fader page by 1 (Ti/Eos/Gio)

#» [Off] + [Load] - releases control of content, restoring to background and leave cue list with pending
cueintact

*» [Release] + [Load] - releases control of content, restoring to background, and resets cue list to top
*» [Shift] + [Go] or [Shift] + [Back] - cuts the pending cue or the previous cue
#+ [Shift] + [Load] - to remove content from a fader

Operations

#» [At] [Enter] - removes move information from selected channel/parameters.

*» [Af] [At] - set to Level (as defined in Setup).

#+ [Color] (Encoder page key) + Encoder Movement - hold Color Point while adjusting parameters
** [Copy To] [Copy to] - posts Move To on the command line.

¥ [Full] [Full] - sets selected channels intensity to “full” and self terminates

#+ [Label] [Label] - appended to a record target command, clears the current label, this includes show
file labels

#» [Recall From] [Recall From] - posts Recall From Cue to the command line
** [Record] [Record] - posts Record Only to the command line.
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7+ [Select Active] [Select Active] - Select Active minus submaster contributions
2+ [Shift] + [Select Active] - posts Select Non-Sub Active
*+ [Select Last] - repeats last command line, unterminated; does a loop of last five commands

2+ [Shift] + [At] - recalls last channel(s) and parameters without terminating; does a loop of last five
commands

#+ [Shift] + [Enter] - reselects the last command and leaves it unterminated; does a loop of last five
commands

#* [Shift] + [Block] - posts Intensity Block to the command line
#+ [Shift] + [Clear] - clears the command line
2+ [Shift] + [Delay] - posts follow

** [Shift] + Encoder Paging Key - posts the category to the command line. For beam subcategories,
press Image, Form or Shutter twice to post Beam. (lon/Gio)

»* [Shift] + Encoder Movement - accesses fine mode

7+ [Shift] + Encoder Toggle - posts the parameter to the command line (lon)

#* [Shift] + Gel Tile - cycles through three modes of Brightness

»* [Shift] + [Full] or [Shift] + [Out] - flash On or Flash Out

#* [Shift] + [+] or [Shift] + [-] - +% or-%

** [Shift] + [Highlight] - appends highlight to the current channel selection.

7+ [Shift] + [Parameter] - from the encoder controls, posts the parameter to the command line.
#* [Shift] + [Select Last] - posts additional channel selection options to the softkeys

** [Shift] + [Sneak] - makes manual data unmanual.

7+ [Shift] + [Update] - shortcut to Save

** [Shift] + restore manual channel faders - reset faders to zero without asserting control.
*+ [Shift] + [Direct Select] - posts DS to the command line without terminating

7+ [Sneak] [Sneak] - releases NPs of selected channels and self terminates

** [Timing Disable] + [Go] or + [Back] - cuts the next cue or cuts the last cue

# [Thru] [Thru] - [Thru] command accesses only channels displayed in the current flexi-state (unless
the range specified is NOT in the current display). [Thru] [Thru] selects the range regardless of the
flexi mode.

# [Trace] [Trace] - forces a previously inactive light to track its new intensity setting backwards
7+ [Undo] - clears an unterminated command line. Otherwise opens undo controls

?+ [Update] + [Sub Bump] - to update a specific submaster

# [n][Af] [/1 [/] [m] [Enter] - sets direct DMX value (m) for channel (n).

#* [Shift] + [Delay] [Delay] - posts hang to the command line
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Eos Family Hotkeys

To enable Eos functions on Mac Function keys:

#*  Open Systems Preferences
** Go into the Keyboard section
** Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

—
( j;,l Note: Some international keyboards require “Use Shift Key as Eos Shift” to be disabled in the
~ General section of the ECU Settings. Use Z as shift to access shortcut functions in these cases.

.

Console Key PC Console Key PC Console Key PC
Shortcut List ; Capture Control Alt P Control 3
? Focus Filter Control F
0 0 Clear Backspace Focus Palette Alt F
1 1 Clear Command Line Shift Backspace Follow/Hang Shift D
2 2 Control Alt Backspace Control Alt D
3 3 Color Filter Control C Format F4
4 4 Color Palette Alt C Control4
5 5 Color Path Control Alt W (Scroller) Frame | Control Alt C
6 6 Copy To C Freeze Control Alt F
7 7 Cue Q Full F
8 8 Cue Only/Track X Go Spacebar
9 9 Data ControlD GoTo Cue Control G
. (decimal) . (decimal) Data Mode Control Shift D Goto CueZero | Control Alt G
- (minus) - (minus) Delay D Group G
+(plus) = Delete Delete Help Alt/
+ Delete (Mac) Fn Delete Highlight \
+% Shift = Displays F9 Control Alt H
Control Alt = Control9 Home Home
+% (Mac) Shift Fn Up Arrow Effect Alt E ControlH
-% Shift - Effects Softkeys Alt Shift E Home (Mac) [ Fn Left Arrow
Control Alt - Encoder Display (Gio) Control Alt\ Intensity Block Shift B
-% (Mac) Shift Fn Down Arrow | Encoder Page Color” Control Alt [ Control Alt B
/ / Encoder Page Focus” Control Alt, Intensity Filter Control |
About Y Encoder Page Form~ Control Alt ; Intensity Palette Alt |
Address/Dimmer Alt A Encoder Page Image” Control Alt ] Label/ Note L
AlINPs ControlN Encoder Page Intensity” Alt. Last Page Up
Assert ControlW Encoder Page Shutter” Alt, Control,
Assert (Playback) Control Alt A Enter Enter Last (Mac) Fn Up Arrow
At A Escape Escape Learn Alt L
@ Expand F5 Level \%
* Control 5 Live F1
Beam Filter Control B Fader Pages Control P Control 1
Beam Palette AltB Fan W Load Control Alt L
Blind F2 FlexiChannel F3 Macro M
Control 2 Macro801* | Control Alt 1
Block B Macro 802* | Control Alt 2

Eos Family Operations Manual Supplement

Electronic Theatre Controls, Inc.




ETC Supplement

Eos Family v2.3.2

Console Key PC Console Key PC Console Key PC
Macro 803* Control Alt 3 Record R Update u
Macro 804* Control Alt 4 RecordOnly ControlR Virtual Keyboard [ Control K
Macro 805* Control Alt 5 Release Control Alt S Workspace Jor|
Macro 806* Control Alt 6 Rem Dim H
Macro 807* Control Alt 7 Scroll Lock F6 Shell Shortcut
Macro 808* Control Alt 8 Control6 Shell Key PC
Macro 809* Control Alt 9 Select Control Enter 0 0
Macro 810* Control Alt O Select Active Control A 1 1
Magic Sheet Alt M Select Last ControllL 2 2

Manual Override Control Alt M Select Manual ControlM 3 3
Control Alt N Setup AltS 4 4
Mark K Shift z 5 5
Mirror, Start Alt F1 Snapshot Control S 6 6
Mirror, Stop Alt F2 Sneak N 7 7
ML Controls F7 Softkey 1 Alt 1 8 8
Control7 Softkey 2 Alt 2 9 9
More Softkeys Alt 7 Softkey 3 Alt 3 . (decimal) . (decimal)
Next Page Down Softkey 4 Alt 4 - (minus) - (minus)
Control. Softkey 5 Alt5 +(plus) =
Next (Mac) Fn Down Arrow Softkey 6 Alt6 / /
Off Control Alt O | Spacebar Disable Alt G Arrow, Down | Arrow, Down
Offset ControlO Stop/Back Control Spacebar Arrow, Left Arrow, Left
Out 0 Control Alt Q Arrow, Right | Arrow, Right
Page Left Left Arrow Stop Effect Control Alt E Arrow, Up Arrow, Up
Page Right Right Arrow Control Alt K Back Esc
Page Up Up Arrow Submaster S Clear Backspace
Page Down Down Arrow Tab Tab Delete Delete
Parameters (Display) Control D Time I Enter Enter
Park Alt K Time (Displays) Shift | Escape Esc
Part P Control Alt | Select Return
Patch 0 Timing Disable Control Alt T
Pixelmap Alt X Toggle Hotkeys F8
Preset Alt P Control 8
Query ControlQ Trace J
Rate Control AltR Thru T
Recall From E Undo Control X

*Some Shortcut Key combinations are not available on all physical keyboard layouts.
MAlternatively use Encoder Display + category to change the encoder pages.
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Element Hotkeys

To enable Eos functions on Mac Function keys:

#*  Open Systems Preferences
** Go into the Keyboard section
** Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

—
( j;,l Note: Some international keyboards require “Use Shift Key as Eos Shift” to be disabled in the
~ General section of the ECU Settings. Use Z as shift to access shortcut functions in these cases.
.
Console Key PC Console Key PC Console Key PC
Shortcut List ; Clear Command Line Shift Backspace Help Alt/
? Control Alt Backspace Home Home
0 0 Color Filter Control C ControlH
1 1 Color Palette Alt C Home (Mac) | Fn Left Arrow
2 2 Color Path Control Alt W Intensity Filter Control |
3 3 Copy To C Intensity Palette Alt |
4 4 Cue Q Label/Note L
5 5 Cue Only/Track X Last Page Up
6 6 Data ControlD Control,
7 7 Data Mode Control Shift D Last (Mac) Fn Up Arrow
8 8 Delay D Learn AltL
9 9 Delete Delete Level \%
. (decimal) . (decimal) Delete (Mac) Fn Delete Live F1
- (minus) - (minus) Displays F9 Control 1
+(plus) = Control9 Load Control Alt L
+ Effect Alt E Macro M
+% Shift = Macro 801* Control Alt 1
Control Alt = Enter Enter Macro 802* Control Alt 2
+% (Mac) Shift Fn Up Arrow Escape Escape Macro 803* Control Alt 3
-% Shift - Expand F5 Macro 804* Control Alt 4
Control Alt - Control5 Macro 805* Control Alt 5
-% (Mac) Shift Fn Down Arrow Macro 806* Control Alt 6
/ / FlexiChannel F3 Macro 807* Control Alt 7
About Y Control3 Macro 808* Control Alt 8
Address/Dimmer Alt A FocusFilter Control F Macro 809* Control Alt 9
AlINPs ControlN Focus Palette AltF Macro 810* Control Alt 0
At A Follow Shift D Magic Sheet AltM
@ Control Alt D Manual Override | Control Alt M
* Format F4 Control Alt N
Beam Filter Control B Control4 Mirror, Start Alt F1
Beam Palette Alt B (Scroller) Frame Control Alt C Mirror, Stop Alt F2
Blind F2 Full F ML Controls F7
Control2 Go Spacebar Control 7
Block B GoTo Cue Control G More Softkeys Alt 7
Capture Control Alt P Goto CueZero Control Alt G Next Page Down
Clear Backspace Group G Control.
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Console Key PC Console Key PC Shell Shortcut
Next (Mac) Fn Down Arrow Snapshot Control S Shell Key PC
Offset Control O Sneak N 0 0
Out 0 Softkey 1 Alt 1 1 1
Page Left Left Arrow Softkey 2 Alt 2 2 2
Page Right Right Arrow Softkey 3 Alt 3 3 3
Page Up Up Arrow Softkey 4 Alt 4 4 4
Page Down Down Arrow Softkey 5 Alt5 5 5
Parameters(Display) Control D Softkey 6 Alt6 6 6
Park Alt K Spacebar Disable Alt G 7 7
Part P Stop/Back Control Spacebar 8 8
Patch N Control Alt Q 9 9
Rate Control Alt R Stop Effect Control Alt E . (decimal) . (decimal)
Recall From E Control Alt K - (minus) - (minus)
Record R Submaster S +(plus) =
RecordOnly ControlR Tab Tab /
Release Control Alt S Time | Arrow, Down | Arrow, Down
Rem Dim H Timing Disable Control At T Arrow, Left Arrow, Left
Scroll Lock F6 Toggle Hotkeys F8 Arrow, Right | Arrow, Right
Control6 Control 8 Arrow, Up Arrow, Up
Select Control Enter Thru T Back Esc
Select Active Control A Undo Control X Clear Backspace
Select Last ControllL Update u Delete Delete
Select Manual ControlM Virtual Keyboard Control K Enter Enter
Setup AltS Workspace Jor[ Escape Esc
Shift z Select Return

*Some Shortcut Key combinations are not available on all physical keyboard layouts.
MAlternatively use Encoder Display + category to change the encoder pages.
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Welcome

This document is supplemental to information in the Eos Titanium, Eos, and Gio v2.0 Operations Manual, lon
v2.0 Operations Manual, and Element v2.1 User Manual, and should be used in conjunction with it.

Additions to Query

Query now has the following buttons:

# {Keywords} - displays buttons for all the text used in the text 1-10 fields and for all of the default
keywords in Patch.

#» {Fixture Types} - displays buttons for all of the fixture types used in the current show file.
# {Gel}-displays all of the gels used in the current show file.

# {Text 1} - {Text 10} - displays only the text used in that text field.

»» Up and Down Arrows - allows paging of the lists.

See also Renaming Text Fields in Patch (page 17) for more information.

Browser Color Coding

The following color coding for selected items has been added to the browser:

# Save - green

** Save As - green
** Open-red

#» Merge - yellow
* New -red

» Clear-red

ket & Cache...)
» Save As...

> Open

> Merge

Corporate Headquarters m Middleton, WI, USA m Tel +608 831 4116 m Service: (Americas) service@etcconnect.com
London, UK = Tel +44 (0)20 8896 1000 m Service: (UK) service@etceurope.com

Rome, IT = Tel +39(06) 32 111 683 m Service: (UK) service@etceurope.com

Holzkirchen, DE m Tel +49 (80 24) 47 00-0 m Service: (DE) techserv-hoki@etcconnect.com

Hong Kong = Tel +852 2799 1220 m Service: (Asia) service@etcasia.com

Web: www.etcconnect.com m © 2015 ETC. All Rights Reserved. m Product information and specifications subject to change.
‘o 4250M1211-2.3.0 m A m Released 2015-07 m ETC intends this document to be provided in its entirety.
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Additional Browser Changes

Previous versions of a showfile will be displayed in dark gray text. To see previous versions of a showfile, you
must click on the arrow to the left of the showfile name or use [Page P].

v Cricket & Cache 2013-11-16 04-16-17.esf

Crick

File folders now display with a folder icon beside their name.

¥ Save As...

> Show File Archive

> Max Touch (F:\)

> TECHCOMMGS (E:\)

Channels in Use

A Channels in Use display has been added. It displays the following information for each channel:

»» Number of cue lists the channel appears in.

#* Number of cues the channel appears in.

»» Number of cue moves from zero.

** Number of submasters that channel appears in.
»  Maximum channel level

To open the Channels in Use display, click on the {CIU} icon in the home screen or press [Tab] + [3][2].

-

CIU

Playback Status Display FX Column
Effects are no longer displayed in the External Links column, instead they will be shown in the FX column.

Int Down Focus Color Beam Dur MBAP'Q v FwfHg Link Loop Curve Rate Label

5 5 5 25 200

scenel

Editing Labels

The page arrow keys on the console or an external alphanumeric keyboard can be used to move the cursor
within a label to aid in editing.

gt

* [Page A]-takes the cursor to the beginning of the label.
* [Page V] - takes the cursor to the end of the label.

* [Page 4] - moves the cursor to the left.

* [Page P] - moves the cursor to the right.

.
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Virtual Keyboard

The virtual keyboard displays the alphanumeric keyboard shortcut for that hardkey in the lower right hard
corner.

The abbreviations are:

»» Ca-CTRL+ALT H
% S-SHIFT
» C-CTRL
» A-ALT

Address

Use Shift As Eos Shift

In the ECU, {Use Shift as Eos Shift} allows the SHIFT key on an alphanumeric keyboard to be used as the
console's [Shift] key. If not selected, the Z key on an alphanumeric keyboard will function as the [Shift] key.

Restore Default

\_) Note: with 2.3, the Hotkey mapping has changed. Please see Eos Family Hotkeys (page 22)
and Element Hotkeys (page 24).

Effect Attributes

Two new effect attributes are now available that affect how effects run.
Those attributes are:
#» Continuous Run - the effect will keep running until there is a stop effect command. By default,

{Continuous Run} is disabled for all step and absolute effects. Itis enabled by default for relative
effects. See Stop Effects on page 5 for more information.

»* Repeat on Go - previously, effects with a duration or number of cycles would refire when a a new cue
was recorded. Now effects will not restart unless {Repeat on Go} is used.

When an effect with duration is running in a cue, the effect will display in light blue while it is running and dark
blue when it has finished. This is only displayed in the Live Summary View.

Light Dark
Blue Blue
When  When
Effect  Effect
is has
Running Finished
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Effect Background Value Modification

For Step and Absolute effects, you can use [+], [-], and [/] to adjust the background value .

\_) Note: When using [-] you will need to preface the command with [+] if you want to remove from
the current value.

For Example:

» Effect 1is a step effect with the on state set to 100 and the off state set to - 50% for all steps. To set the
step off state to -50%, you would use the following syntax [Effect][1] [Step] [1] {Offstate} [+] [-] [/]
[5] <0> [Enter]. If the channels in the effect have a background value of 50, the off state for each step
would be 25.

% Effect 2 is an absolute effect. To set a level at + 20 of the background, you would use the following syn-
tax, [Effect][2] {Action} [1] {Level} [+] [2]<0> [Enter]. If the channels in the effect have a back-
ground value of 50, the level 1 in the effect would be at 70.

Effect Status Display

The properties of an effect that can be modified at a cue or sub level have been extended. The new properties
are displayed at the bottom of the Effect Status display and in the channel effects screen (which is access by
pressing [Shift] + [Effect]).

Several color indicators are used in the Effect Status Display. Those colors and their meanings are:

» Grey - property is drawn directly from the effect.
7 Red - property has been manually modified but not stored.
?* Blue - property is an override to the saved effect.
7 Magenta - property is tracking from a previous cue.
From the Effect Attribute Override display, you can access most of the same properties as those found in the

Effect Editor. This display allows you to make modifications to properties, and store those modificationsin a
cue or submaster. Click on a column to make changes from a list of available options.

se 8/2 : Effect 1 Attributes _

A new effect attribute, {Restart Effect}, has been added that can only be accessed from this display. When
enabled, {Restart Effect} will cause an effect to restart whenever the cue is fired. This attribute is applied to
the cue that the effect is stored in and not in the effect itself.

\_) Note: {Repeat on Go} s similar to {Restart Effect} but it is applied to the effect. For more inform-
ation on {Repeat on Go}, see Effect Attributes on page 3.
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Effects In Presets

Effects can be stored in a preset, and those presets can be used to create submasters and cues. However, the
effect's data is only copied to the submaster or cue, it is no longer referenced through the preset.

Z:\j) Note: If used with submasters and cues, the data is not referenced. So if changes are made to the
effectin the preset, the effect saved to the submasters and cues will remain unchanged.

The preset list display has a new column for effects.

Query and Group Effect
You can use [Query] [Effect] [n], [Query] [Effect], and [Group] [Effect] [n] to select the channels currently
running in the selected effect.

Using [Query] will select the channels in numeric order. [Group] will select the channels in the order that they
were originally selected.

[Query] [Effect] will select all channels currently running effects.
For Example:

» [31[1] + [2][6] + [31[0] +[2][7] + [2][9] + [2][8] [Effect] [1] [Enter]

Using [Query] [Effect] [1] will select the channels currently running effect 1. Using [Next], the channels will
be selected in numeric order starting with channel 26.

Using [Group] [Effect] [1] will select the channels currently running effect 1. However, pressing [Next], the
channels will be selected in the order they were originally selected. In this example, channel 31 would be first,
then channel 26.

1j) Note: [Group] [Effect] [n] was previously used as an alternate to [Recall From]. This is no longer
the case.

Replace With

{Replace With} allows you to replace an effect with another one. All overrides will be preserved.

»+ [Effect] [1] {Replace With} <Effect> [2] - all channels that were running effect 1 will now be running
effect 2.

Size for Step and Absolute Effects

Size is now an option for Step and Absolute effects.
For Example:

Effect 1is a step effect with the On State set to 50 and the Off State setto 10. If Size is set to 50, the On State
will be setto 50% of 50 and the Off State will be 50% of 10. So On would be 25 and Off would be 5.

Stop Effects

A [Stop Effect]/{Stop Effect} command can now be assigned to a list of channels in a cue without an effect
tracking into it or to a list of channels in a submaster.

#» <channel> [1] [Stop Effect]/{Stop Effect} [Enter] - will create a stop effect instruction for all selected
parameters, if there isn't an effect running on any of the parameters.

#» <channel> [1] [Effect] [Enter] - will only stop the currently running effect.

#+ [Effect] [0] [Enter] - will place a stop all flag.
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Manual Control of Non-Intensity Parameters

On Element, non-intensity parameters can now be set by using either the ML Controls or the buttons in the
central information area (CIA).

Parameter Display

The parameter display in the CIA is populated with only those parameters that are found in the patched
devices. As channels are selected, the parameter display will change to show only parameters relevant to the
selected channels.

The parameters are divided into the following categories: Intensity, Focus, Color and Beam. Each parameter
category is represented with buttons in the parameter tiles. These buttons allow you to select the entire col-
lection of all parameters within that category. You can also select a single parameter from a category using
that parameter’s touchbutton in the parameter display.

Al Spoed

2 Print

3 Record Target Lists

Within the CIA, in the upper left corner, notice the {All NPs} button. When pressed, this collects all non-intens-
ity parameters for further editing.

Some examples of using parameter touchbuttons are:

#» [1] {Iris} [5] [Enter] - Places the iris parameter of channel 1at 50%.

» [Group] [4] {Zoom} {Edge} [Out] [Enter] - Sends any zoom and edge values for all fixtures in group 4
10 0%.

» [1] [Thru] [3] {All Speed} [At] [2][5][Enter] - Sets all the available speed parameters for channels 1
through 3 to 25.

Setting Parameters with the Keypad

When the CIA is placed in parameter mode, all parameters of selected channels may be given numeric values
through the keypad.

When no channels are selected, the CIA shows all of the parameters that are available in the lighting system.
When channels are selected, the CIA condenses to show only the parameters that are appropriate to the selec-
tion set. If channels are selected that have different device types, such as spot and wash lights, the CIA will
show all of the available parameters. Parameters that are not available to all channels are grayed out.

Using [At] [/] [/]1 will place the direct DMX value on the command line. For example,[1] [At] [/] [/] [2][3][9]
[Enter] would put channel 1 at DMX value 239.

The following examples illustrate how to set parameter values with the keypad:

»+ [5] {Iris} [5] {Zoom} [6] [5] {Edge} [5] [Enter] - sets channel 5 to an iris value of 50%, a zoom value of
65%, and an edge value of 50%.

Adjusting Parameters Using + and -

[+] and [-] can be used to adjust parameters from the command line. When using [-], you will need to preface
the command with [+] if you want to remove from the current value.

For Example:
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b
e

[Channel List] {Pan} [1][0] - sets to 10 degrees.

¥ [Channel List] {Pan} [+] [1][0] - adds 10 degrees.
[Channel List] {Pan} [-] [1][0] - sets to -10 degrees.
[Channel List] {Pan} [+] [-] [1][0] - removes 10 degrees.

g
Tt g

Partial Show File Channel Merge

A new option has been added to Merge.

Merge From: D\

Color Show Magic

Palette Presets Control Sheets
Advanced

Beam
Palette

Submasters| Fixtures Pixel Maps

Intensity

Palette Groups Effects Snapshots Media

L} Sys
Focus — ystem

Palette Settings ElEs

When Merge Channels is selected, channels from cues, submasters, groups, and other channel targets will be
added to any existing channel targets of that same type.

With Merge Channels not selected, those channels will override any existing channels in the channel targets of
the same type.

For Example:

In a show file 1, group 1 has channels 1 through 5. In show file 2, group 1 had channels 6-10. With Merge
Channels and Groups selected for the merge, show file 2's group 1 will merge with show file 1's group 1.
Group 1 will then have channels 1-10. If Merge Channels was not selected, group 1 would just have channels
6-10.

j Note: Itisimportant to remember that if the same channels exist in both show files, the data mer-
ging in will override the existing data for those channels.

Lightwright Import

Several changes were made to importing Lightwright files. Once a file has been selected for import, you will
now have options for importing.

Lightwright Fos Lightwright 05 Lightwright
Channel
Addre

Device Type

<Ignore - ext3 - ext9 <Ignore

Purpose - - <Ignore>

Color

Merge and Overwrite

You can select to either merge the data with the current show file, or to overwrite the data in the current file.
To do this, check the {Overwrite} box. Leaving this box unchecked will merge the data.

Starting and Ending Channel
You can select starting and ending channels for the import.
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Mapping

You can map Eos patch fields to fields in the Lightwright file. Channel and Address must be mapped for the file
import to work. Any other field can be set to ignore if desired. Once a Lightwright field has been mapped, it
will display in grey in the dropdown menu. However, greyed out options can be selected again for placement
in multiple fields.

Lightwright Fos bl v Lightwright

The text fields in the Patch display and database will rename based off of the Lightwright imported fields. See
Renaming Text Fields in Patch on page 17 for more information.

ey
[J) Note: Fos 2.3 does not currently support multiple gels per fixture from Lightwright. ]

Address Formats

Eos will accept mulitple address formats for importing. Examples of those formats are 2/3, 2.3, 2,3, 2-3. Eos
will convert all formats to n/n.

Device Mapping
Devices can also be mapped. Click {Map Devices} to open the following display.
Lightwright

dor Desire DE0 Lustr

Select the Lightwright device and the match from the Eos column. Multiple Lightwright devices can be selec-
ted ata time. Then click {Link Devices}. The link will appear in the Mapping column. To unlink a device,
select it from the Mapping column, and then press {Unlink Device}.

Device mapping and import fields are saved with the show file.

MLA Added to Export Menu

An option for exporting to Moving Light Assistant (MLA) has been added to the Export menu, Dis-
plays>File>Export>Moving Light Assistant.

This will open the export screen in the CIA. From this screen, you can choose which aspects of the show file
you want to export. By default all aspects are selected and will be exported. To withhold any show aspects
from exporting, simply deselect them in the CIA by clicking on the respective button. Deselected show aspects
will appear in black.
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You can also choose to export specific portions of show aspects. To select this information, press the
{Advanced} button. In the Advanced screen, all aspects are deselected (black) by default.

To stop the show file from being saved for export, press the {Cancel} button. If you are ready to save, press
{Ok}. You will be prompted to name the file. A .csv file will be created.

Adding to the Current DMX Value

It is possible to set a channel's parameter levels with the DMX value by using [/][/], which posts DMX to the
command line.

# [1]1 {Pan} [/1[/]1 [2][5] [Enter]
You can add or subtract from the DMX value by using [+] or [-].

7+ [11{Pan} [/][/] [+] [5] [Enter]
»» [11{Pan} [/1I/1 [-] [71[5] [Enter]

Discrete Time as a Percentage

Discrete times can be entered as a percentage of the cue time.

#+ [2] [Time] [/] [5] [Enter] sets the time for channel 2 to 50% of the cue time.
#» [2] [Focus] [/] [71[5] [Enter] - sets the focus category time to 75%.

Most Recently Activated Cue

Use [Cue] [n] [/] [Enter] to select the most recently activated cue from that cuelist. If there is no active cue
from that list, the first cue in the cuelist will be used.

Color Overview

In version 2.3, you will notice several major changes to working with color.
These changes allow for a more complete control of color.

With the color picker open, you now have the choice between six different
Color Spaces (page 10), a Gel Picker (page 11),Color Path (page 13), Tint{
ing Tools (page 13), and Spectrum Tools (page 14).

These options are found by clicking on the display configuration tool (the gear
icon) in the upper left corner of the color picker display.
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Color Spaces

There are six color spaces that you can choose to work in. All of these spaces are connected. So it doesn't mat-
ter which space you wish to work in, the console will translate the information to work with your fixtures.

When the color picker is first opened, the CIE xy color space and the gel picker will open by default. You can
select other color spaces and tools by clicking on the display configuration tool (the gear icon) in the upper left
corner of the color picker display.

\_) Note: Muitiple color picker tabs with different color spaces can be opened at the same time. Mul-
tiple color spaces can be opened on the same tab.

The available color spaces are:

\_) Note: When a fixture is in HS mode, the brightness control is not provided. Intensity controls the
brightness.

For the CIE xy (CIE 1931) and CIE uv (CIE 1976), the triangle represents the RGB space as defined by the
PLASA standard E1.54. Fixtures that comply to that standard can achieve any color within the triangle. The
cone represents the color spectrum that we can see.

Controls
Each color space has three virtual encoders, a vertical encoder, a {2} button, and a {*} button.

The encoders will change based on the color space selected. Double tapping in a virtual encoder will cause it
to jump to the location of your finger. Pressing and holding will cause the encoder to fade toward your finger.

Tapping anywhere in the color space will cause the crosshair to move to that location. Press and hold, then
move your finger to fade the crosshair toward that location.

The {*} button will create the brightest version of the selected color. Press the {?} button to display labels on all
of the controls.
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Virtual Encoders

For the RGB and CMY color spaces, you can change which color control is on the vertical encoder. Touch the
label of the virtual encoder to change which color control is located on the vertical encoder. In the following
graphics, Red is on the vertical encoder in the first one and green is on the vertical encoder in the second one.
This is also indicated by the highlighted encoder name.

For the HS Wheel and HSB color spaces, the vertical encoder is always brightness.

Gel Picker

Several changes have been made to the gel picker for working with the new Color Spaces (page 10). When
the gel picker is opened up with a color space, there will be dots displayed on the color space. These dots rep-
resent the gels in the currently selected gel book. Hovering over a dot with a mouse will display the gel's name
and a color swatch.

The following buttons are also available:
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#» {Brightest} - determines the color match used. This is helpful when working with fixtures that have
more than three color components, such as RGBA, RGBWm or ETC's fixtures. Pressing {Brightest} or
{Shift} +a gel from the picker will cycle through the three modes.

7+ {Brightest} - matches to the brightest match of that chromaticity.

» {Spectral} -matches to the best spectral match chromaticity. However, this mode can remove a
lot of the intensity. This is based off of a 575w long life Source Four®.

» {Hybrid} - halfway between the brightest and the best spectral match.

In the channel display, a single dot shows best spectral match, 2 dots indicates hybrid,
and no dot shows brightest.

» {Sort Hue} - takes the selected gel library and sorts it by hue instead of by gel number.

7 {Similar} - will show gels that are in the same selected area of the color picker. Only gels in the same
selected gel book will display. You can switch to another gel book though to discover gels in that area.

7 {Show} - displays all of the static gels in the show file. This populates from Patch.

» {Standard Colors} - shows a range of White Point from 2700K to 6500K. Also shown are colors located
around the triangle and variations of those colors at 25% increments.

ook | moox | meoc | woox | awex | owooe | amex | seoc | omeox | omoox | omwox | moox | meox | weoc

aoe | amow | awex | ewox | amox | osooe | awew | sesc | omeow | osoox | oswex | osmwex | oswex | see

00K (T

formge 73|

How the Gel Picker Affects Scroller and Color Wheel
When possible the Gel Picker will select the closest gel as defined in a scroller or color wheel.

\_) Note: Some devices contain manufacturer specified gel mixes, and will only allow selection from
the Gel Picker of the exact gels in their list.

In previous versions when using the Gel Picker, the channel display would show the gel. Now the channel dis-
play shows the frame number and the corresponding label that is defined for that frame.
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Tinting Tools

The Tinting Tools option is found by clicking on the display configuration tool (the gear icon)
in the upper left corner of the color picker display.

Tint allows you to easily adjust color regardless of the color space that you're working in.

You can increase or decrease the saturation and brightness. You can make a color warmer
or cooler, and you can add or remove colors.

Color Path

o
[\D Note: inversion 2.3, color path is only applicable for additive mixing systems. ]

Color Path is a new option for controlling color fades between cues. By default, color fades happen in the nat-
ive space of the fixture. If you want a fade that resembles a fade in a different color space, you can do that
using color paths. There are eight preprogrammed color paths, and you can also record your own . Up to 1000
color paths are supported.

To open the color path display, click on the gear icon in the color picker display and select Fade. To open the
color path list display, press [Path] [Path] or by pressing the {Color Path}icon in the home screen.

Color paths are selected either by clicking on the drop down above the color path or by using [Path] / {Color
Path} [n]. lon and Element users will need to use the {Color Path} softkey.

o
Z:\D Note: Channels involved in the fade have to be selected before you can choose or modify a color
path.

The color path display has a drop down list of the available paths, a color path preview bar, and control but-
tons. An indication line will display on the color space to show the color fade.

The Color Fade

Available control buttons are:
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b

o) >
- - replays the color fade using the cue time.
L] >

] - replays the color fade using the Go to Cue time from Setup.

" - replays the color fade in five seconds.

" - replays the color fade in ten seconds.

— - pauses the color fade.

bl

b - plays / resumes the color fade.

Y - skips to the end of the color fade.

You can also click on the color path preview bar to scrub to any point along the fade.

Additional controls may be available based on the color path selected. For example, Color Path 7 has addi-
tional controls for Hue, Saturation, and Brightness. You can move those controls to adjust the fade, and you'll
see a representation of those changes in both the color path preview bar and in the color space.

Changes can be stored in the destination cue as absolute data by using [Update] or [Record]. When there's a
change to the color path information, a red c will display next to the channel number and the color path's

name will disEIay inredin the collorfoat.h display. When that data has been saved, a blue c will display. H
The color path's name will also display in blue in the color path display.

You can save changes to a new color path by using [Record] [Path] / {Color Path} [n]. That data will then be
referenced, and any changes made to that path will be used anytime that path is used Press [Shift] + [Path] /
{Color Path} to see the values behind the referenced data.

See [About] Color Path on page 16 and Color Path in Patch Attributes on page 17 for more inform-
ation.

Spectrum Tools
The Spectrum option is found by clicking on the display configuration tool (the gear icon) in the upper left
corner of the color picker display.

This option displays all the color parameters across the color spectrum, and allows for individual control of each
parameter. Press a color point to move it.

This display is a good visual of what the fixture is outputting.
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The following screenshot shows a 7 color fixture. This display will change based on the type of fixture being
used.

Zij) Note: The grey line shows the composite color of the fixture. If multiple fixtures are selected, the
grey line represents the first channel selected.

With the Gel Picker (page 11) open and a gel selected, a dotted line will appear in the Spectrum display.
That line represents the selected gel.

—— Press to Remove the Gel Line.

Hold Color Point

{Hold Color Point} allows you to adjust individual emitters and the other emitters will automatically adjust to
hold the color selected. If an emitter has been adjusted too far, a Limit Reached warning will appear. This can
only be used with fixtures that have more than three color parameters.

If you are working outside of this display, holding down [Color] while adjusting the encoders will cause Hold
Color Point behavior.

Encoder Softkeys

If you press the encoder for any parameter, the softkeys change to display options relevant to that parameter.
These may include {Home}, {Last} and {Next}, or {Min} and {Max}, and depending on the type of parameter,
a {Mode} or {Calibrate} button.
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Previously this behavior was only available on lon. Now this is available on Eos, Eos Ti, Gio consoles and the
Eos Programming Wing.

[Shift] + [At], [Shift] + [Enter], and [Select Last]

[Shift] + [At], [Shift] + [Enter], and [Select Last] can now be used to loop through commands five times.

Zoom Added to About

A zoom button has been added to the About display. There are three zoom sizes: small, medium, & large.
Medium is the default size. Press {.a[A]} to zoom.

Current
Values

.[alA ||Background

! }
Source Value Delay Time Marked In ~ Mark For Park 1 moves

Usage

Patch

Lamp
Controls

[About] Color Path

The following information will be displayed when a color path is selected:

v

* The color path number

* Label (if any)

* Channels that use the color path

# Cues that have moves that use the color path
»» Number of cue lists the color path is used in

e

See Color Path on page 13 for more information.

[About] Submaster

The following information will be displayed when a submaster is selected:

#* The submaster number

» Label (ifany)

2 Current value

»» Mode (additive, inhibitive, or effectsub)
»* Fader (proportional or intensity master)
# HTPorLTP

7 Exclusive

#  Priority

#* Timing

»* Fader Pages

2 Channels in Submaster

% Effects assigned
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Color Path in Patch Attributes

A default Color Path (page 13) can be assigned at the channel level in Patch. That color path will be used for
all of that channel's color fades unless overridden at the cue level. Submasters and manual transitions that use
that channel will use the default color path as well.

While in Patch, [1] [Path]/{Color Path} [2] [Enter] will assign color path 2 to channel 1. lon and Element users
will need to use the {Color Path} softkey. You can also go to Patch>Attributes>Color Path to place color
path on the command line.

See also Color Path on page 13 and [About] Color Path on page 16 for more information.

Fixture Lists in Library

The fixture lists in the library are now ordered alphanumerically.
For example, the following fixtures are listed first in alphabetical order and then ordered numerically.

AR5 Diffusion
Element Labs SA16 8 AR250C

Eliminator ARS Douser Dﬁf:z;'f“mq
SA16 8 = A SA8

AR50 Diffusion | ARS00 Douser

SAl6 8 SAB 4

AR50 Douser
SA16 8

ETC Arch AR250

>

Elumeng

Gel Field

The Gel field in the Patch Database display automatically populates with the gel selected from the Gel Picker
(page 11). The gel information will show up in two places in the Patch Database.

This field is available for use with the [Query] function. See Additions to Query on page 1 for more inform-
ation.

Renaming Text Fields in Patch

In the {Database} page in Patch, you can now rename the text fields. By default, the text fields are named
{Text 1} through {Text 10}.

¥+ {Text 1} [Label] <Position> will rename the text 1 field to Position.

Eos Family Operations Manual Supplement 17 Electronic Theatre Controls, Inc.



ETC® Supplement

Eos Family v2.3.0

Text fields 1 through 4 display in the Patch display. Renaming those fields will rename the columns associated
with them in the Patch display.

Chan Address Type Label Position

350 Dimmer front lights

351 Dimmer front lights

See also: Additions to Query on page 1, Gel Field on page 17, and Lightwright Import on page 7

Warning with Out of Sync Fixture Libraries

For multiconsole systems, all devices have to use the same fixture library. If the fixture library is different
between devices, a warning will be displayed on the device trying to connect to the system.

Updating a Fixture Definition Warning

When updating a fixture definition in Patch, a warming message now includes what changes will be made to
the fixture by updating it.

By Type Presets

By Type presets are created with 'default' channels which contain values that can be assigned to any other
channel within the same fixture type. By Type presets can also contain discrete channel values.

By Type presets will display a ‘T’ in the lower corner of the direct selects. A '+ will display after the ‘T" if there
are channels stored with discrete data.

Using By Type Presets

Storing a By Type Preset

If {By Type} is used when recording, the lowest number channel of each fixture type will be the default chan-
nel. Generally, when storing by type presets, you will want only one channel of each fixture type in use. Any
additional channels in that fixture type will be recorded with discrete data.

#» [1] [Thru] [6] [Record] [Preset] [1] {By Type} [Enter] - Channels 1 through 6 are saved to Preset 1.
Channels 1 through 6 are of the same fixture type. Channel 1 will be the default channel, and channels
2 through 6 will be saved with discrete data.

»+ [1] [Thru] [6] [Record] [Preset] [1] [Enter] - If a by type preset is rerecorded without using the {By
Type} softkey and the default channel is included in the record, the default channel's level will change
and all other changes will be discrete.

»+ [1] [Thru] [5] [Record] {Intensity Palette 1} {Discrete} [Enter] - If a default channel is included in a
record where {Discrete} is used and another channel is tracking it, the default channel will be changed
to having discrete data and the lowest numbered tracking channel will become the new default chan-
nel. All other channels in the record will also have discrete data.

Editing By Type Presets in Blind

In Blind, the default channel’s levels will display in blue, discrete data for the other channels will display in
white, and any channels that are using the default channel value will display in magenta.

71
72

73
74
75
76 FL 0 0 0 1] 67 56 34 F1-

Softkeys available for editing presets in blind are {By Type}, {Discrete}, and {Cleanup}.
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#+ [3] {By Type} [Enter] - makes channel 3 the new default channel for that device type. If another chan-
nel for that type was the default channel, its data will now be discrete.

#» [11[0] [Thru] [2] [0] {Discrete} [Enter] - changes the levels for channels 10 through 20 to discrete. If
any of those channels are default, the lowest numbered tracking channel will become the new default
channel.

#+ [5] [Thru] [8] [At] [Enter] - removes the discrete data for channels 5 through 8. They will now use the
default channel’s values.

#+ [Preset] [2] {Discrete} [Enter] - changes all tracking and default channels to discrete.
#+ [Preset] [5] {By Type} [Enter] - makes the first channel of each device type a default channel.

#» [Preset] [3] {Cleanup} [Enter] - converts presets created in earlier versions of Eos Family software to by
type presets. This command will use the first channel of each type as the default, and allow other chan-
nels of the same type to use that value upon recall.

{Make Null} can be used with by type preset when you wish to withhold a channel from responding to a by
type preset recall. The data will still display but will be in gray witha “N”.

Updating By Type Presets

Pressing {By Type} after an [Update] command, with a channel tracking but no default channel included in
the update, will cause the lowest numbered tracking channel's level to be updated into the default channel.
The tracking channel will remain tracking. This means that when updating a default value in a by type preset,
you don't need to know the default channel number.

When a default channel is included in an [Update] command without using {By Type} and another channel is
tracking it, the default channel’s data will be changed to discrete. The lowest numbered tracking channel will
then become the new default channel. Any other updated channels will be made discrete.

Indicators in Palette and Preset List Displays

Indicators for absolute (A), locked (L), and by type (T+) have been added to the palette and preset displays .
These indicators displays to the right of the palette or preset number.

Intensity Palette

Configuration Menu

In the direct select x25 tab, a configuration menu button is located in the top left corner.

Eos Family Operations Manual Supplement 19 Electronic Theatre Controls, Inc.



ETC® Supplement

Eos Family v2.3.0

Menu Options

Fit To Screen

The following options are available in the Configuration Menu: Rows: 5 -Row || +Row
Cols: 5 - Col + Col
#» Fit to Screen - when selected, the direct selects will fill the screen as much as [ e
possible. use Pages
*» Rows - allows you to select the number of rows in the arrays. se Arrous :
Use Record Recor
» Columns - allows you to select the number of columns in the array. e Select =
»» Use Buttons - selecting the checkbox for these buttons will allow them to dis- use Flox e
play on the direct select screen. With or without the checkbox selected, you Uss Color Swatch

can use the buttons to the right to of the checkboxes to recall the function.
¥ Use +/- - displays the {+ Array} {- Array} buttons.

»» Use Pages - displays the page # buttons. There is not a way to select a page # from the con-
figuration menui.

#» Use Arrows - displays the page up and down arrows.

#» Use Record - displays the {Record} button.

7 Use Select - displays the {Select} button.

» Use Flexi - displays the {Flexi} button.

A Uste (I'ol?r Swatch - displays a round color swatch in the lower left corner of a color palette dir-
ect select.

By default all options except for Fit to Screen are enabled.

Color Swatch

In the Direct Select Configuration Menu (page 19), there is an option to {Use Color Swatch}. When selec-
ted, a round color swatch will appear in the lower left corner of a color palette direct select.

dark
green

darkblue | dark red yelow

®: O &3 @4

Gadget Settings

In the ECU>Settings>Local 1/0, settings are available for Gadget. From this screen, you can configure the
port address, enable Doubled, and set the port speed. Multiple Gadgets will appear in separate boxes and can
be identified by their serial numbers.
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e
ZJ) Note: Witha Gadget connected, you will need to go into the main Eos application first before the

' Gadget will display in the ECU.

od Maximum =

Speed Maximum = No Gadget

Detected

Speed Maximum -

Gadget

Gadget Support

Eos can now support multiple Gadgets at the same time.

-

[\E) Note: There is a limit of four outputs. ]

Programming Wing Settings

In the ECU>Settings>Local 1/0, settings are available for the Eos Programming Wing. Please see the Eos Pro-
gramming Wing Setup Guide for more information.

Mini Encoder Display

A mini encoder display will display when an Eos Programming Wing is connected to ETCnomad.

Softkeys

For the Eos Programming Wing, you can hold down [More SK] + Encoder Category Button to access the
second page of softkeys.

For Example

With a channel on the command line, pressing [More SK] + [Intensity] will post Make Manual on the com-
mand line.

This also works with Gio.

Encoder Paging

OnETC nomad, while hO|dIng down CTRL+ALT+\ , You Intensity Focus Color Form Image Shutter
can press one of the encoder category buttons to change
the page.
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Eos Family Hotkeys

To enable Eos functions on Mac Function keys:

»* QOpen Systems Preferences
# Gointo the Keyboard section
»* Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

(o
j,:l Note:. Some international keyboards require “Use Shift Key as Eos Shift” to be disabled in the Gen-
~ eral section of the ECU Settings. Use Z as shift to access shortcut functions in these cases.
L
Console Key PC Console Key PC Console Key PC
Shortcut List ; Capture Control Alt P Focus Palette AltF
? CIAHide F5 Follow/Hang Shift D
0 0 Clear Backspace Control Alt D
1 1 Clear Command Line | Shift Backspace Format F4
2 2 Color Filter Control C Control4
3 3 Color Palette Alt C (Scroller) Frame | Control Alt C
4 4 Copy To C Freeze Control Alt F
5 5 Cue Q Full F
6 6 Cue Only/Track X Go Spacebar
7 7 Data ControlD GoTo Cue Control G
8 8 Data Mode Control Shift D Goto CueZero | Control Alt G
9 9 Delay D Group G
. (decimal) . (decimal) Delete Delete Help Alt/
- (minus) - (minus) Delete (Mac) Fn Delete Highlight \
+(plus) = Displays F9 Control Alt H
Control9 Home Home
+% Shift = Effect Alt E ControlH
Control Alt = Effects Softkeys Alt Shift E Home (Mac) | Fn Left Arrow
+% (Mac) Shift Fn Up Arrow Encoder Display (Gio) Control Alt\ Intensity Block Shift B
-% Shift - Encoder Page Color” Control Alt [ Control Alt B
Control Alt - Encoder Page Focus” Control Alt, Intensity Filter Controll
-% (Mac) Shift Fn Down Arrow Encoder Page FormA Control Alt ] Intensity Palette Alt |
/ / Encoder Page Image” Control Alt ; Label/Note L
About Y Encoder Page Intensity” Alt . Last Page Up
Address/Dimmer Alt A Encoder Page Shutter” Alt, Control,
AllNPs ControlN Enter Enter Last (Mac) Fn Up Arrow
Assert ControlW Escape Escape Learn Alt L
Assert (Playback) Control Alt A Expand F5 Level \
At A Control 5 Live F1
@ Fader Pages Control P Control 1
* Load Control Alt L
Beam Filter ControlB Fader Independent Shift | Macro M
Beam Palette AltB Fan W Macro 801* | Control Alt 1
Blind F2 FlexiChannel F3 Macro 802 * Control Alt 2
Control 2 Control 3 Macro 803* | Control Alt 3
Block B Focus Filter Control F Macro 804* | Control Alt 4
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Console Key PC Console Key PC Console Key PC
Macro 805* Control Alt 5 Record R Thru T
Macro 806* Control Alt 6 RecordOnly ControlR Undo Control X
Macro 807* Control Alt 7 Release Control Alt S Update u
Macro 808* Control Alt 8 Rem Dim H Virtual Keyboard | ControlK
Macro 809* Control Alt 9 Scroll Lock F6
Macro 810* Control Alt 10 Control 6 Shell Shortcut
Magic Sheet Alt M Select Control Enter Shell Key PC

Manual Override [ Control Alt M Select Active Control A 0 0
Control Alt N Select Last ControlL 1 1
Mirror, Start AltF1 Select Manual ControlM 2 2
Mirror, Stop Alt F2 Setup Alt S 3 3
ML Controls F7 Shift z 4 4
Control 7 Snapshot Control S 5 5
More Softkeys Alt 7 Sneak N 6 6
Next Page Down Softkey 1 Alt 1 7 7
Control. Softkey 2 Alt 2 8 8
Next (Mac) Fn Down Arrow Softkey 3 Alt 3 9 9
Off Control Alt O Softkey 4 Alt 4 . (decimal) . (decimal)
Offset ControlO Softkey 5 Alt 5 - (minus) - (minus)
Out 0 Softkey 6 Alt 6 +(plus) =
Page Left Left Arrow Spacebar Disable Alt G /
Page Right Right Arrow Stop/Back Control Spacebar Arrow, Down | Arrow, Down
Page Up Up Arrow Stop Effect Control Alt E Arrow, Left Arrow, Left
Page Down Down Arrow Control Alt K Arrow, Right | Arrow, Right
Park AltK Submaster S Arrow, Up Arrow, Up
Part P Tab Tab Back Esc
Patch " Time I Clear Backspace
Path Control Alt W Time (Displays) Shift | Delete Delete
Pixelmap Alt X Control Alt | Enter Enter
Preset Alt P Timing Disable Control Alt T Escape Esc
Query ControlQ Toggle Hotkeys F8 Select Return
Rate Control Alt R Control 8
Recall From E Trace J

*Some Shortcut Key combinations are not available on all physical keyboard layouts.

AAlternatively use Encoder Display + category to change the encoder pages.
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Element Hotkeys

To enable Eos functions on Mac Function keys:

»* QOpen Systems Preferences
# Gointo the Keyboard section

»* Enable the “Use all F1, F2,etc... keys as standard function keys” setting.

(- "
j,:l Note:. Some international keyboards require “Use Shift Key as Eos Shift” to be disabled in the Gen-
~ eral section of the ECU Settings. Use Z as shift to access shortcut functions in these cases.
L
Console Key PC Console Key PC Console Key PC
Shortcut List ; Clear Backspace Home Home
? Clear Command Line | Shift Backspace ControlH
0 0 Color Filter Control C Home (Mac) Fn Left Arrow
1 1 Color Palette Alt C Intensity Filter Controll
2 2 Copy To C Intensity Palette Alt
3 3 Cue Q Label/Note L
4 4 Cue Only/Track X Last Page Up
5 5 Data ControlD Control,
6 6 Data Mode Control Shift D Last (Mac) Fn Up Arrow
7 7 Delay D Learn AltL
8 8 Delete Delete Level \Y
9 9 Delete (Mac) Fn Delete Live F1
. (decimal) . (decimal) Displays F9 Control 1
- (minus) - (minus) Control9 Load Control Alt L
+(plus) = Effect Alt E Macro M
Effects Softkeys Alt Shift E Macro 801* Control Alt 1
+% Shift = Enter Enter Macro 802* Control Alt 2
Control Alt = Escape Escape Macro 803* Control Alt 3
+% (Mac) Shift Fn Up Arrow Expand F5 Macro 804* Control Alt 4
-% Shift - Control 5 Macro 805* Control Alt 5
Control Alt - FlexiChannel F3 Macro 806* Control Alt 6
-% (Mac) Shift Fn Down Arrow Control3 Macro 807 * Control Alt 7
/ / FocusFilter Control F Macro 808* Control Alt 8
About Y Focus Palette AltF Macro 809* Control Alt 9
Address/Dimmer Alt A Follow Shift D Macro 810* Control Alt 10
AlINPs ControlN Control Alt D Magic Sheet AltM
At A Format F4 Manual Override | Control Alt M
@ Control4 Control Alt N
* (Scroller) Frame Control Alt C Mirror, Start Alt F1
Beam Filter Control B Mirror, Stop Alt F2
Beam Palette AltB Full F ML Controls F7
Blind F2 Go Spacebar Control 7
Control 2 GoTo Cue Control G More Softkeys Alt7
Block B Go to CueZero Control Alt G Next Page Down
Capture Control Alt P Group G Control.
CIA Hide F5 Help Alt/ Next (Mac) Fn Down Arrow
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Console Key PC Console Key PC

Offset ControlO Timing Disable Control Alt T

Out 0 Toggle Hotkeys F8
Page Left Left Arrow Control 8
Page Right Right Arrow Thru T
Page Up Up Arrow Undo Control X
Page Down Down Arrow Update u
Park Alt K Virtual Keyboard ControlK
Part P
Patch 5
Path Control Alt W Shell Shortcut
Rate Control AltR Shell Key PC

Recall From E 0 0
Record R 1 1
RecordOnly ControlR 2 2
Release Control Alt S 3 3
Rem Dim H 4 4
Scroll Lock F6 5 5
Control 6 6 6

Select Control Enter 7 7

Select Active Control A 8 8
Select Last ControlL 9 9
Select Manual ControlM . (decimal) . (decimal)

Setup Alt S - (minus) - (minus)

Shift Z +(plus) =
Snapshot Control S /

Sneak N Arrow, Down Arrow, Down
Softkey 1 Alt 1 Arrow, Left Arrow, Left
Softkey 2 Alt 2 Arrow, Right Arrow, Right
Softkey 3 Alt 3 Arrow, Up Arrow, Up
Softkey 4 Alt 4 Back Esc
Softkey 5 Alt 5 Clear Backspace
Softkey 6 Alt 6 Delete Delete

Spacebar Disable Alt G Enter Enter
Stop/Back Control Spacebar Escape Esc
Stop Effect Control Alt E Select Return

Control Alt K
Submaster S
Tab Tab
Time |

*Some Shortcut Key combinations are not available on all physical keyboard layouts.

AAlternatively use Encoder Display + category to change the encoder pages.
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Eos Family v2.2 Supplement to Operations Manual

The following information is new for version 2.2.0. This document is supplemental to and should be
used in conjunction with information in the Eos Titanium, Eos, and Gio v2.0 Operations Manual, lon
v2.0 Operations Manual, and the Element v2.1.0 User Manual..

CAUTION: If you choose to update fixture definitions in your existing show files after
upgrading to version 2.2, it is recommended that you verify that your show plays
back as expected. Changes have been made to the fixture library to make fixtures
in future shows easier to control, however, these changes will impact existing
shows after you manually update fixture definitions. For more information, see
Changes to Fixtures on page 16

Display Management Tools

One of the most significant improvements to the Eos family in this software release are the
enhanced display management tools. The software provides improved capabilities for opening and
navigating displays and control tools.

Increasing the depth of individual displays, this software introduces the ability to have one of three
different workspaces active on individual monitors, as well as to have up to four areas (called
frames) in use in any workspace. Each frame can hold multiple tabs.

Display

Controls Workspaces
Menu Button P

Cricket & Cache.

B

Group

©® N U A WN R

-
o

17 Group List Display 12 Patch

color || 1pollo [ 26aMG
G for

Format olor | 3¢

O
Tokyoss
Poly.

7 Rosco
SuperGel | E Color

Int Down Beam Dur " Fw/Hg Link

3 25 L

Monitors

Any physical monitor or touchscreen device connected to your console. The integral touchscreens
on Eos Ti are examples of monitors as are external monitors used with any of the Eos Family
consoles.
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-
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Workspaces

Further expanding your monitor capabilities, workspaces have been added to offer independent
display control on all of your connected monitors. Every monitor can have up to three workspaces,
identified by the workspace icons in the upper left corner of any monitor (including any integrated
touchscreens with your console).

You can use [Tab] + [Page A] and [Tab] + [Page ¥ ] to cycle through the workspaces. This will
increment or decrement the current workspace and will then force all of the other workspaces to
match the current workspace’s number (1, 2, or 3). This is so you can quickly step through the
workspaces.

Workspaces 1, 2, and 3

These three monitor icons are used to switch between each monitor’s available workspaces. Each
can be set up to include any of the desired layout, displays, and controls options offered on the
Home Screen (page 4) or the Display Controls Screen (page 6).

Frames

Each workspace can have up to four frames in its layout. The number of frames in a workspace
layout is determined by choosing from the Layout Options (page 4) offered in the Home Screen
(page 4) or the Monitor Options Screen (page 6).

Tabs

Any frame can have multiple tabs open. Tabs are now broken down into two categories: Control
and Display. Control tabs (see page 6 for a list of tabs) are the virtual control options that were
formerly available in the browser, such as the color picker and the virtual keyboard. Display tabs
(see page 5 for a list of tabs) are the various displays available on the console, such as the
playback status display and the park display.

You can open or close tabs using the Display Icons (page 5), Control Icons (page 6), or all of the

methods used in previous versions of software. Pressing [Shift] + [Tab] once will clear all tabs on
the selected monitor but tabs in locked frames will remain. Pressing [Shift] + [Tab] twice will clear
all tabs on all monitors but tabs in locked frames will remain. Pressing [Shift] + [Tab] a third time

will clear all tabs on all monitors including those in locked frames.

White text in the tab indicates a Display Tab, and magenta I

All Display and Control Tabs have fixed tab numbering

under which they open (for example, “Live” opens under Tab 1, “Patch” under Tab 12, and “Color
Picker” under Tab 27). These numbers are identified on the Home Screen in each icon and in the
following table. For multiple instances of the same display, the tab number will be followed with a
decimal number. Additional tabs will start their numbering with n.2. When you press [Tab], active
focus will move numerically through all open tabs on active workspaces.

Note: Using just the [Tab] key to cycle through tabs will skip over any Control Tabs in
locked frames. Pressing [Tab] [n] will select the tab regardless of if it is in a locked

frame or not.
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This table lists the tab number for each of the Control and Display tabs.

1 Channels 11 Show Control List 21 Curve List 31 Lamp Controls
2 Playback Status Display | 12  Patch 22  Intensity Palettes | 99 Diagnostics

3 Magic Sheet Display 13  Effect List 23 Focus Palettes

4 Direct Selects 14 Magic Sheet List 24  Color Palettes

5 ML Controls 15  Submaster List 25 Beam Palettes

6 Effect Status 16 Cue List Index 26  Preset List

7  Virtual Keyboard 17  Group List 27  Color Picker

8 Effect Channels 18  Macro List 28  Virtual Faders

9 Pixel Map List 19  Snapshot List 29  About

10  Pixel Map Preview 20 Park 30 Command History

Focus Rules for Control and Display Tabs

Single clicking on a Controls Tab will bring it to the front of the frame but will not move focus to that
tab unless the tab’s frame already has focus. Double clicking on a Controls Tab will bring it to the
front and grab focus. Single clicking on a Display Tab will bring it to the front and grab focus.

Tab Tools

Every frame has a tab tools menu in the lower left corner of the
frame. Selecting this menu icon will open the tab tools menu, O 17 Group List Display |
which provides options for opening and closing tabs in that

frame. You can left click with a mouse or double tap a tab in focus Close Tab

to also see this menu. Most options are self-explanatory with the
following exceptions:

Replace Tab
+ “Replace Tab” allows you to close the current tab and
choose from the Home Screen which display to replace it Close All Tabs But This
with. Pressing escape will return you to the previously
selected tab. Close All Tabs
* “Lock Frame” prevents any additional tabs from being
opened in the selected frame. Lock Frame
* “Open New Tabs In This Frame” specifies that any new
tabs opened will automatically open in the specified frame. ] Open New Tabs In This Frame

Only one frame can have this option selected at a time.
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Home Screen

Upon start up or creation of a new show file, any connected monitor that is not already displaying
the Live or Playback Status Displays will show the Display Management Home Screen.

(untded)

Layout Options

OOEINECSEEOBREEA

Display Icons

8] o> > 7 5 P FP CP BP

SUB

P A5 8 2 E D oL a

Cues Pix Maps. Macros nay Curves Parc ‘Show crl

Control Icons

BB Nk B OO W O

Snapshots Area

This screen consists of four general areas, each offering different display-related options.

Layout Options

These tools offer you greater flexibility in the number of tabs you can view in any given workspace.A
workspace can have up to four frames. Selecting a layout icon will assign the frame layout identified

in the icon. Once a layout is assigned, you can select which displays and controls will be in which
frames.
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Display Icons
The following displays can be selected, and they will open in a new tab in the selected frame:

Channel Channel Split Channel Playback Magic Sheet Magic Sheet
(Tombstones) | (Table) Status Display | Display List

MS List

Intensity Focus Palettes | Color Palettes | Beam Palettes

Palettes

FP

Effect Submasters
Channels

Presets Pixel Maps

Pr

Presets
Macros Snapshots Show Control

Snaps

Show Ctrl

Macros

The following displays can have multiple instances open:

* Channel (Tombstone)

* Channel (Table)

+ Split Channel

» Playback Status Display
» Magic Sheet Display

+ Effect Channels

« Park

For multiple instances of the same display, the tab number will be followed with a decimal number.
Additional tabs will start their numbering with n.2. If you have only one instance, there will be no
decimal number.
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Control Icons

The virtual controls that were located in the browser are now part of the home screen. You can
select from the following list of virtual controls, and they will open in a new tab in the selected frame:

Direct Selects Direct Selects ML Controls Effect Status Virtual Pixel Map
Classic x25 Keyboard Preview
Color Picker Fader Module About Command

History

2

Snapshots

The snapshots displayed here are single monitor-only snapshots recorded for the visible
workspace. These snapshots can be recalled from any selected monitor from the Home Screen or
the Display Controls menu screen. You can recall a monitor-only snapshot from the command line
by using the syntax [Snapshot] [n] [Enter]. When recalled from the command line, the selected
snapshot will only affect the monitor from which it was originally recorded.

To record a monitor-only snapshot, press the {New Snapshot} button on the Display Controls
menu screen. [Delete] [Snapshot] [n] [Enter] [Enter] will delete a monitor-only snapshot.

All snapshots can be viewed on the snapshot list display, which can be opened by pressing
[Snapshot] [Snapshot] or from the home screen.

Display Controls Screen

Selecting the display controls icon will grant you access to the Layout Options previously
described. Choose the layout icon for the arrangement and number of frames you want to use on
the monitor.

Display
Controls
Menu
Button

New Snapshot
Button

This screen also offers options for opening and closing tabs as well as resizing and resetting the
monitor(s). The icons are:

Eos Family Operations Manual Supplement Page6 Electronic Theatre Controls, Inc.



ETC Supplement
Eos Family v2.2.0

Open New Tabs On This Monitor

Select this icon to redirect to the Home Screen where you can open new tabs using
the Display and Controls icons.

Resize Frames In This Workspace

Select this icon to resize frames in any of the workspaces on the monitor. After
selecting, resizing tools will appear between frames of the workspace and you can
select and drag the resize tool icons to adjust sizing as needed.

Resize Tool Icons

Close All Tabs In This Workspace
Select this icon to close all of the tabs in the active workspace on this monitor only.

Reset This Display

This icon will close all of the tabs and frames and will reset the layout for the active
workspace to a single frame displaying the Home Screen, from which you can select
new tabs to open.

Reset All Displays

This icon will close all of the tabs and frames on all monitors, reset all layouts to a
single frame, and return their workspaces to the Home Screen, from which you can
select new tabs to open.
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Changes to Displays

Blind Indicators

The blind indicators have changed with version 2.2. Now while in blind, the background color of the
displays will be blue, the title bar will be bright blue, and the word “Blind” will display in the top left

Clickable Support to Displays

Row
Headers

corner of each monitor. You can click on “Blind” to go back to live.

Several displays are more interactive now with click supported cells. Clicking on a row header will
select and place it on the command line. You can click on multiple row headers to select a range of
items. Double-clicking a row header will select that row and deselect any other rows. Clicking on a
column header will place that action on the command line. You can click on multiple column actions
that can be combined, such as cue times, to place those on the command line.

Column Headers

Cricket & Cache

The

following displays have added clickable support:

« Show Control List
* Cue List

» Playback Status Display
+ Palette Lists

» Sub List

* Preset List

« Effect List

* Group List

* Snapshot List

* Curve List
 Partition List

* Pixel Map List

» Magic Sheet List
» Park Address List

Eos Family Operations Manual Supplement

Page8

Electronic Theatre Controls, Inc.



ETC Supplement
Eos Family v2.2.0

+ Patch Display
» Spreadsheet Display
» Macro List

Displaying Fader Pages with Content
When using [Fader Page] or [Shift]+ [Fader Page], the displayed page will jump to the next page
with content, and then to the next incremental page before skipping to the next page with content.

For example, pages 1-3 and page 11 have content. If on page 2 you press [Fader Page], you will
see pages 3 then 4 then 11 then 12 displayed. After page 12, you will jump back to page 1.

When on page 11, as you press [Shift]+ [Fader Page] you will see page 10 then page 3.

Playback Fader/Page Displayed in Cue List Index

Previously only the playback fader’s ID displayed in the cue list index. Now the page and fader
number display after the playback ID.

Links to Non-existent Cues

When a cue is linked to a non-existent cue, a “*” will display next to the cue number in the
link column of the playback status display and the cue list index.

Wk

Beam Subcategories Rearranged
The order of beam parameters has changed from (Shutters, Image, Form) to (Form,
Image, Shutters). This change impacts the live/blind displays, ML controls, the fixture editor
parameter list, and the parameter tiles in the CIA. This change does not affect the physical keycaps.

Virtual Media Server Crossfade
The Virtual Media Server crossfade parameter level will display in subscript beside the
intensity.

Element Playback Status Display

Scrolling with a mouse is now enabled for the Playback Status Display on Element. This
behavior was already available on the other Eos Family consoles.

Changes to Direct Selects
There are now two different direct select modes: direct selects classic and direct selects x25.

Direct Selects Classic
In classic mode, you have two options, fit to screen and classic layout, that were first made
available in version 2.1. You can change between fit to screen and classic layout by toggling the
{Classicl/Fit} button.

A couple of new options have been added for version 2.2:

* A {1x/2x} button allows you to toggle the direct selects to show one bank of 5 rows or two
banks of 5 rows.
* A {Record} button has been added that posts Record to the command line.
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Direct Selects x25
The Direct Selects x 25 mode displays only a single category of direct selects at a time.

Page Access
Buttons

By using the {+25} and {-25} buttons, you can change the number of available buttons in
increments of 25. You can select a page of direct selects by using the page access buttons or by
using the page up and down buttons. The {Select} and {Flexi} buttons work the same as in
previous software versions.

Changes to About

The number of patched channels and number of cues have been added to the default [About]
display. The number of cues is a count across all cue lists. Multipart cues are only counted once.To
see this display, press [About] when the command line is clear.

About Palette/Preset
A {Usage} button has been added to the About Palettes and About Presets displays.

{Usage} displays the following information about palettes and presets:

* Number of cues that move

« List of channels that use the palette/preset in a cue

« List of channels stored in the palette/preset that are not used in a cue
« List of cues in which the palette/preset have a move instruction

« List of effects that use the palette/preset

About Macro

An [About] Macro display has been added. This display shows a list of cues that will execute a
selected macro. To view this display, you must be in the Macro Editor Display. While in that display,
press [About] and then select the macro by using a mouse or touchscreen.

About Cuelist

Cue List 7

Channels = 0

6>20 26>31 36>41 46>51 61>64 71>78 6>20 26>31 36>41 46>51 71>78 81>86 61>64

81>86 91>98 91>08

The following information will be displayed when a cue list is selected:

e Cue List Attributes

Eos Family Operations Manual Supplement Page 10 Electronic Theatre Controls, Inc.



ETC Supplement
Eos Family v2.2.0

+ Active Cue

* The number of cues in the list (Multipart cues are only counted once)
+ First cue in the list

* Last cue in the list

+ Partition

» Playback number and physical fader location of the cue list

» Channels currently controlled in live by the cue list

+ Channels with any intensities above 0 in the cue list

» Channels with Parameters stored in the cue list but no intensities

Changes to User Interface

Changes to Snapshots
The following changes have been made to the snapshot screen ([Snapshot] [Snapshot]):
» The {Faders} button is no longer selected by default.
+ A {Visible Workspaces} button has been added to snapshot only the visible workspaces.
» An {All Workspaces} button has been added to quickly include all workspaces, including
those not visible at the time of recording.
+ Direct selects is no longer a separate option.

See Snapshots on page 6 for information on single monitor snapshots.

Snapshots Added to Element

Snapshot functionality has been added to the Element console with the addition of a {Snapshot}
softkey.You can now store all of the monitor configurations for your Element console. All displays
are automatically included in all snapshots.

Changes to Setup

Default Preheat Time

An option for default preheat time has been added to Setup>ShowSettings.
If this option is disabled, the cue’s up intensity time will be used when
preheating. The default setting is “Disabled”.

Changes to Channel Distribution
When {Offset} is pressed, a new channel distribution display will open.

LIVE: Cue 2/ 1.1: Chan 1 Thru 10 Offset Mirror In

Channels: (1 10) (2 9) (3 8) (4 7) (5>6)

The following options are available as extensions of {Offset}. Previously only {Reverse},
{Random}, {Odd}, {Even}, and {Reorder} were available. Options can be used together. These
extensions can be used to create subgroups. For more information on subgroups, please see the
Eos Family v2.0.1 Operations Manual Supplement.
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Direction
* {Reverse} creates a group with the channels in the reverse order that they were selected in.
» {Mirror In} creates subgroups of channels that mirror inward.
* [11[Thru] [8] {Mirror In} [Enter] would create 4 subgroups in this order: (1,8) (2,7)

(3,6) (4,5).

Ch1 Ch2 | Ch3 Ch4 | Ch5 | Ch6 |Ch7 |Ch8
X X
X X
X X

X X

» {Mirror Out} creates subgroups of channels that mirror outward.
* [1]1[Thru] [8] {Mirror Out} [Enter] would create 4 subgroups in this order: (4,5) (3,6)

2,7) (1,8).
Ch1 |Ch2 |Ch3 |Ch4 |Ch5 |Ch6 |Ch7 |Chs
X X
X X
X X
X X

+ {Random} creates a random order to the channels.

Grouping
» {Chan Per Group} creates a specified cluster of channels.

* [1] [Thru] [1][2]{Chan Per Group} [3] [Enter] would create these 4 subgroups of 3
channels each: (1,2,3) (4,5,6) (7,8,9) (10,11,12).

+ {InterLeave} creates a number of distributed sets of channels, that are not clustered together.

« [1] [Thru] [1][2]{Chan Per Group} [4] {InterLeave} [Enter] would create these 4
subgroups: (1,4,7,10) (2,5,8,11) (3,6,9,12).

« [11[Thru] [5] [+] [11[1] [Thru] [11[5] [+] [2][1] [Thru] [2][5] {Chan Per Group} [3]
{InterLeave} [Enter] would create these 5 subgroups: (1,11,21) (2,12,22) (3,13,23)
(4,14,24) (5,15,25).

* {Num Groups} creates a specified number of subgroups.

* [11[Thru] [1][2{Num Groups} [3] [Enter] would create these 3 subgroups: (1,2,3,4)

(5,6,7,8) (9,10,11,12).

Spacing
» {Jump} is used to skip over a specified number of channels.

* [1]1 [Thru] [1][2]{Chan Per Group} [3] {Jump} [1] [Enter] would create these 3
subgroups of 3 channels each: (1,2,3) (5,6,7) (9,10,11). Channels 4, 8, and 12 will be
jumped over and will not be in the subgroups.

+ {Odd} selects only the odd numbered channels.
» {Even} selects only the even numbered channels.
* {Reorder} is used to reorder the channels of a group into numeric order.

{Offset} Button Added to Some Displays

Submaster, palette, and preset blind views now all include an {Offset} button. Step-based effects
have an {Offset} button now as well.
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Changes to Effects
Effect Channel Display

The ability to override certain effect properties per channel at the cue level has been added.

The effect channel display has been added for this. To open this display, press [Shift] + [Effect] or
select the effect channel icon from the display management home screen, see Display Icons on
page 5.

The following properties can be overridden:

+ Rate

+ BPM

+ Size (Relative Effects Only)
* H Form (Focus Effects Only)
* V Form (Focus Effects Only)
» Axis (Focus Effects Only)

Note: To add a channel level override, first you will need to be in the Effect Channel
display with the effect running. The effect status display also needs to be open.To
learn how to apply an effect, please see the Apply an Existing Effect section of the
Creating and Using Effects chapter of your console’s manual.

[2][6]<Effect><1>{Rate}[6][Enter] - to change the rate for just channel 26. With the effect running,
the console will default to the running effect number. You may need to select the effect first ([Effect]
[n] [Enter]). This will open the effect status display, and you will have access to the effect softkeys.

In the effect status display, an “+” will display by any effect property that has a channel level
override.

You can then store these channel overrides in a cue by using [Record] or [Update].
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BPM as a Cue Level Override

BPM can be applied to an effect or individual channels as only a cue level override in live and blind.
As a cue level override, the effect step/action times will not be affected.

Note: The effect editor cannot be open when applying a cue level override. The effect
status display does need to be open though. You can open the effect status
display from the home screen or by pressing [Effect] while in live.

With an effect recorded into a cue and playing back in live, [Effect] [1] {BPM} [3][0] [Enter] will
change the BPM of the effect running. This change will happen immediately but the step or action
times will not change. You can see the BPM value, which will be in red, in the Effect Status display.

When the cue is updated or recorded with the new BPM, an “*” will appear next to the effect number
in the Ext Links column of the PSD and the cue list. The BPM value in the effect status display will
now be displayed in blue.

[1] [Effect] [1] {BPM} [3][0] [Enter] will only change the BPM for channel 1. A “+” will display in the
BPM column of the effect status display, and the BPM will display in red in the effect channel
display.

Once the cue is updated or recorded, the BPM will display in blue in the effect channel display. The
“+” will still be displayed in the effect status display, and an “*” will appear next to the effect number
in the Ext Links column of the PSD and the cue list.

BPM Impacts All Times of a Step-based Effect
Applying BPM to a Step based effect will now override all timing in the effect. Previously BPM only
impacted the step times. Now the Step, In, Dwell, and Decay times are all affected.

Step/Action Selection

If an effect step/action is on the command line or indicated in the blue text to the left of the
command line, entering a number on the command line will default to selecting a step/action for the
previous selected effect.

If no step/action is displayed, the command line will default to effect number.

Effect List Navigation
Using the [Next]/ [Last] keys will now only move between effects in the effect list display. To
navigate the effect editor, you will need to use the page arrow keys.

Confirming Effects changes

When using [Page V] to create a new effect step/action in the Effects Editor display, you will first
be asked to confirm the new step/action number before continuing. This is to prevent new step/
action from being created by mistake. To bypass this confirmation, you can hold down [Shift] while
using [Page V] or enter the step/action number manually.

Changes to the ECU

Client Mode Consoles

Consoles in client or backup mode now by default will not output on their local DMX ports. This
option is found at ECU>Settings>Local 1/O. Click on {Output Local DMX in Client mode} to
enable the ability to output.

24 Hour Format Clock Added

In the ECU>Settings>General, an option has been added to display the clock in the 24 hour
format.
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Changes to Magic Sheets
Display Behavior

In the Background Settings tab of the magic sheet editing tools, there is
a new option for display behavior. This option was added to go along
with the new focus rules for display and control tabs. See Focus Rules
for Control and Display Tabs on page 3 for more information.

Display Behavior

Normal Display

The following display behaviors are now available:

* Normal Display - The display will behave the same as a Display Tab.
« Channel Display - This mode uses the following rules:
+  When focus is drawn to the playback status display, a magic sheet channel display
will be brought to the front.
+ Using [Shift] + [Live] cycles through the magic sheet channel displays.

« Pressing[Live] or bringing a Live tab into focus will restore your last focused magic
sheet channel display.

* Magic sheet channel displays in the locked frame will not be skipped when using
the [Tab] key to cycle through tabs.

» Control - The display will behave the same as a Controls Tab.
Changes to Background Settings

You can now select live and blind backgrounds for magic sheets. These backgrounds can either
use a solid color, gradient of two colors, or an image. One of these backgrounds will be used when
editing a magic sheet. Select the {Use While Editing} button to use either the live or blind
background.

Live and Blind Indicators
Magic Sheets now indicate Live or Blind on their tab.

\ 3 Blind Magic Sheet 2 | +

ive Magic Sheet 2 | +

Clock

A clock has been added to the MS Object Library. You can now
add a clock to any magic sheet. By using the MS Object
properties, you can edit the color, font, and size of the clock.
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Changes to Fixtures
Changes have been made to the fixture library in version 2.2 to make fixtures easier to control.
These changes affect the fixture definitions.

These changes include:

* More mode parameters for complex fixtures
* More calibrated ranges
* For example, DMX ranges are calibrated in real units (25 to 50 Hz or 5 to 20 RPM)
instead of their absolute DMX values.
» Changes to the index type parameters
+ For example, some index parameters that used to be 0-360 degrees are now -180-180
degrees.

Pixel Mapping Installer Update

Eos Family v2.2 includes an enhancement for operating file system support for Nomad systems
running on a PC or Macintosh. This changes the default location for storing show files and media to
the main “User” documents location of the system; [Windows Drive]:\Users\<<Your User
Name>>\My Documents\ETC\Eos for Windows 7 & 8, ~/Documents/ETC/Eos on Mac platforms.

An update to the Eos Family Pixel Mapping Installer is available (v1.0.1). You may obtain this
release of software by downloading it from the Downloads section of the ETC website,
www.etcconnect.com. First time Nomad installs of Eos Family v2.2 should use Eos Family Pixel
Mapping Installer v1.0.1. This is not required for upgrades to Eos Family v2.2, but it is

recommended.

Note: For consoles updating from v1.9.2 or earlier, it is recommended that you install
pixel map installer v1.0.1

Note: Please be sure to check your media archive location in

ECU>Settings>General>Media Archive Path to ensure proper configuration.
Restoring defaults will use the updated locations configured by Eos v2.2 and the
v1.0.1 pixel map installer.

ECU Change for Nomad

General

General

Ac

For Nomad, a new option has been added to the ECU to allow FIIscren Offline Editor mode.
Instead of separate windows, the displays will be fullscreen.

With this mode disabled, you can choose up to six windows to display. Fullscreen Offline Editor
mode is enabled by default.
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Hardware Changes
Element and lon are now shipping with Windows 7 and a revised motherboard/SSHD.

Element

Ethernet Ports 1& 2 Audio Reserved  MID| Ports
for Future In & Out Remote
Trigger

Implementation // /

USB Ports

Hard Power Switch Fan

==

0

(8]

(8]
ety

NS E 3 | @.ce
Phone
IEC Receptacle Remote
eSATA USB Ports
Port ; DVI-D DVII s
us Display
Ports Port ~ Port Port 187
lon
. Ethernet Ports 1 & 2
Hard Power Switch Audio Reserved mlglgl?{t y Remote
for Future Trigger
UsB Por\ts Implementation N 9
3 —\ @&‘\I

DVL.D \ USB Ports
Displa - DVI-I

lon & Element support up to 2 monitors using
the following combinations:

Signal
prysol’® | Display Port DVI VGA
Port
Yes Yes
Display Port Yes . with Active
with Adapter Adapter
DVI-l Port No Yes Yes dapter
DVI-D Port No Yes No

Multitouch monitors need to be Windows 7 or 8 Compatible.
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Eos Family v2.1.0 Supplement to Operations Manual

The following information is new for version 2.1.0. This document is supplemental to information in
the Eos Titanium, Eos, and Gio v2.0 Operations Manual, and lon v2.0 Operations Manual, and

should be used in conjunction with it. For Element users, the Element User Manual has been
updated for version 2.1.0.

Eos Ti

Eos Ti consoles cannot automatically update the software on other devices running software
versions prior to 2.1.0. Once those units are updated to version 2.1.0, Eos Ti consoles will be able
to auto update all system devices via the update setting in the ECU.
System Overview Change
Channel Counts
The maximum number of allowed channels that can be defined in patch has increased from 10,000
to 16,000, (can be any number from 1 to 99,999). This change impacts Eos Ti, Eos, Gio, and lon.
System Basics Changes
Direct Selects

There are two options for opening the direct select modules, which are Fit to Screen and Classic
Layout. Fit to Screen is designed for wide format displays. For standard size monitors, use the
Classic Layout. The following example shows both options on a wide format display:

Classic Format

[Shift] + Direct Select

Selecting record targets from direct selects will terminate the command line. To post a control to the
command line without terminating it, hold down [Shift] while pressing the direct select. This allows
multiple commands to be selected and executed at once, and an optional sneak time to be entered.

Modifying a Terminated Channel Selection

It is possible to add or remove channels from a previously terminated command line. You will need
to first press [+] or [-] and then you can add to or remove from your current channel selection.This
includes selecting channels from the direct selects, summary view, and Magic Sheets.
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Grandmaster/Blackout _
If a grandmaster is set to a value other than 100%, a grandmaster button

with the set value will be shown at the top of each display. If blackout is _
currently on, a blackout button will be shown at the top of the displays.

Clicking on either button will open a new display which will allow you to

turn off blackout and set the grandmaster to a different level.

Managing Show Files Change
Show File Advisory

If the loaded show file exceeds the console’s output capacity, an advisory will display in the CIA.
You will need to dismiss the advisory by pressing {Ok} before continuing. To see the capacity of the
console, press [About].

Setup Changes

High Contrast Display
By default, High Contrast Display is now enabled in Setup>Desk>Displays.

100 Channel Display

Additional options have been added to 100 Channel Display in Setup, Setup>Desk>Displays, to
help accommodate different display dimensions.

You can select to have this option disabled, display the channels in 4 rows of 25 (4x25), or 5 rows
of 20 (5x20), depending on the dimensions of your displays. The default for this setting is
“Disabled.”

Encoder Acceleration on Eos and lon

Encoder Acceleration has been removed from Eos and lon, which matches the behavior of the Eos
Ti and Gio encoders.

In Setup>Desk>Face Panel>Encoders, there are two options available: {Degrees Per
Revolution}, which is for the pan & tilt encoders, and {Percent Per Revolution}, which is for the
other encoders. When a pan or tilt encoder is moved one revolution, the parameter will change by
as many degrees as defined in Setup. The default is 30. When any other encoder is moved one
revolution, the parameter will change by the set percentage of its entire range. The default is 35.

The settings for {Encoder Degrees Per Revolution} and {Encoder Percent Per Revolution} are
stored with the show file. Starting a new file will reset the two settings to their default values.

Note: On Eos, toggling an encoder no longer works to place it into fine mode.On both
Eos and lon, hold down [Shift] while moving the encoder for fine control.

Releasing the [Shift] key will restore the encoder to its default mode
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Removing Virtual Hue and Saturation Parameters
In Setup>Show>Show Settings, an option, {Create Virtual HSB}, has been added, which allows
you to disable creation of virtual hue and saturation parameters. This option is “Enabled” by default.

When Virtual HSB controls are disabled, the hue and saturation columns will not display in Table
view. You will not be able to record just the Hue or Saturation values into a cue, submaster, preset,
or palette, and you cannot apply an effect to Hue and Saturation. You will still be able to control Hue
and Saturation from the encoders, ML Controls, Color Picker, and the command line.

Fan Change
Using Subgroups with Fan

Subgroups can be used with the Fan feature. Channels in the same subgroup will act as a single
channel when fanned.
For Example:

Group 1 is made up of channels 120 thru 130. Channels 120 thru 123 are one subgroup,
channels 124 thru 126 are not in any subgroup, and channels 125 thru 130 are another
subgroup.

*  [Group] [1] [Fan] [Enter]

Selects group 1 and puts it into fan mode. Rolling up the level wheel creates the following
result. Channels 120 thru 123 share an intensity, channels 124 thru 126 each have different
intensities, and channels 127 thru 130 share an intensity.

Submaster and Patch Changes
GM Exempt and Intensity Master

For channels that have been set to GM Exempt in Patch, Intensity Master control will not impact the
intensity of those channels.

[Query] {Unpatched}

To quickly delete channels without addresses in the Patch display, you can use the command
[Query] {Unpatched} [Delete]. This will post to the command line all channels without addresses.
By pressing [Enter][Enter] you will delete them.

lon users will need to press [Shift] + [Select Last] to access the {Query} softkey in Patch.

[About] Changes

In the default About display, a new field has been added called Parameters. This field references
the number of parameters that have been defined in patch. This includes parameters that have
been patched to output addresses and those that have not. The field below Parameters,
Addresses, only calculates the number of addresses that have been used in patch (which counts
toward available outputs). The Parameters field is useful as even unpatched, but defined,
parameters must be displayed and calculated in the fade engine. If you are running a large show,
it is helpful to delete defined, but unpatched channels. This is where the [Query] {Unpatched}
command is helpful.
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For Example:

System Count: 4096

Version 2.1.0 BETA Build 65

2,1.0.1.0.68

Copyright (c) 2013 Electronic Theatre Controls International, All Rights Reserved.

About Cue

In the About Cue display, three new columns that show channel moves have been added. Those
columns are intensity moves, live NPs moves, and dark NPs moves.

Effects Changes

Preprogrammed Rainbow Effects
Two new preprogrammed effects have been added to the effect list. Effect 917 is a Rainbow RGB
effect, and effect 918 is a Rainbow CMY effect. These effects are for a rainbow on native color
parameters that will fade hue from 0 to 360 with saturation at full, when the parameters are at their
default levels. 0 is the default for CMY, and Full is the default for RGB.

Focus Effects
When adjusting the form of a focus effect, you can hold down [Shift] while using the horizontal
encoder to change the vertical form.

Beats Per Minute/ Tap Rate

For step-based and absolute effects, you can set a beats per minute (BPM). For step-based effects,
BPM affects the step times and for absolute effects, this affects the time/dwell. Note that BPM
impacts the effect directly. It is not currently available as a cue level override.

There are two different ways for assigning BPM to effects:

Directly setting BPM

If you know the BPM, you can assign that directly to the effect by using the {BPM} softkey, which is
available when in the effect editor display.

* [Effect] [1] {BPM} [1][9][0] [Enter] - sets the BPM of effect 1 to 190. The step times will be
adjusted for step-based effects, or the time/dwell will be adjusted for absolute effects.

The BPM will display on the right side of the effect editor beside the effect number/label. Editing the
cycle time, the step time for a step-based effect, or the time/dwell for an absolute effect will remove
the BPM.

Learning BPM
If you don't know the desired BPM, you can learn the BPM.
From Live, with the effect running:

+ [Effect] [1] [Learn] [Time] - posts Effect 1 Learn Time Sample BPM to the command line, and
opens the effect editor display.
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While in this mode, press [Enter] to establish the BPM. The console will use an average of the last
four times you press [Enter] in this mode to calculate the BPM. Pressing [Learn] again will stop this
mode.

In this mode, every time the BPM changes, a live running effect will be modified accordingly without
stopping.

Learning Discrete Step Time

In learning discrete step time mode, every time you press [Enter], the time since the last press of
[Enter] is used to set the next step's step time for a step-based effect, or the next step's fade/dwell
time of an absolute effect.

» [Effect] [1] [Learn] [Time] [Time] - posts Effect 1 Learn Time Discrete Steps to the command
line, and opens the effect editor display.

Pressing [Learn] again will stop this mode.

Instead of pressing [Enter], you can press [At] while in this mode to add new steps to the end of the
effect. Pressing [Enter] will send you back to the first step in the effect.

Magic Sheet Changes
Address as Target Type

Address is now an available target for magic sheet objects.

Address Added to List of Fields
Address has been added to the list of fields that can be displayed around an object.

Address Object Color

An address object, with its outline color set to Link to Channel
Color, will have a white outline if the address is patched, or a dark
outline if the address is unpatched.

If the address object's outline color is set to Link to Channel
Intensity, the brightness of the outline color will be tied to the DMX At 50%
level of the address. The higher that the DMX value is the brighter
the outline color will be.

To set the outline color to Link to Channel Color or Intensity, select
the outline color icon in the color section of MS Object Properties.
Then select either Link to Channel Color or Link to Channel Intensity.

Outline Color Icon
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Fixture Symbols

Additional fixture symbols can be imported. The symbol must be saved as a .svg image file, and
needs to be tagged properly. These tags can be linked to the channel’s color, intensity or both.

The outline section needs to be tagged as etc_symbol_outline0, etc_symbol_outline, and/or
etc_symbol_outline2. The base section needs to be tagged as etc_symbol_base0,
etc_symbol_base, and/or etc_symbol_base2. Tags can be layered, and they will render in the order
listed below:

» etc_symbol_base0 - uses fill color intensity link (not color)
» etc_symbol_base - uses fill color and intensity link

« etc_symbol_base2 - uses fill color intensity link (not color)
» etc_symbol_outline0 - uses outline intensity link (not color)
» etc_symbol_outline - uses outline color and intensity link

» etc_symbol_outline2 - uses outline intensity link (not color)

Tags that only link to intensity will cause the base or outline to dim based on the channel’s intensity.

The edits to the tags in the .svg file can be made in any text editor program, such as Notepad, or in
a .SVG editor program, such as Inkscape.

ECU Changes

Enable Sensor/ FDX3000 Feedback

Clicking in the enable box will allow your console to receive feedback over the network from a
CEM+, a CEM3, or FDX3000. This option is “Enabled” by default.

Enable FDX2000 Feedback

Clicking in the enable box will allow your console to receive FDX2000 dimmer feedback over the
network.

Client Software Change

Using Offline or Client with Mac Laptops
When using a Mac laptop or wireless &0 Keyboard

keyboard with the Mac functions (=] [ Showan | a
mapped to the F1-F12 keys, Eos
offline/client functions are not

executable. The Mac functions must Key Repeat
first be disabled before Eos offline/ P

client functions will work: Bl

120 Keyboard Shortcuts |

Delay Until Repeat

.

Long Shart

| Use all F1, F2, etc. keys as standard function keys
When this option is selected, press the Fn key to use the special
patures printed on each key.

Step 1:  Open System
Preferences on your
Computer (¥ Show Keyboard & Character Viewers in menu bar | Input Sources...
Step 2:  Open the Keyboard
section.

Step 3: Enable Use all F1, F2,
etc. keys as standard
function keys by
clicking in the box.
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The following information is new for version 2.0.1. This document is supplemental to information in
the Eos Titanium, Eos, and Gio v2.0 Operations Manual, lon v2.0 Operations Manual, and Element
v2.0 User Manual, and should be used in conjunction with it.

Display Changes

Changes in this section impact the System Basics chapter and the Facepanel Shortcuts appendix.
Latching Data and Time

[Data] Key

Pressing and holding [Data] allows you to view the values behind any referenced or marked data.
[Data] exposes the next lower reference level. So if you view a palette reference and press [Data],
the absolute data will be displayed instead. If you are viewing a preset, absolute or palette data will
be displayed, depending on what is contained in the preset.

On Eos Ti, Eos, Gio, and lon, you can lock this mode by pressing [Shift] + [Data]. When in display
reference values mode, “Data Latched” will display in the upper left of the live display and the
[Data] key will be lit in green on Eos Ti and Gio. To exit this mode, press [Shift] +[Data] again.

[Time] Key

Pressing and holding the [Time] (the one by [Data] on Eos Ti, Eos, and Gio) allows you to view
discrete timing data behind any channel parameter. [Time] exposes channel or parameter specific
timing for any channels in the current cue. The first value is the delay time. If “--" is displayed, there
is no delay. The value to the right of the / is the transition time.

On Eos Ti, Eos, and Gio, you can lock this mode by pressing [Shift] + [Time]. When in display time
mode, “Timing Latched” will display in the upper left of the live display and the [Time] key will be lit
in green on Eos Ti and Gio. To exit this mode, press [Shift] +[Time] again.

On lon, you can lock this mode by pressing [Shift] + [Time] [Time]. To exit this mode, press [Shift]
+[Time].
Category Time in PSD

When the {PSD Time Countdown} setup option (Setup> Desk> Displays) is enabled, each
category time will individually turn gold when that timing has completed.

e

7 2 1

Manual Control Changes
Changes in this section impact the Basic Manual Control or the Advanced Manual Control chapter.

Rem Dim /

Rem Dim levels can either be an absolute value, such as Full or 50%, or a proportional value, which
would set the levels to a percentage value of their current levels. To use a proportional value, press
[/] before entering the percentage value.

For Example:

Assume that channels 1 through 10 are selected and set to an intensity level of 60. Select channel
1 and dim the remaining channels.
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*  [1] [Rem Dim] [/] [5][0] [Enter]
Channels 2 through 10 will be dimmed to 30.
Highlight Rem Dim
To temporarily override the {Highlight Rem Dim} option in Setup, you can use either of the
following syntax examples:

* [channel list] [Highlight] [Rem Dim] [#] [Enter]
* [channel list] [Highlight] [Rem Dim] [/] [#] [Enter]

[-] [Select Manual] / [Select Active]
[-] [Select Manual] or [-] [Select Active] can be used to modify channel selections. Using [-]
[Select Manual] will select all of the channels in the list except those that have manual data. Using
[-] [Select Active] will select all of the channels in the list except those that are active.
* [1] [Thru] [2] [0] [-] [Select Manual] [Enter] - selects channels 1 through 20 except any
channels that currently have manual data.
[1]1 [Thru] [2] [0] [-] [Select Active] [Enter] - selects channels 1 through 20 except any channels

that are currently active.

[Undo] [Undo] [Enter]

Pressing [Undo] [Undo] will scroll to the most recent undo-able command in the command history
display. To undo the command, press [Enter].

Capture Latch
Previously Capture Latch would be enabled for all users when it was enabled by one user. Now

Capture Latch works on a user by user basis. For more information on using Capture Latch, see the
Using [Capture] section of the Advanced Manual Control chapter.

Recording and Playback Changes

Changes in this section impact the Cue Playback, Storing and Using Submasters, or Using
Partitioned Control chapters.

Loading a Cue with Temporary Time
A cue can be loaded with a temporary time. J—

* [Cue] [3] [Time] [6] [Load] - loads cue 3 with the 3
manual time of 6.

Note: For multipart cues, the temporary time will be applied to the entire cue, not just the

part on the command line.
For cues with discrete timing, its parameters will use the temporary time instead

of the assigned discrete timing.

Submasters
The number of submasters has increased to 999. The number of fader pages available is still 30,

which means that there is a still a limit of 300 submasters being used with physical faders at a time.

Partitions on Cue Lists
A partition may be assigned to a cue list. If a partition has already been applied to a cue list, any

channels not in the cue list's partition will not be included in cues when they stored or replayed.

Any data for a cue list that already existed before a partition is applied, will be maintained, including
data for channels not included in the partition. If data existed before the partition was assigned, in
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blind, channels that are not in the partition will display without a channel graphic, any levels will be
in gray, and a small superscript N will display with it.

Blind Table Channels that were

initially saved in the
cue listbut are not in
the currently
assigned partition

Assigned partitions will display in the external links column in the cue list index.
To assign a partition to a cue list:

* [Cue] [n] [/] {Partition} [n] [Enter]
To remove a partition from a cue list:

* [Cue] [n] [/]] {Partition} [Enter]

Working with a Single Cue List Changes

Changes in this section applies to the Working with a Single Cue List chapter.

Auto-block Cleanup
Cues that have auto-blocks will display a underscored b in the PSD. {Autoblock Clean} is used to
remove all auto-blocks from a single cue, cue range or entire cue list. {Autoblock Clean} is a
softkey that will be posted when a cue list and/or cue number are on the command line in the Cue
List Index, Live, and Blind. A range of cues or a cue list can be specified with this command.

For Example:

* [Cue] [1] [/] {Autoblock Clean} [Enter] - clears all auto-blocks from cue list 1. Only blocks
displayed with the white underscore are removed. If the [Block] key was previously used, this
command will not unblock it.

* [Cuel[1] [/1 [11[0] [Thru] [1][0][0] {Autoblock Clean} [Enter] - clears the auto-blocks just
from cues 10 through 100 of cuelist 1.

Default Update Modes

The default Update modes have changed. Eos defaults to Make Absolute for the {Update Mode},
with {Break Nested} and {Update Last Ref} enabled.

Auto Playback Update Mode
Enabled Make Absolute

[ Track Break Nested
Tracking Mode Enabled
[ Record Confirm { update Last Ref
Enabled Enabled
Delete Confirm
Enabled

Record Defauls |

Default Update Setup Options
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Timing Disable
This change affects the Setup and Cue Playback chapters.
You can assign a separate time value for [Timing Disable] in Setup> Desk> Manual Control>
Default Times> Timing Disable. When a fader has been set to timing disable mode, cues will use
the time set in Setup. The default time is 0.

[Shift] + [Go] and [Shift] + [Back]

[Shift] + [Go] and [Shift] + [Back] can be used to cut to the next cue in the same way as [Timing
Disable] + [Go] and [Timing Disable] + [Back].

Show File

An indicator has been added to show when a show file has been » _ "
modified but not saved. An asterisk (*) will display beside the show file RS GENE: Ty
name.

Mirror Mode

This change affects the Mirror Mode section of the Multi-console and Synchronized Backup
chapter.

A device that is currently in mirror mode can select which user number it is mirroring by using the
alphanumeric keyboard shortcut M + # (# being the user number). M + ESCAPE can be used to
leave mirror mode.

Note: If a device is not currently in mirror mode, pressing M on an alphanumeric
keyboard will post Mark to the command line.

Collapsing PSD Columns
This change affects the Playback Status Display section of the System Basics chapter.
To collapse a column in the Playback Status Display, press [Escape] while clicking on the column
you want to collapse. Press [Shift] + [Select] to bring back all of the collapsed columns.

Magic Sheets on Direct Selects

Magic Sheets can now be accessed from the direct selects. Clicking on a magic sheet direct select
will open the Magic Sheet tab and display the selected magic sheet. Pressing a different magic
sheet direct select will change the displayed sheet.

Using Park Changes

Changes in this section impact the Using Park chapter.

Recall From Park

You can use [Recall From] [Park] to set a channel or parameter to the same level as the current
park value.

For Example:

Let's assume that channels 1 through 5 are parked at 55. To recall that level to channels in live or
blind, use the following syntax:

e [1] [Thru] [1][5] [Recall From] [Park] [Enter]
Channels 1 through 5 will be set to 55 and channels 6 through 15 will be unaffected.

Note: This does not release the Park buffer.
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[Thru][Thru] in Park

When parking a range of addresses in Park, using [Thru] will only park the intensities. If you want
to park all of the addresses and parameters within the selected range, you will need to use [Thru]
[Thrul.

Patch Changes

Changes in this section impact the Patch chapter.

{Swap} in Patch
Additional options have been added to {Swap} in Patch.

» {Swap} - swaps only the patched address

* {Swap} {Plus Show} - swaps all show and patch data

» {Swap} {Only Show} - swaps only the show data and not patch data

» {Swap} {Plus Patch} - swaps addresses and patch data but not show data

Fixture Editor Parameters
The fixture editor parameters list is now displayed in alphabetical order.

[Thru] [Thru]
This change applies to the Multipart Cues chapter.

[Thru] [Thru] can be used in blind to create multiple cue parts in a range. For example, [Cue] [1]
[Part] [1] [Thru] [Thru] [4] [Enter] will create parts 1 through 4. If you were to use just [Thru]
instead of [Thru] [Thru] in that example you would create parts 1 and 4.

Subgroups
This change applies to the Using Groups chapter.

You can create subsets of channels within a group by using [Shift] + [/]. [Shift] + [/] will create
parentheses. These subsets of channels or subgroups are treated as a single channel in the
following ways:

* When applying absolute or relative effects from live, the subgroups are treated as a single
channel by the effect.

» When setting a range of step's channels on a step based effect, the subgroup will not be
spread out amongst multiple steps.

* When the group is selected and next/last is pressed, each subgroup is traversed.

* When a group has subgroups, {Reverse}, {Reorder}, and {Random} in the group editor will
affect the subgroups instead of the channels in each subgroup. {Reorder} will order the
groups based on the first channel in each group.

Subgroups can be created either in the group list or live.

Group Label

To create a subgroup in live:

* [Shift] + [/] [1] [Thru] [4] [Shift] + [/] [Record] [Group] [2] [Enter]
To create a subgroup in the group list index:

* [Group] [2] [Enter] [Shift] + [/] [1] [Thru] [4] [Shift] + [/] [Enter]

Note: Fan is not currently supported with Subgroups.
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Managing Show Files Changes

Changes in this section impact the Managing Show Files chapter.

Importing Custom Gobo Images

Custom gobo images can be imported by going to Browser> Import> Gobo Images and selecting
an image file or folder. If a folder is selected, all image files within the folder will be imported. All
standard image files are supported with the exception of .svg files.

Imported gobo images can be deleted by going into Browser> Import> Gobo Images> Imported
Gobos, selecting the image, and pressing [Delete] [Enter].
Imported Media and Partial Show Open/Merge

A new tile, {Media} has been added to the Partial Show Opening and Merge displays. Media is
imported gobo and magic sheet images.

Note: Media will be included by default when you select Patch, Fixtures, or Magic
Sheets.

Virtual Media Server
Changes in this section impact the Virtual Media Server chapter.

Number of Pixel Maps
The number of pixel maps per show file is now 40. Previously it was limited to 10 maps.

{Flash}

The {Flash} softkey is available in the Pixel Map Editor display. {Flash} works the same as it does
in Live. See the section on Flash in the Basic Manual Control chapter for more information.

Patch by Channel

An option for setting the starting channel has been added to the Edit display for mapping channel-
based pixels.

* When either {Starting Channel} or {Starting Address} is selected, both fields will be
cleared.

» Address-based pixels can not overlap with channel-based pixels. This includes the entire
DMX fixture footprint.

« If using {Starting Channel}, any overlapping channel-based pixels will be removed and any
overlapping address-based fixtures will be unpatched.

« If using {Starting Address}, any overlapping address-based pixels will be removed and any
overlapping channel-based fixtures will be unpatched.

* When the [Data] key is latched, the address for channel-based pixels will display.

* When [Format] is pressed, the address will toggle between port/offset and address number.
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Park and Address Check

You can use Park and Address Check for Virtual Media Server outputs.

Color Picker

A second color picker has been added for virtual effect layers. The second color picker will be
labeled as End Color and will control RGB2.

Copying Color
You can copy or swap a color between the two color pickers using the buttons located between the
two color pickers.

Start Color End Color
opies Start Color to End Color
waps Start Color and End Color
opies End Color to Start Color
[t [ Color Format
AT

FDX Dimmer Feedback

ECU Settings
Changes in this section impact the ECU appendix.

FDX Feedback
Clicking in the enable box will allow Eos to receive FDX dimmer feedback over the network.

Broadcast Type
» Directed Broadcast - Broadcast packets are directed to a subnet based on the IP address and
subnet mask of the sender.
 Limited Broadcast - The limited broadcast address is 255.255.255.255. It is limited because
routers will never forward datagrams with that destination address. This means that
datagrams with the limited broadcast address are confined to the particular network segment
on which they originate.

About System
Changes in this section impact the About chapter.

Clicking on a FDX rack in the {About System} list will open the About Rack display, which shows
the following information about the rack:

* Rack number

* Rack Type

» Phase A,B,C Voltages
* Frequency

» System Number

* |P Address

» Software Version

Device List
For information about FDX Dimmer feedback, see the Device List section in the Patch chapter.
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